Management Software for
Concept 4000 Security / Access Systems

USER MANUAL
For Version 5.2 Software

IMPORTANT NOTE: The version of Insight software available for download
from the Website may be newer than the version on your installation CD.
Prior to installation, check to ensure that you are installing the latest version.
http://www.innerrange.com Follow the links to the Support area (login required)

This Insight User Manual is provided as a pdf file on the product CD and from
the Inner Range website. See Tip on page 10.
Comprehensive on-line help is provided in the Insight software.
See page 4 for more details.

INNER RANGE recommends that
all CONCEPT systems
be installed & maintained by
FACTORY CERTIFIED TECHNICIANS.
For a list of Accredited Dealers in your
area refer to the Inner Range Website.
http://www.innerrange.com

Insight
User Manual: Revision 5.2
P/No: 630053
For Insight software version 5.2

Supporting Concept 4000 Panel firmware up to
V7.8x
May, 2011

© Copyright 2006-2011
Inner Range Pty. Ltd.

Disclaimer:
1. The manufacturer and/or its agents take no responsibility for any
damage, financial loss or injury caused to any equipment, property or
persons resulting from the correct or incorrect use of the Inner Range
system and its peripherals. The purchaser assumes all responsibility in
the use of the Inner Range system and its peripherals.
2. Whilst every effort has been made to ensure the accuracy of this
manual, Inner Range Pty Ltd assumes no responsibility or liability for
any errors or omissions. Due to ongoing development the contents of
this manual are subject to change without notice.

Contents
For Version 5.2 Software ........................................................................................... 1
Contents..................................................................................................................................... 2
Protect Your Insight Professional Software Investment ............................................................ 6
with an Inner Range ................................................................................................................... 6
Software Maintenance Agreement ............................................................................................ 6
INSIGHT HELP .......................................................................................................................... 6
Introducing Insight ......................................................................................................................... 7
Product Highlights .................................................................................................................... 10
Registering Insight Professional .............................................................................................. 11
Insight Professional (Demo Edition) ........................................................................................ 11
Launch Pad ................................................................................................................................. 13
Starting Launch Pad ................................................................................................................ 13
Launching a Module ................................................................................................................ 14
Logging In ................................................................................................................................ 14
Changing Launch Pad Preferences ......................................................................................... 14
Changing Client Settings ......................................................................................................... 15
The Insight Toolbar ..................................................................................................................... 17
Working With Sites .................................................................................................................. 18
Working With Panels ................................................................................................................... 21
Enrolling Panels ....................................................................................................................... 21
Creating Panels From Templates ............................................................................................ 25
Duplicating Panels ................................................................................................................... 26
Moving Panels ......................................................................................................................... 26
Panel Connections ................................................................................................................... 27
Permanent Connections .......................................................................................................... 28
Panel Initiated Connections ..................................................................................................... 29
Scheduled Connections (Insight 3.2 or later) .......................................................................... 29
Understanding Connection Status ........................................................................................... 30
Manual Connections ................................................................................................................ 31
Modem Blocking ...................................................................................................................... 32
Panel Properties ...................................................................................................................... 32
Remote Control Field Hardware .............................................................................................. 34
Insight Edit ................................................................................................................................... 35
Using the Browser ................................................................................................................... 36
Understanding Item Status ...................................................................................................... 37
Using Filters ............................................................................................................................. 38
Editing Items ............................................................................................................................ 39
Online and Offline Edit ............................................................................................................. 40
PIN Discovered ........................................................................................................................ 41
Scheduled User Expiry ............................................................................................................ 41
Write-Locking Panels ............................................................................................................... 41
nd
Detecting LCD Terminal (Keypad) or “2 Insight” Edits .......................................................... 42
Comparing Insight With A Panel .............................................................................................. 42
Long Names, Notes, Name Lock Slider, Item Picker, Quick Navigation ................................. 43
Searching Panels ..................................................................................................................... 44
Cross-Referencing Items ......................................................................................................... 46
Using The Copy Wizard ........................................................................................................... 46
Card Pool Integration ............................................................................................................... 49
Card Acquisition ....................................................................................................................... 50
Insight Edit Reports ................................................................................................................. 51
Employees ............................................................................................................................... 53
Custom Fields .......................................................................................................................... 54
Importing Extended User Information ...................................................................................... 54
User Photographs .................................................................................................................... 60
Panel Memory Configurations ................................................................................................. 61
Virtuality ....................................................................................................................................... 64
Virtual Users Explained ........................................................................................................... 65
Virtual Links Explained ............................................................................................................ 67
Virtuality In Practice ................................................................................................................. 68
Icon .......................................................................................................................................... 68
3

Creating Virtual Panels ............................................................................................................ 69
Example ................................................................................................................................... 69
Example ................................................................................................................................... 70
Insight Card Pool ......................................................................................................................... 74
About Card Pools ..................................................................................................................... 75
Migrating To Card Pool ............................................................................................................ 75
Working With Card Pools ......................................................................................................... 76
Using The Browser .................................................................................................................. 77
Managing Cards....................................................................................................................... 78
Panel Scan for Unassigned Cards........................................................................................... 81
Card Scan ................................................................................................................................ 81
Troubleshooting cards with the Card Scan dialog ................................................................... 83
Insight Review ............................................................................................................................. 85
Underlying Concepts ............................................................................................................... 86
Insight Audit Events ................................................................................................................. 86
Review Windows...................................................................................................................... 87
Review Preferences and Review Colouring. ........................................................................... 87
Filtering Review ....................................................................................................................... 89
Moving The Review Pointer ..................................................................................................... 91
Basic Reports........................................................................................................................... 91
Custom Reports ....................................................................................................................... 92
Time On Site Report ................................................................................................................ 92
Alarms ...................................................................................................................................... 95
Acknowledging Alarms ............................................................................................................ 95
Working With Alarm Responses .............................................................................................. 96
Working With Help Responses .............................................................................................. 101
Working With Operator Responses ....................................................................................... 102
Insight Licence Manager ........................................................................................................... 103
Registering Insight Professional ............................................................................................ 103
Licensed Modules .................................................................................................................. 104
Panel Licensing...................................................................................................................... 104
Workstation Licensing ............................................................................................................ 104
About Fixed Workstation Licences ........................................................................................ 104
Remote (Terminal Services) Licensing .................................................................................. 105
Insight Operators ....................................................................................................................... 106
Working With Operators ........................................................................................................ 107
Working With Operator Types ............................................................................................... 108
Working With Permissions ..................................................................................................... 109
Working With Module Permissions ........................................................................................ 110
Working With Workstations .................................................................................................... 111
Working With Tenants ........................................................................................................... 112
Insight Schematic ...................................................................................................................... 116
Working With Maps ................................................................................................................ 117
Adding Labels ........................................................................................................................ 118
Adding Alarm Groups ............................................................................................................ 118
Working With Surveillance Items ........................................................................................... 118
Adding Surveillance Items ..................................................................................................... 118
Working with Icons ................................................................................................................. 120
Understanding Surveillance Item Status ............................................................................... 121
Adding Cameras .................................................................................................................... 122
Adding Camera Presets ......................................................................................................... 122
Creating Drill-Downs .............................................................................................................. 123
Working In Surveillance Mode ............................................................................................... 123
Alarm Processing ................................................................................................................... 123
Controlling Items Within Schematic ....................................................................................... 124
Insight Server Tool .................................................................................................................... 126
Starting and Stopping Insight Server ..................................................................................... 126
Viewing Client Connections ................................................................................................... 127
Configuring Your Modem Pool ............................................................................................... 127
Insight Photo ID ......................................................................................................................... 128
Underlying Concepts ............................................................................................................. 129
Toolbars ................................................................................................................................. 129
4

Working With Card Templates ............................................................................................... 130
Designing Card Templates .................................................................................................... 131
Editing Card Templates ......................................................................................................... 133
Printing Cards ........................................................................................................................ 134
To output to a file ................................................................................................................... 136
Print Using Card Associations ............................................................................................... 136
Insight DVR Integration ............................................................................................................. 139
About Insight DVR Integration ............................................................................................... 140
DVR Plugins installer. ............................................................................................................ 140
Enrolling A New DVR ............................................................................................................. 140
Working With Video Windows ................................................................................................ 141
Synchronising DVR Date/Time .............................................................................................. 142
Working With The DVR Control Bar ...................................................................................... 143
Controlling PTZ Cameras ...................................................................................................... 143
Working With The Video Timeline ......................................................................................... 144
Working With Layouts ............................................................................................................ 145
Sending Commands To A DVR Or Camera .......................................................................... 146
Integration With Review ......................................................................................................... 146
Integration With Schematic .................................................................................................... 146
Touch Designer ......................................................................................................................... 147
Customisation of a Touch Screen Terminal .......................................................................... 148
Panel memory and layouts .................................................................................................... 148
Creating a new Layout ........................................................................................................... 148
Creating a new Screen .......................................................................................................... 149
Creating a new Button ........................................................................................................... 151
Button placement ................................................................................................................... 151
Button properties ................................................................................................................... 151
Menu Buttons ......................................................................................................................... 152
Area Buttons .......................................................................................................................... 152
Timed Auxiliary Buttons ......................................................................................................... 152
AreaList Buttons..................................................................................................................... 152
Isolate Buttons ....................................................................................................................... 153
Review Buttons ...................................................................................................................... 153
User Extra Area Buttons ........................................................................................................ 153
Home Analogue Auxiliary Buttons ......................................................................................... 153
Switched Auxiliary Buttons .................................................................................................... 153
Active User Rotation Module ..................................................................................................... 154
Requirements......................................................................................................................... 154
Configuring Active User Rotation........................................................................................... 154
Dynamic User Import Module .................................................................................................... 158
Setting up the Dynamic User Import Module ......................................................................... 158
Working with the Dynamic User Import Module .................................................................... 163
Hotel PMS INI File Format ..................................................................................................... 163
Instructions for DUIMPreprocess.bat ..................................................................................... 164
Qualifications ............................................................................................................................. 166
Requirements......................................................................................................................... 166
Preparing the Concept Panel ................................................................................................. 167
Creating the Qualification ...................................................................................................... 167
Creating Doors ....................................................................................................................... 168
Creating Door Lists ................................................................................................................ 169
Creating Users ....................................................................................................................... 170
Insight Review........................................................................................................................ 172
Importing Extended User Information .................................................................................... 172
Appendix A: Communications Task Configuration .................................................................... 173
Appendix B: Upgrading the Database to SQL Express 2005 ................................................... 175
Appendix C: Insight Express Feature Set ................................................................................. 176
Overview ................................................................................................................................ 176
Appendix D: Panel Firmware Versions Support ........................................................................ 177
Appendix E: Microsoft SQL Server Express limitations ............................................................ 178

5

Protect Your Insight Professional Software Investment
with an Inner Range
Software Maintenance Agreement
For a modest annual fee you will receive:
•
•

Unlimited telephone and e-mail Customer Support by our Insight Help Desk.
Free software upgrade releases of Insight Professional for the software
modules for which you are licensed.
Get the most from your Insight Professional Security Management Software!

Complete and return the Application form contained in your Insight Professional
pack or download the form from:
http://www.innerrange.com/downloads/MaintenanceAgreement.pdf
Did you know that Inner Range Provides customer training courses?
Details of our Insight Professional System Administration courses are listed on our
Training Website at http://training.innerrange.com/index.cfm
Enrol on-line or contact Inner Range on (03) 9753 3488 or via email to:
admin@innerrange.com

INSIGHT HELP

Insight includes a comprehensive Help file, which provides up-to-date
descriptions and instructions for the majority of User operations.
It is recommended that Insight Help be utilized as your first source of
information when using Insight.
Where available, the Help button on the toolbar can be used to
quickly access context sensitive help for the item that you are editing.
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Introducing Insight
Insight consists of fourteen modules. Each module is a separate program that helps you
manage an aspect of your Inner Range installation. The fourteen modules are (in the order you
will probably use them):
Icon
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Module

Description

Launch Pad

Launch Pad is a central springboard that lets you
quickly navigate to the other Insight modules.

Insight Edit

Insight Edit lets you inspect and modify the
programming of your Inner Range system, including
virtual panels.

Insight Review

Insight Review lets you examine live and archived
panel review, generate simple reports and manage
alarms.

Insight Schematic

Insight Schematic allows operators to monitor the
status of an installation via graphical floor plans and
site maps.

Advanced Reports

Advanced Reports lets you create complicated reports
including muster reports. Requires separate licence.

Card Pool

Card Pool lets you manage direct entry and site code
card pools. Requires separate licence.

Tag-Board

Tag-Board can help your monitor your site. It can tell
you who is in a particular area, or which area a
particular person is in.

Insight Operators

Insight Operators lets you manage access rights and
privileges of personnel who can logon to the Insight
front-end.

Insight Photo ID

Insight Photo ID lets you design and print personnel ID
badges. Requires separate licence.

TouchScreen Layouts

Design and maintain screens and programming for
your colour touchscreen terminals.

Licence Manager

Licence Manager activates paid features (not required
for Insight Installer).

Insight Archiver (SQL)

Insight Archiver provides a one-click backup solution
for your Insight security database.

Enrol Panel

Enrol Panel is used to initiate panel communications to
the Concept 4000 Hardware. Ensure the
communication options within the panel have been set
prior to running this module.




Paid Feature
Licence Manager, Insight Operators, Touch Designer, Enrol Panel and Insight Schematic are
part of Insight Professional. All other modules are separately licensed.

Warning
Insight is compatible with version 5 panel firmware. You can enrol version 4 panels, but they
must be upgraded to version 5 after enrolment before they can be managed in Insight. Detail on
the upgrade procedure is available in the Insight V5 Getting Started Manual.
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Product Highlights
Connectivity
 Insight is a true multi-panel, multi-workstation system.
 Insight uses Octane™ compression for fast upload/download, even over slow links.
 Supports direct serial, Ethernet and internal modem connections. Future releases will
add support for external modems.
 Supports multiple paths with automatic switching to redundant paths on link failure.
 An Insight INSTALLER connection to a Panel can now be established while a
permanent Insight Pro or Insight Express connection is already in place. This allows
remote Installer access when necessary without interfering with the on-site Insight
operations. Operators are alerted to changes made by the other Insight instance so
that appropriate actions can be taken to synchronize the databases. i.e. Mark the
changed records for upload. Note that the Panel must be V7.4 or later and have 128k
or 512k memory to support the two active Insight Comms Tasks, and both Insight
instances must be V5.2 or later.
Editing
 Changes to module programming take effect immediately, without a LAN secure.
 The LAN status of modules, zones and auxiliaries is displayed.
 Selectively show or hide items based on:
o Name
o LAN status (secured, missing, unexpected, not installed)
o Programming status (blank, programmed, queued for upload/download)
 You can have multiple forms open at the same time.
 Single-click hyper-linking between forms (“[Help], [9] / [Help], [0]” functionality).
 On-line data comparison between the front-end database and any panel.
 Automatic detection of edits made at any Elite Terminal.
 Insight V5.2 supports Concept 4000 Control Module (Panel) firmware up to V7.4.
 User editing provides the following features:
 Users can be exported. This allows an operator to make preset templates
easily and observe how the import file format should appear. (V4 or later)
 Multiple Users can be selected for blanking records or exporting. (V4 or later)
 When managing Inputs assigned to an Area, the operator can actively filter the input list
by “Currently equipped”, “System Input” or “Zone Input”, to simplify the Input selection
process.
Virtuality
 Virtual users and virtual panels lets you share common users easily between multiple
panels.
 Multiple Virtual Users can be selected for edit operations such as delete. (V4 or later)
Reports
 Comprehensive reporting including muster reporting, time on site, activity reports and
system programming reports.
 Fully flexible report designer enables creation of custom report layouts and content.
Management
 Perform full or partial uploads and downloads.
 Upload individual records.
 Full support for offline editing.
Control
 Remotely control areas, area lists, auxiliaries, auxiliary lists, doors, door lists, floors,
floor lists, home auxiliaries and zone inputs.
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DVR Integration
 Control DVRs and cameras including live digital video feeds and remote camera
control.
Online Help
 Comprehensive context sensitive help. Press F1 for help on any screen!
 Helpful tips are shown when each module starts. These can be turned off if required.

Alarm Forwarding Service
 An optional “IP – XMIT” Alarm Forwarding Service module is available. (V4 or later)
 Functions as one path for panel XMIT alarm events to be sent to a central monitoring
station's Automation system.
 Contact-ID and IR-Fast formats are supported.
 Intended only for situations where Insight is installed in the monitoring station and
connected via an RS232 serial link to a co-located monitoring station Automation
System.
 The IP-XMIT module requires a separate, special license, available for purchase on
consultation only.

Registering Insight Professional
Insight Professional must be registered within 30 days of installation. See page 103 for more
information.



Tip
A searchable colour version of this manual is available in electronic form. Click Start
®
Programs Insight Insight User Guide (requires free Adobe Reader software:
http://www.adobe.com).

All

Insight Professional (Demo Edition)
Insight Professional is available in a demonstration edition. This version is identical to Insight
Professional, with five exceptions:






Operator passwords are bypassed.
Only the first five items of each type are visible (doors, areas, users, maps etc.)
You are logged off every two hours.
A different USB security key is used.
Licence Manager is not available.
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Launch Pad
Launch Pad is the “command centre” of Insight. It’s a module that lets you quickly navigate to all
other modules. When you close Launch Pad, it moves to the system tray for easy access (next
to your clock in the Windows task bar).
Launch pad also lets you specify key Insight settings such as when Operators need to log on.

Wallpaper

Launch Buttons
Tip Window

Company Logo

The launch buttons let you launch other modules with one button click.
The tip window provides information about each module. Point your mouse over a
launch button for a description of that module.
The wallpaper improves the aesthetics of Launch Pad. You can select from a library of
default wallpapers, or choose your own.

Starting Launch Pad
You can start launch pad in two different ways:
1. Click the start button and choose Programs
Inner Range
Insight
Insight
Launch Pad
2. When you start your computer, Launch Pad appears automatically in the system tray
(next to your computer clock). Click the icon.



Tip
If Launch Pad is running, you can access it from the system tray. Click the Insight icon to open
it. (On Windows XP, you may need to click the  button to display all icons.)
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Launching a Module
You can start a module in one of four ways. Choose the one that is most
convenient for you.
1. Click the module icon with the mouse.
2. Right-click the launch pad icon in the system tray, and in the pop-up
menu that appears click the name of the module you want to
launch.
3. In any module, click the Launch menu, and then click the module you want.
4. Hold down the control key, and then click the number key that corresponds to that
module. (See the Launch menu for the number assignment of each module.)
You may need to log in to the module with an operator name and password.



Tip
You can run multiple different modules simultaneously - you don’t have to quit a module before
starting another module. If a module is already open, then attempting to launch another copy
switches to the open module instead.

Logging In
You have to log on as an operator before you can use any
module. When you start a module, you are prompted to enter
your operator name and password.
1. Enter admin as the operator name.
2. Enter admin as the password.
3. Click Log On.



Tip
Insight ships with two default operators: admin and installer. You can edit these operators and
create new operators with the Operators module (professional version only).

Changing Launch Pad Preferences
You can customise aspects of Launch Pad.
1. On the Edit menu, click Preferences.
2. Make your changes.
3. Click Save or Apply.
The settings are:
Play Sounds: clear this check box if you do not
want to hear a beep as the mouse moves over a
launch button.
Wallpaper: change the appearance of Launch Pad.
Choose from a library of built-in wallpapers, or
choose your own. You can also fade the wallpaper
to make it less obtrusive.



Tip
Settings are saved per operator. If you log on to launch pad, your previously saved settings are
restored. When launch pad starts, no operator is logged in. You can still change preferences,
which will be restored the next time launch pad is started.
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Changing Client Settings
You can change Insight settings for your workstation. These
settings apply universally to all modules on the workstation.
1. On the Tools menu, click Insight Client Settings
2. Make your changes.
3. Click Save or Apply.
The settings are:
Server
o Server Address (not available in Installer):
specifies which computer is running the
Insight Database Server. If Insight is
installed on a single computer, or if this computer is the server in a multicomputer installation, then select “This Computer”. If this computer is not the
server in a multi-computer installation, click “another computer” and enter the
name or IP address of the server computer.
Logging
o Specifies diagnostic logging options. Do not modify these settings unless
instructed by an Inner Range technician.
Client
o Client Options: tick this option if you want Launch Pad to appear whenever an
Insight module is closed.
o Password Caching: specifies when Operators must enter their password. If
caching is enabled, then Operators do not need to enter their name and
password until they quit a module, at which point the cache is cleared. If
caching is disabled, then Operators must enter their password every time a
module is started.



Tip
Press F1 at any time to get content sensitive help.
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The Insight Toolbar
The Insight Toolbar is the management centre of Insight. The toolbar is where you create and
manage sites, enrol panels, control field devices and perform panel programming and
maintenance. The Insight Toolbar is available in all modules.
Use the Insight Toolbar to:
Enrol panels
Connect and disconnect panels
Create master sites and sub-sites
Copy or move panels between sites
Import, export and duplicate panels
Perform selective upload and download
Remotely control hardware and modules

Master Site

Gripper

Panel

Sub-Sites
Site Tree

Tabs

The Site Tree displays all the sites and panels being managed by Insight.
The gripper lets you undock (float) the toolbar, move it around, or dock (anchor) it.
Use the tabs to select different modes of the Insight Toolbar (page 33).

17

Working With Sites
When using Insight, you organise your panels into
collections called sites. A site is a “container” for adding
panels, virtual panels and DVRs. When you create a
site, you specify a name and some contact details.
Tip
Sites don’t have to correspond to actual, physical sites.
You may wish to have a new site per customer, or you
may want to group your panels by geographic area, or
you may choose to store all of your panels in one site.





Tip
When Insight is installed, it creates a single site called
“Default Site”. If you want, you can delete this site or rename it to something else.

Previous Software
In PCDirect and WinDirect, sites are called clients. Sites are more powerful, because:
One site can hold more than one panel.
Sites can be contained within other sites, forming a ‘hierarchy’.
Master Sites and Sub-Sites
If a site is contained within another site, it is called a sub-site. Sites that are not contained by
other sites are called master sites.



Paid Feature
You cannot create sub-sites in Insight Installer.

To Create A New Master Site
1. Right click the blank white area below the bottom of the Sites Tree, and choose “New
Master Site…” in the menu that appears. (Tip: you may have to scroll to the bottom of
the Site Tree to find the blank area.)
2. Enter a unique name for the site.
3. Click OK.
To Create A New Sub-Site (licensed versions)
1. Right click an existing site and choose “New Sub-Site…” in the menu that appears.
2. Enter a unique name for the site.
3. Click OK.



Operator Permissions
To create a new master site, you must have the create permission for sites. To create a new
sub-site, you must have the create permission for sites and the change permission on the
parent site.
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To Edit Or Rename An Existing Site
1. Right click the site and choose “Properties…” in the menu that appears.
2. Edit the details of the site.
3. Click OK.



Operator Permissions
To edit or rename a site, you must have the change permission on that site.

To Move A Sub-Site (paid versions)
1. Click the site you want to move, and keep the mouse button down.
2. Drag the site into its new location.
3. Release the mouse button
Panels are moved with the site.



Operator Permissions
To move a sub-site, you must have delete permission on the site being moved and change
permission on both the old and new parent sites.
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Working With Panels
You cannot work with a panel until it has been created in Insight. There are three methods of
creating panels:
1. Enrolling: this is the normal method. The panel is physically connected, and is fully
uploaded into Insight.
2. Importing: with this method, the operator specifies a template file that is loaded into
Insight. The panel is connected later on for full or partial download from the template.
3. Copying: the programming of an existing panel can be duplicated, creating a new
panel. The programming of the new panel can then be fully or partially downloaded later
on.





Tip
Insight ships with a number of “empty panel” templates, including Standard, Enlarged, Access,
Access 2, Alarms, Apartments, Extra Door and Special. You can use these templates as a basis
for panel programming without enrolling an empty panel.
Note
Panel connections are always made through Insight Server. For direct serial connections, the
panel must be connected to the server computer. For dial-up connections, the PC modem must
be connected to the server computer.
Paid Feature
By default, you can only manage one panel with Insight Professional . If you want to manage
multiple panels with Insight Professional, you must purchase a multi-panel licence.

Enrolling Panels
Enrolling a panel makes the panel available in Insight, and
also uploads (reads) all of the existing programming and
users from the panel. To upload a panel:
The panel must be powered on.
Insight must be able to communicate with the panel
(via direct serial, dial-up or TCP/IP).
A comms task must be configured in the appropriate
format. For PCDirect, consult your programming
manual. For Insight, see page 173.
To enrol a panel:
1. In the Insight Toolbar, decide which site will contain
the panel. If necessary, create a new master site or
sub-site.
2. Right click on the site that will contain the panel,
and choose “Enrol Panel…” in the menu that appears.
3. The Enrol Panel window appears. Enter the correct information for the panel being
enrolled (see following pages).
4. Click the Enrol Now button. A new window appears, showing enrolment progress.



Note
Some of the settings on the enrolment screen must match the equivalent settings in Insight, or
enrolment will fail. For your convenience, these fields are marked with a small Control Module
icon ( ) in Insight. Double-check that these settings match the settings in the panel.
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Note
You can only enrol panels from the Insight Server computer. You cannot enrol panels from an
Insight Client computer.

Operator Permissions
To enrol a panel, you must have the create permission for panels and the change permission
on the containing site. The permissions for the new panel are copied from the defaults tab of
each Operator Type.
Previous Software
Uploading a panel in WinDirect and PCDirect was a very time consuming task. Insight uses
Octane™ compression to upload the panel many times faster. Depending on panel contents
and transfer conditions, Insight can upload up to 600% faster than PCDirect / WinDirect.

If you are enrolling a version 5 or later panel:
Name:
Panel ID:

Serial Number:

IP Door Controller:
Add To Site:

Enter a name for the panel.
Enter the 8 digit panel identification number. This number
must match the panel ID specified in the Insight comms
task.
Enter the panel serial number (press [Menu], [2] on any
terminal). You must enter the number exactly as it appears,
including leading zeros.
Tick this box if you are enrolling an IP Door Controller.
Shows the site that will contain the newly enrolled panel.

Encryption Key:

Enter the encryption key for this panel (exactly 32 digits).
This number must match the Insight A & Insight B fields
specified in the Insight comms task. Leaving this field blank
is equivalent to selecting all zeros.

Connection:

Specify the connection method you will use to enrol the
panel.
Ethernet Panel Ethernet UART: select this option
if you wish to use your computer’s TCP/IP network
and/or the Internet, and the panel is fitted with a
TCP/IP Ethernet UART board.
Serial Port Panel UART: select this option if you
are using a direct serial connection between Insight
Server and the panel.
PC Modem Panel External Modem: choose this
option if you wish to use a modem on the Insight
Server computer to dial an external modem on the
panel.
PC Modem Panel Internal Modem: choose this
option if you wish to use a modem on the Insight
Server computer to dial the internal modem on the
panel.

Settings:

Panel Server:
Protocol:
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Specify any additional connection parameters here.
Settings such as baud rate and IP address must match
those of the panel.
Do not change this setting from ‘LOCAL’.
Set this to Insight. Make sure comms task 1 is configured
as Insight (page 173).

Installer PIN:

This field is disabled when you select the Insight protocol.

If you are enrolling a version 4 panel:
Name:
Panel ID:

Serial Number:

IP Door Controller:
Add To Site:
Encryption Key:

Connection:

Enter a name for the panel.
Enter a unique, non-zero number in this field. The first two
digits should be 00. Later on, when the panel is upgraded to
version 5, you must configure the Insight comms task with
this value.
Enter the panel serial number (press [Menu], [2] on any
terminal). You must enter the number exactly as it appears,
including leading zeros.
Leave this field un-ticked.
Shows the site that will contain the newly enrolled panel.
Enter the encryption key for this panel (exactly 32 digits).
Later on, when the panel is upgraded to version 5, you
must configure the Insight comms task with this value.
Leaving this field blank is equivalent to selecting all zeros.
Specify the connection method you will use to enrol the
panel.
Ethernet Panel Ethernet UART: you cannot select
this option when enrolling a version 4 panel.
Serial Port Panel UART: select this option if you
are using a direct serial connection between Insight
Server and the panel, or if you are using a serial to
TCP/IP protocol converter.
PC Modem Panel External Modem: choose this
option if you wish to use a modem on the Insight
Server computer to dial an external modem on the
panel.
PC Modem Panel Internal Modem: choose this
option if you wish to use a modem on the Insight
Server computer to dial an internal modem on the
panel.

Settings:
Panel Server:
Protocol:
Installer PIN:

Specify any additional connection parameters here.
Settings such as baud rate must match those of the panel.
Do not change this setting from ‘LOCAL’.
Set this to PCDirect. Make sure there is a PCDirect comms
task configured in the panel.
The PIN number of User 1 in the panel.



Warning
Although you can enrol version 4 panels, you cannot manage them with Insight until they are
upgraded to version 5.
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Troubleshooting
If you receive a message to say that the upload failed, review the following checklists.
If you are using the Insight protocol to enrol the panel:
If you upgraded the panel from version 4:
o Was your firmware upgrade successful? (Press [Menu], [2] on any Elite
Terminal, and confirm that the version is 5.xx)
o Did you remember to default the panel?
The Insight comms task must be Comms Task 1.
Check the configuration of your Insight comms task matches with the Insight software:
o Panel ID (which must be unique and non-zero)
o Connection method and parameters (including baud rate etc.)
Check you have entered the panel serial number correctly (including leading zeros)
If you’re enrolling an IP Door Controller, make sure you ticked the IP Door Controller
option. If you’re enrolling a regular Control Module, leave the option cleared.
If you are using Serial Port
Panel UART, make sure you have specified the correct
serial port on your PC, and that no other programs are using this port.
If you are using Serial Port
Panel UART, and you are using a USB serial port, try
using a legacy (physical) serial port, if possible.
Make sure you have given Insight the correct protocol information. In particular, check
that:
o The protocol is set to ‘Insight’.
Make sure the other Insight options are correct (page 173).
Try stopping and starting the Insight comms task.
Try restarting your computer.
If you are using the PCDirect protocol to enrol the panel:
Make sure your panel ID is unique. Even though PCDirect doesn’t use it, Insight still
checks this number because it will be used later on.
Make sure you have given Insight the correct protocol information. In particular, check
that:
o The protocol is set to ‘PCDirect’.
o You have entered the correct installer PIN.
Check the configuration of your PCDirect comms task matches with the Insight
software:
o Connection method and parameters (including baud rate etc.)
If you are using Serial Port
Panel UART, make sure you have specified the correct
serial port on your PC, and that no other programs are using this port.
If you are using Serial Port
Panel UART, and you are using a USB serial port, try
using a legacy (physical) serial port, if possible.
Try stopping and starting the PCDirect comms task.
Try restarting your computer.
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Creating Panels From Templates
You can create a panel from a template. Templates can be
blank panel configurations from Inner Range, or any panel
that you’ve exported previously. Once you’ve created the new
panel you can download it into a physical panel at a later date.
To create a panel from a template:
1. In the Insight Toolbar, decide which site will contain
the panel. If necessary, create a new master site or
sub-site.
2. Right click on the site that will contain the panel, and
choose “New Panel From Template…” in the menu
that appears.
3. The Create New Panel window appears. Enter the correct information for the panel
being created.
4. Click OK.
A progress window appears while the panel is being imported.





Note
The new panel will be created with the name, ID and serial number you specify. After creating
the panel, you must manually set up protocol parameters and connection paths. In the Insight
Toolbar, right click the new panel and select “Properties…” from the menu that appears, then
click the Protocol and Ports tabs.
Tip
Insight ships with a number of “empty panel” templates, including Standard, Enlarged, Access,
Access 2, Alarms, Apartments, Extra Door and Special. You can use these templates as a basis
for panel programming without enrolling an empty panel.
Operator Permissions
To import a panel, you must have the create permission for panels and the change permission
on the containing site. The permissions for the new panel are copied from the defaults tab of
each Operator Type.

Field Descriptions:
File Name:
IP Door Controller:
Panel Name:

Click the ... button and navigate to the template file you
wish to import.
Tick this option if you will be connecting to an IP Door
Controller instead of a regular Control Module.
Enter a name for the new panel.

Panel ID:

Enter the panel identification number. This number must
match the panel ID specified in the Insight comms task. If
you do not know the panel ID (for example, the panel has
not yet been delivered), enter any unique number here, and
change it later on.

Serial Number:

Enter the panel serial number (press [MENU], [2] on any
terminal). You must enter the number exactly as it appears,
including leading zeros. If you do not know the panel serial
number, enter any number here, then change it later on.
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Duplicating Panels
You can duplicate a panel that you have already enrolled, and
then download the duplicate panel into a physical panel at a
later date.
To duplicate a panel:
1. In the Insight Toolbar, decide which site will contain
the duplicate panel. If necessary, create a new master
site or sub-site.
2. Hold down the Control key on the keyboard.
3. Click on the panel you want to duplicate, but do not release the mouse button.
4. Drag the panel onto the site that will contain the duplicate. A plus sign appears.
5. Release the mouse button. (You can release the Control key as well.)
6. The Copy Panel window appears. Enter the correct information for the panel being
created.
7. Click OK.
The new panel is created.



Note
The new panel will be created with the name, ID and serial number you specify. After creating
the panel, you must manually set up protocol parameters and connection paths. In the Insight
Toolbar, right click the new panel and select “Properties…” from the menu that appears, then
click the Protocol and Ports tabs.



Operator Permissions
To duplicate a panel, you must have the create permission for panels, the inspect permission
on the panel being copied, and the change permission on the site that will contain the copy.

Field Descriptions:
Panel Name:
Panel ID:

Serial Number:

Enter a name for the duplicate panel.
Enter the panel identification number. This number must
match the panel ID specified in the Insight comms task. If
you do not know the panel ID (for example, the panel has not
yet been delivered), enter any unique number here, and
change it later on.
Enter the panel serial number (press [Menu], [2] on any
terminal). You must enter the number exactly as it appears,
including leading zeros. If you do not know the panel serial
number, enter any number here, then change it later on.

Moving Panels
You can move a panel from one site to another site.
To move a panel:
1. In the Insight Toolbar, decide which site you want to move the panel to. If necessary,
create a new site.
2. Click on the panel you want to move, but do not release the mouse button.
3. Drag the panel onto the site you want to move it into. A special icon appears.
4. Release the mouse button. The panel is moved.
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Panel Connections
For communications to occur between a panel and Insight, it must be connected. Connections
occur over a configured connection path. Insight supports a number of different connection
paths. The following table is ranked in order of reliability and lowest line cost, best option first.
Path
Ethernet
Serial
1
Serial
Dial-up
Dial-up
GSM

Panel Hardware
Panel Ethernet UART
Panel UART
Panel UART converter
External modem
Internal modem
Panel UART FE3000

Ethernet

Insight Hardware
TCP/IP
Serial port
TCP/IP
Modem
Modem
TCP/IP

Suitable For
Permanent connections
Permanent connections
Permanent connections
Non-permanent
Non-permanent
Non-permanent

1

This option employs a Serial to TCP/IP protocol converter and should only be used if a V4
panel must be connected to Insight via Ethernet. i.e. Part of the link is Ethernet, however the
end-to-end protocol is serial.
When a panel is not connected, you can do the following:
Make offline edits to panel programming with Insight Edit, which will be downloaded to
the panel later.
Manage card pools with Insight Card Pool (requires separate licence).
View archived review data with Insight Review or Insight Advanced Reports (requires
separate licence).
Generate reports on archived data with Insight Review (professional edition)
Backup your entire Insight database with Insight Archiver SQL (professional edition) or
Insight Archiver (Installer edition)
Create and manage operators with Insight Operators (professional edition)
When a panel is connected, you can perform the following additional actions:
Transmit changes to panel programming (including user cards and PINs)
Control field equipment (such as doors, zone inputs and auxiliaries)
View live security logs (review) from the panel
Receive alarms (professional edition)
Monitor field equipment status with Insight Schematic (professional edition)
Update panel info in Insight.
Update LAN status in Insight.
Set the panel time.



Tip
A summary of panel connections is shown in the status bar at the bottom right of most Insight
modules. If no panels are connected, a blinking red
square is shown. Yellow
means some panels are connected, and green means all panels are connected. Click the red
square to stop it flashing.
To configure an Ethernet connection:
1. In the panel, configure CT001 as Insight (page 173). Ensure Ethernet options are
configured including Insight IP, Panel IP, Router IP and Subnet Mask. Ensure Ethernet
options are set to ACE.
2. In Insight, right click the panel in the Insight Toolbar and choose “Properties ” in the
menu that appears.
3. Click Ports.
4. On the Ports tab, tick the TCP/IP option.
5. Click OK.
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Note
This information applies to a panel with an Ethernet UART. If you are using a protocol converter,
configure a serial connection, then consult the documentation that came with your converter.



To configure a serial connection:
1. In the panel, configure CT001 as Insight (page 173). Ensure serial options are
configured including panel UART port and baud rate. Ensure serial options are set to
ACE.
2. In Insight, right click the panel in the Insight Toolbar and choose “Properties ” in the
menu that appears.
3. Click Ports.
4. On the Ports tab, tick the Direct Serial option.
5. On the Serial tab, set the PC serial port and baud rate. The baud rate must match the
baud rate you programmed in step 1.
6. Click OK.

To configure a dial-up connection:
1. In the panel, configure CT001 as Insight (page 173). Ensure serial options are
configured including panel UART port and baud rate. Ensure internal modem options
are set to ACE.
2. In the panel, configure CT002 as I-modem (page 174).
3. In Insight, right click the panel in the Insight Toolbar and choose “Properties ” in the
menu that appears.
4. Click Ports.
5. On the Ports tab, tick the Internal Modem option.
6. On the Internal Modem tab, set the dial-up number.
7. If you are using fax bypass, tick the fax bypass option.
8. Click OK.



Tip
In timed fax bypass mode, Insight calls the panel, hangs up after 2 rings, then re-dials the panel
60 seconds later. You must activate the timed fax bypass mode in the panel – see the callout
box on page 174.

Permanent Connections
If your panel is wired for Ethernet or direct serial connections, then you will generally want to
leave it permanently connected. Insight can be configured to always keep a connection open on
one of these paths – this is known as a permanent panel connection. On the other hand, for
dial-up connections, you generally want to choose when the panel is connected manually. This
is called a non-permanent connection.
To set up a panel to be permanently connected:
1. In the Insight comms task for the panel, ensure that Ethernet and/or direct serial paths
are configured and enabled.
2. In Insight, ensure that Ethernet and/or direct serial paths are configured and enabled
(pp. 27-28).
3. Right click the panel in the Insight Toolbar, and choose “Properties ” in the menu that
appears.
4. Click Protocol.
5. Select the Connection tab.
6. Select the Permanent Connection radio button.
7. Click OK. Insight will attempt to keep the panel connected via Ethernet or direct serial.
(Insight will not attempt to dial the panel if these paths are unavailable.)
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To set up a panel so that connections are managed manually by operators:
1. Right click the panel in the Insight Toolbar, and choose “Properties
appears.
2. Click Protocol.
3. Select the Connection tab.
4. Select the Non-Permanent Connection radio button.
5. Click OK.

” in the menu that

Panel Initiated Connections
You can configure your panel to automatically connect to Insight Server via dial-up if an alarm
occurs. The panel will connect in these circumstances:
1. An XMIT event occurs.
2. There is an IMODEM comms task configured in the panel with outgoing connections
enabled (page 174).
3. There is at least one Insight modem configured to receive incoming calls (page 32).
Scheduled Connections (Insight 3.2 or later)
You can configure Insight to automatically connect to a
panel on a periodic basis. The panel must be
configured for manual connections (see top of page)
and a dial-up connection must be configured (page 28).
The connection will be maintained until a condition you
specify is satisfied, such as all review being received.
Scheduled connections are configured independently
for each panel.
To schedule automatic connection:
1. In the Insight toolbar, right-click the panel you
want to configure and choose “Schedule
Connection” in the menu that appears.
2. Tick the Schedule Panel Synchronisation check box.
3. Specify how often to connect, and on which days and at what time to establish the
connection.
4. Specify the connection duration. The options are:
Maximum Minutes. The connection will be maintained for the number of minutes you
specify.
Until Synchronised. Insight only connects to the panel if records are marked for
upload/download. Upon connection, Insight maintains communication with the panel
until the panel and Insight are synchronised.
Until No Review Received. The connection will be maintained until all review has been
downloaded from the panel.




Tip
If you want the connection to be maintained until you manually disconnect, set the Connection
Duration to “Maximum Minutes” then enter 0 in the minutes field.

Note
If Insight can’t establish a connection with the panel, it will retry periodically for the next twelve
hours.
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Note
The ‘Until Synchronised’ connection duration should only be chosen if Insight is the sole means
panel programming is changed and if there is no requirement to retrieve new review data.




Operator Permissions
To configure connection scheduling, you must have the control permission for the panel.

Understanding Connection Status
The status of the panel is displayed graphically in the Insight Toolbar. Refer to the following
table:
Icon






Path

Status

Description

TCP/IP
Serial
Ext. modem
Int. modem

Disconnected

The panel is not connected. Programming changes
will be queued. Status information and live review
is not available. Hardware cannot be controlled.

TCP/IP
Serial
Ext. modem
Int. modem

Connected

The panel is connected. Live and queued
programming changes will be transmitted (provided
the panel isn’t locked – see page 41). Review and
status information is available. Hardware can be
controlled.

TCP/IP
Serial
Ext. modem
Int. modem

Connection error

The connection could not be established, or has
been lost. See ‘troubleshooting’ on page 24.

Tip
Connections can take up to twenty seconds to establish. While Insight is negotiating the
connection, the panel icon changes to
.

Note
When a panel becomes connected, the following operations are performed automatically:
refresh LAN status (page 37), check for terminal edits (page 42), check memory configuration
(page 61), download review (page 86).
Tip
You can get more information about the current connection status of a panel. Right click the
panel and choose “properties” in the menu that appears, then click the “status” icon.

Tip
To get a quick overview of the status of all panels in an installation, click the status tab of the
Insight Toolbar. It lists all panels in a flat hierarchy, with all sub-sites removed from the tree.
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Manual Connections
You can manually connect a panel in Insight. Use this option to connect to a dial-up panel, or if
you have configured a panel to be non-permanently connected.
To connect a panel:
1. Right-click the panel in the Insight Toolbar, and choose “Auto
Connect” in the menu that appears.
Insight establishes a connection with the panel. The connection icon
turns green with a tick upon success, or red with a cross if the
connection could not be established.




Note
The connection will remain active, even if you close all Insight modules. The connection will only
be broken if you choose to disconnect, or if the Insight Server is stopped.

Tip
If the panel is configured with multiple connection types (for example, direct serial and dial-up),
Insight tries the ‘best’ path first. Insight always tries to connect in this order: TCP/IP, direct
serial, dial-up to external panel modem, dial-up to internal panel modem, GSM. Only configured
paths are tried – see page 33.




Tip
If you don’t want to use “auto connect” you can manually specify a connection method. After
right-clicking the panel, choose “connect” in the menu that appears, then specify the connection
method to try. You can only select paths that have been configured for that panel.
Operator Permissions
To connect to a panel, you must have the control permission for the panel.

To disconnect a panel:
1. Right-click the panel in the Insight Toolbar, and choose “Disconnect”.




Note
If you disconnect a panel and it is configured for permanent connection, Insight will immediately
attempt to reconnect with the panel. You should configure the panel with a non-permanent
connection first. See page 29.

Operator Permissions
To disconnect a panel, you must have the control permission for the panel.
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Modem Blocking
If you have multiple modems, you can choose which
modems can be used by Insight.
To prevent Insight from using a modem:
1. On the Insight Server computer, right click the
Insight Server tool in the system tray, and choose
“Settings Modems…” in the menu that appears.
(On Windows XP, you may need to click the 
button to display all icons.)
2. Select the modem you want to block.
3. Click the Disable button. Insight will not make or
receive calls using that modem.

To allow Insight to use a modem for outgoing calls only:
1. On the Insight Server computer, right click the Insight Server tool in the system tray,
and choose “Settings Modems…” in the menu that appears.
2. Select the modem you want to make available for outgoing calls.
3. Click the Enable button. Insight will use the modem for outgoing calls. Insight will not
receive calls using the modem.

To allow Insight to use a modem for receiving incoming calls only:
1. On the Insight Server computer, right click the Insight Server tool in the system tray,
and choose “Settings Modems…” in the menu that appears.
2. Select the modem you want to make available for incoming calls.
3. Click the Listen button. Insight will receive incoming calls using the modem. Insight will
not use the modem for outgoing calls.



Note
You cannot configure a single modem for both incoming and outgoing calls. If you want to make
and receive calls, you will need two different modems.

Panel Properties
You can find out further information about
your panel by opening the panel properties
window. From here you can rename the
panel, change Insight protocol settings,
configure communications ports, set the
panel date and time, perform directory
maintenance and inspect other panel
properties such as firmware version and
PCB revision.
To open panel properties:
1. Right-click the panel in the Insight
Toolbar, and choose “Properties…”
in the window that appears.
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To change protocol settings:
1. Open panel properties and click the “Protocol” icon.
2. Fields marked with a Control Module icon must match the corresponding settings in the
Insight comms task.
3. Click OK.



Tip
You can configure Insight to connect panels automatically under certain conditions. Open panel
properties, click the “Protocol” icon then click the Connection tab.

To change port settings:
1. Open panel properties and click the “Ports” icon.
2. Fields marked with a Control Module icon must match the corresponding settings in the
Insight comms task.
3. Click OK.



Tip
You can configure multiple paths (such as direct serial and dial-up) so that if one path fails,
additional paths can be tried.

To set the panel date and time:
1. Open panel properties and click the “Maintenance” icon.
2. Click the Date/Time button. (Panel must be online to enable this button)
3. To synchronise the panel time with the time on the workstation you are using, click the
“PC Time” button. To set the date and time manually, highlight each digit and click the
up and down buttons.
4. Click OK.




Note
The panel must be connected before you can set the date or time. If the panel is not connected,
the button is disabled.

Warning
Changing the panel date and time causes all time zones, diaries and holidays to be reevaluated, which in turn could alter the state of auxiliaries, calculated auxiliaries and other
system entities.
To automatically synchronise the panel date and time with Insight Server:
1.
2.
3.
4.
5.

Open panel properties and click the “Maintenance” icon.
Click the Schedule button.
Tick the “Schedule Panel Time Synchronisation” box.
Specify how often you wish to synchronise the panel with Insight Server.
Click OK.




Note
When synchronising, the panel date and time is changed to match the date and time of Insight
Server.

Note
For synchronisation to occur, Insight server must be running.
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Remote Control Field Hardware
You can control your Inner Range security system
remotely using Insight. You can control areas, area lists,
auxiliaries, auxiliary lists, doors, door lists, floors, floor
lists, home auxiliaries and inputs.
To control items remotely:
1. Click the Control tab of the Insight Toolbar.
2. Click the item type you want to control
3. A window appears containing the items of that
type, and after a moment the current state is
displayed.
4. Highlight the item(s) you want to control.
5. Click the appropriate control button to control the item.







Tip
You can select multiple items by holding down the SHIFT or CONTROL keys whilst clicking.

Tip
If an item changes state, the change will be reflected in the control window within five seconds.

Tip
The Insight Toolbar doesn’t have a Control tab in Insight Schematic. To control items in
Schematic, right click the item directly on the map and choose from the menu that appears.

Tip
You can control DVRs and cameras using Insight. See page 139.

Operator Permissions
To control an item you must have the control permission for that item.
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Insight Edit
Insight Edit lets you inspect and modify the programming of your Inner Range security system.
This includes initial configuration of all security parameters during site commissioning,
inspection and modification of programming as time progresses and ongoing site management
functions such as allocating user cards and PINs.
Use Insight Edit to:
Inspect panel programming
Program panels and modules
Manage user cards and PINs
Import extended user programming
Program virtual panels and virtual users
Browse Toolbar
Text Filter

Status Filters
= installed
= missing
= unexpected
= not installed

Insight Toolbar

= upload marker
= download marker

Double-Click
To Edit

Browse Pane

The Insight Toolbar lets you manage your sites and panels (page 17).
The browse pane displays items you can program (page 36).



Note
The following sections deal with panel programming. You can only program panels that have
been enrolled into Insight. To learn how to enrol panels, see ‘enrolling panels’ on page 21.
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Using the Browser
The most important part of Insight Edit is the browser pane. Once you have mastered the use of
this pane you can quickly and easily make programming changes to your panels.
Text Filter

Programmed Item (solid)

Status Filters

= upload marker
= download marker

= installed/secured
= missing/not responding
= unexpected/unsecured
= not installed

Unprogrammed Item (translucent)

Item Count

Navigation
The browser pane is driven from the Insight Toolbar. To program a particular item:
1. In the Insight Toolbar, click the browse tab.
2. Expand the tree for the panel you wish to program.
3. Click on the programming item you want.




Tip
You can change the layout of the Insight Toolbar by selecting “Preferences…” on the Edit menu,
then clicking the Interface tab. Installers who are used to the terminal menus will probably want
to use the “installer” layout.
Tip
By default, the browser pane is set to large icon view (pictured). You can
select different views with the Browse Toolbar. In particular, ‘detail’ view
allows you to sort the information by clicking on the column headings.
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Understanding Item Status
Various graphics and symbols are used in the browser to reflect the status of each programming
item.

Symbol

Applies To

Meaning

Description

All items

Programmed

Items that are ‘solid’ have been programmed.

All items

Blank

Items that are translucent are blank / have not
been programmed.

All items

Upload

This item has been marked for upload. The next
time the panel is connected, the item will be read
from the panel.

All items

Download

This item has been queued for download. The
next time the panel is connected, the item will be
written to the panel.

Hardware items

Secured

The module is present on the LAN and secured.

Hardware items

Unexpected

The module is present on the LAN, but not
secured.

Hardware items

Missing

The module should be on the LAN but isn’t.

Hardware items

Uninstalled

The module isn’t on the LAN.

All items

Shadow

This record has been created because the panel
memory configuration has changed, and there are
more items of this type than before.

All items

Surplus

The panel memory configuration has changed,
and this record no longer fits into the new
configuration.



Tip
The status of hardware modules (secured, missing etc.) is updated each time you connect with
a panel. You can also update this status manually. Right-click the panel in the Insight Toolbar
and choose “Entire Panel” in the menu that appears, then choose “refresh LAN status”.
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Using Filters
You can filter the browser so that only key items are displayed. There are a number of different
filtering methods available.
Using Filter Buttons
You can quickly show and hide items with the filter buttons.
Click show programmed to hide or show programmed items
Click show blank to hide or show blank / unprogrammed items
Click show normal to hide or show records that aren’t surplus, shadow or marked
Click show upload to hide or show items marked for upload from the panel
Click show download to hide or show items marked for download to the panel
Click show surplus to hide or show surplus records
Click show shadow to hide or show shadow records
Click installed to hide or show secured hardware
Click missing to hide or show missing hardware
Click unexpected to hide or show unexpected hardware
Click not installed to hide or show uninstalled hardware
To use the filter buttons:
1. Click the appropriate filter button. If the button is active (pressed in), then items
matching that type will be displayed.



Note
Filters are saved for each different item type, even when you exit Insight Edit. Always check the
item count (bottom right corner) to see if there are any items hidden in the current view.

Using Filter Text
You can filter based on text that you specify. Text filtering can be applied to the short or long
name, address or notes field of regular items, and also the site code, user type and extended
information fields of users.
To use filter text:
1. Select the field you want to filter on. “Name in panel” is the short name of the item.
“Name” is the full-length Insight name. “Address” is the notated address (such as DL015
for door list 15). ‘Notes’ is the notes field kept by Insight for each item.
2. Enter the text you want to filter by.
3. Press enter. Your filter is applied.
Using Wildcards
You can use special symbols called “wild cards” in your text filters. The ? symbol matches one
letter. The * symbol matches any number of letters.
Here are some example filters to get you started.
Field
Name
Notes
Address
Address
Address
Address
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Text
PIR
delay
C01
T03:Z05
T03:Z*
T*:Z*

Description
Only show items whose name includes the word “PIR”
Only show items whose notes includes the word “delay”
Only show control module items
Show the fifth zone input on the third LCD module
Show all zone inputs on the third LCD module
Show all zone inputs on all LCD modules

Address
Address
Address
Name
Name

*:Z*
?01:Z10
*:S?5
k*
*s

Show all zone inputs on all modules
Show the tenth zone input on the first module of each type
Shows all system inputs ending in “5” on every module
Shows all names starting with the letter K
Shows all names ending in the letter S

Editing Items
To edit an item, double click the item in the browser. This opens an edit window for that item.

Edit Toolbar

Navigation
Toolbar

Tabs

Name Lock
Slider
Hyperlink

Item Pickers

Using the Navigation Toolbar
Locate this item in the Insight Toolbar tree.
Go to the first record.
Go to the previous record.
Displays the current record number. You can enter a different number to jump to that
number.
Displays the name of the current record. Click on the arrow to select a different record
to jump to.
Go to the next record.
Go to the next blank / unprogrammed record.
Go to the last record.
Using the Edit Toolbar
Save changes to the current record. If the panel is offline, mark the record for
download the next time a connection is available.
Turn autosave on or off. With autosave enabled, changes to a record are saved
automatically as soon as the record is closed or you use the navigation buttons.
Discard changes you’ve made to this record without saving them. The record reverts
to the last saved version.
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Erase the programming of this record. The record becomes blank / unprogrammed.
Upload the current record from the panel. If the panel isn’t connected, the record is
marked for upload the next time a connection is available.
Places the current record into the Windows clipboard. When you select paste, the
original record is then made blank / unprogrammed.
Copies the current record into the Windows clipboard.
Pastes from the Windows clipboard over the current record.
Undo the last action. You can repeat this command to undo all changes made since
the record was opened.
Opens the find window.
Opens the cross-reference window for this item.
Opens context-sensitive help for this item.




Tip
If you are editing a lot of records, you should probably turn autosave on. As you finish each
record, using the navigation buttons save your changes automatically.

Operator Permissions
To open an item, you must have the inspect permission for the item. To save changes to an
item, you must have the change permission for the item.

Online and Offline Edit
If you save programming changes while the panel is connected, the changes are sent to the
panel immediately. This is called “online edit”. If you make changes while the panel is
disconnected, then the changes are queued to be written later on. This is called “offline edit”.
Insight uses different colours so you can quickly see if there are edits waiting to be sent to the
panel.
Icon




Colour
Green
Blue

Meaning
Panel is up to date
Panel synchronising

Red

Panel unsynchronised

There are no edits waiting to be sent to the panel.
Programming changes are being exchanged with the
panel. The number in brackets next to the panel
name indicates how many changes are remaining to
be sent / received.
Offline edits have been made. There are
programming changes waiting to be written to the
panel.

Tip
You can configure Insight to automatically connect to a panel when you make programming
changes. Go to Panel Properties Protocol Connection, and tick the boxes that say
“Automatically connect this panel” and “when programming changes are made”.
Tip
If your panel is red (unsynchronised), you can find all records that are queued for upload or
download by opening a new search, clicking the “only match records marked for upload or
download” and clicking “Find Now” (without entering any search text).
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PIN Discovered
Two user’s cannot have the same PIN in the same panel. Insight Edit will prevent you from
setting a duplicate PIN. In addition, the user whose PIN was discovered will be asked to change
their PIN the next time they use an Elite Terminal in the field.



Note
If the panel is offline, then the PIN discovered flag won’t be set until the panel is next connected.

Scheduled User Expiry
You can configure users to expire at a certain date and time. The expiry information is
downloaded into the Control Module, which takes care of expiring the user at the appropriate
time. Typically, the panel memory configuration means that only some users can be tagged to
expire. With Insight, you can specify an expiry date for any user.
To schedule expiry for any user:
1. Open the user you wish to tag for expiration.
2. Click the Options tab.
3. Set the Expiry Date and Expiry time. If the month or year fields are set to disable, then
“any month” and “any year” are assumed, respectively. If the day, hour or minute fields
are disabled (by right-clicking their “spinner” controls), then “today”, “any hour” and “any
minute” are assumed, respectively.
4. Specify the Disabled User Type. When the expiry date and time occurs, the user will be
assigned this user type.






Note
Insight Server must be running for the cardholders to expire. If Insight Server isn’t running, then
the users will be expired the next time Insight Server starts.

Note
If the panel is offline, then the users aren’t expired until the panel is next connected.

Tip
When a user expires, the original user type is displayed in the Primary User Type box.

Tip
You can set a common expiry date for a batch of users using the Copy Wizard. See page 49.

Write-Locking Panels
Sometimes you may wish to make offline edits, but you want the panel to be online (e.g. so that
alarms can be received). In this case, the panel can be write-locked. This means that the panel
is online, but any edits are not sent to the panel until it is unlocked.
To write-lock a panel:
1. Right-click the panel in the Insight Toolbar, and choose “locked” in the menu that
appears.
2. A padlock appears next to the panel, indicating that it is write-locked. Changes will not
be sent to the panel.
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To unlock a write-locked panel:
1. Right-click the locked panel in the Insight Toolbar, and choose “unlocked” in the menu
that appears.
2. If the panel is online, then any changes will be immediately written to the panel.
Detecting LCD Terminal (Keypad) or “2

nd

Insight” Edits

The Concept 4000 security system allows programming changes to be made by authorised
users at any LCD Terminal “in the field”. Concept 4000 V7.4 or later can also be programmed
nd
to allow a 2 instance of Insight (Insight Installer) to connect temporarily for remote service
purposes. Edits performed from these sources are not automatically uploaded by Insight, but
you will be warned that changes have been made at a terminal or by Insight Installer the next
time you connect to the panel. You can then use the compare records feature (below) to
determine what type of item was edited.
Tip
If you leave Insight permanently connected to your panels, then you can manually check for
programming changes. Right click the panel, and choose “Entire Panel Compare Records” in
the menu that appears.



Comparing Insight With A Panel
If you suspect that edits have been made at an Elite Terminal in the field, or if you just want to
satisfy yourself that Insight is correctly synchronised with a panel, you can perform a
comparison between Insight and the panel. You can choose to compare the entire panel, or
only a particular type of item such as doors or areas.
To compare a panel with Insight:
1. If the panel is offline, connect to the panel.
2. Right click the panel you wish to compare and choose “Entire Panel
Records” in the menu that appears.
3. A message is displayed indicating if any records are different.

Compare





Note
It can take up to 30 seconds to compare a 512k panel. You will receive a message when the
comparison is complete.

Note
Insight will not tell you which specific records are different, only that there are differences. For
example, the message “areas are different” could mean that 1, 2 or all areas are different
between Insight and the panel.
Tip
If you have established that there are differences and you want to synchronise (remove) them,
then you should mark the different items for upload (if you want to preserve what is in the panel)
or download (to preserve what is in Insight).

To compare part of a panel with Insight:
1. If the panel is offline, connect to the panel.
2. Expand the panel tree and locate the item type you want to compare.
3. Right click the item in the tree, and choose “Compare Records” in the menu that
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appears.
4. A message is displayed indicating if any records are different.
Long Names, Notes, Name Lock Slider, Item Picker, Quick Navigation
Long Name and Notes
Insight lets you enter long names for all items, and a notes field for recording miscellaneous
details.
Name Lock Slider
Although Insight allows for long names on all items, the Control Module only has limited space
for names. To spare operators from the chore of entering both long and short names, Insight
automatically links them together. If the name is too long to fit into the panel, a tilde (~) symbol
is used.
Names are locked (default behaviour).
Names are unlocked and may be edited separately.



Tip
If you enter a very long name with numbers at the end, Insight will preserve the numbers and
remove excess characters from the middle of the name instead of the end.

Item Picker
Wherever you see a button like this (
) you can click it to open the item picker. The item
picker is a window that lets you choose from a list of items.
Quick Navigation (Hyperlinks)
Hyperlinks are blue text labels that let you quickly navigate between related items, without using
the Insight Toolbar to manually locate them. To follow a hyperlink, click on it with the mouse
button. In the picture below, clicking the “Inside Area” hyperlink opens the area called “Office”.





Tip
You can click as many hyperlinks as you like. When you close the windows that have popped
up, you will return to the original record you were editing.

Tip
If you click a hyperlink on a field that is set to “none”, Insight changes the browser to view all of
the items that can be selected for that field.

Previous Software
In WinDirect, quick navigation was performed with the F9 and F10 keys. On panel terminals,
quick navigation is performed with the [HELP], [9] / [HELP], [0] key combinations.
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Searching Panels
Insight Edit includes an extremely fast search tool.
You can choose between simple searches, which
look for matching text in the locations that you
specify, and advanced searches, which let you
specify complicated searches such as “find
everything with the word door but not the word
office”.
To perform a simple search:
1. On the Edit menu, choose “Power
Search…” (or press CTRL+F).
2. Enter the text you wish to search for.
3. Choose which panels and item types you wish to search by clicking the “Look In” field
(optional).
4. Un-tick match case if you want GREEN to match with Green.
5. Un-tick whole words if you want am to match with hammer.
6. Enter any settings you want on the “Modified” tab (optional).
7. Click “Find Now”, or press ENTER.
Items matching the search text are displayed.





Tip
All text fields are searched by default. To specify which fields are searched, click the
“Advanced” tab and select them in the “Filter” box.

Tip
If your panel is red (unsynchronised), you can find all records that are queued for upload or
download by opening a new search, clicking the “only match records marked for upload or
download” and clicking “Find Now” (without entering any search text).

Tip
You can open any matching item by double-clicking it with the mouse.

To perform an advanced search:
1.
2.
3.
4.
5.
6.

On the Edit menu, choose “Power Search…” (or press CTRL+F).
Click the “Advanced” tab.
Enter your search criterion (see below).
Choose the fields you wish to search (optional).
Enter any settings you want on the “Modified” tab (optional).
Click “Find Now”, or press ENTER.

You specify advanced criteria by entering text (enclosed in single or double quotes) separated
by special commands and, or, not and xor (“exclusive or”). Placing a text item in double
quotes means the text will match both upper and lower case. Placing a text item in single
quotes means the text will only match if the case is the same. Brackets are used like they are in
arithmetic.
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Examples
“door” (double quotes)
case-insensitive match with door (including trapdoor, doorstop, DOORMOUSE etc.)
‘door’ (single quotes)
case-sensitive match with door (including trapdoor but not TRAPDOOR)
exact(“door”)
case-insensitive match with the whole word door (including DOOR but not trapdoor)
exact(‘door’)
case-sensitive match with the whole word door (but not DOOR or trapdoor)
“door” or “window”
matches all items with either door or window or both, regardless of capitalisation
“door” and “window”
matches all items with both door and window
“door” and not “window”
matches all items with door, unless the item also has window
“door” or not “window”
matches all items with door, and also matches all items without the word window
not “door”
matches anything that doesn’t have the word door
“exit” and “door” or “window or “corridor”
matches anything with window or corridor, and also matches anything with both exit
and door
“exit” and (“door” or “window” or “corridor”)
matches anything that has exit as well as one or more of the words door, window,
corridor (note: bracketed terms are evaluated first)
“exit” or (“door” and “window” and “corridor”)
matches anything that has both door, window and corridor or it has exit
“door” xor “window”
matches everything with either door or window, but not both




Tip
If you have difficulty understanding advanced searches, try entering some of the examples
listed above, then modifying them to what you want.

Operator Permissions
You must have the see permission on an item for it to appear in the output window.
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Cross-Referencing Items
The cross-reference window is a very useful and
powerful tool for trouble-shooting an Inner Range
installation. When an item is cross-referenced, all
programming relationships between that item and the
rest of the system are displayed. For example, crossreferencing a calculated auxiliary shows any auxiliaries,
inputs, areas, lift cars, floor lists and counters that might
be altered by the calculated auxiliary.
To cross-reference an item:
1. Select the item in the browser window, or open
the item for editing.
2. From the Edit menu, choose “cross-reference”;
or press F2; or click the “x-ref” toolbar button
(editing window only).
The cross-reference window appears.
 Any items that this item refers to are shown in the refers to section.
 If this item appears in the programming of a completely different item, then this
relationship is shown in the referred from section.




Tip
You can open an item from the cross-reference window by right-clicking and choosing “Edit” in
the menu that appears.

Warning
The cross-reference window will not show an item if you do not have the see permission for that
item. In this case, the cross-reference tree will be incomplete.

Using The Copy Wizard
You can use the Copy Wizard to copy, swap or move
items within a panel or between panels. You can also
use the copy wizard to batch program user names,
card numbers and other user fields.
You can replicate a record, which means a duplicate
of the record is made one or more times.
To replicate a record one or more times:
1. Press F7 to open the Copy Wizard, or select
the Edit menu and choose “Copy Wizard”.
2. Click “Copy, swap or move records”.
3. Click Next.
4. Click “Replicate the current record one or more times”.
5. Click Next.
6. Click the arrow in the Item Type field, and navigate to the panel and item type you want
to replicate. A list of programmed items is displayed. (Click the “show blanks” box to
show all items.)
7. Select the item you wish to replicate.
8. Click Next.
9. Click the arrow in the Item Type field, and navigate to the panel where you want to
save the replicated records. (This can be the same panel as step 6, or a different
panel.)
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10. Choose which record(s) will be replaced. Hold down the CTRL key to select more than
one destination record. Hold down the SHIFT key to select a range of records to be
replaced.
11. Click Next.
12. Click Finish. The source record is written over the target record(s).




Warning
The contents of the target records are permanently replaced. This operation can’t be undone,
except by restoring to a previous backup.

Note
If you copy a record into a different panel, Insight leaves any programming references intact.
For example, copying a user type that points to “door list 15” into another panel will result in the
user type still using door list 15 in the new panel, even if it isn’t programmed or doesn’t exist.

You can block copy one or more records, which means a group of records are copied (either
into a different location in the same panel, or into a different panel).
To block copy select records:
1.
2.
3.
4.
5.
6.

7.

8.
9.

10.

11.
12.

Press F7 to open the Copy Wizard, or select the Edit menu and choose “Copy Wizard”.
Click “Copy, swap or move records”.
Click Next.
Click “Block copy selected records”.
Click Next.
Click the arrow in the Item Type field, and navigate to the panel and item type you want
to block copy. A list of programmed items is displayed. (Click the “show blanks” box to
show all items.)
Select the item(s) you wish to block copy. Hold down the CTRL key to select multiple
records. Hold down the SHIFT key to select a range of records. You must make a note
of how many records are selected, which is displayed in the bottom right corner.
Click Next.
Click the arrow in the Item Type field, and navigate to the panel where you want to
save the replicated records. (This can be the same panel as step 6, or a different
panel.)
Choose which record(s) will be replaced. Hold down the CTRL key to select more than
one destination record. Hold down the SHIFT key to select a range of records to be
replaced. You must select the same number of records as step 7.
Click Next.
Click Finish. The source records are copied over the target records.





Warning
The contents of the target records are permanently replaced. This operation can’t be undone,
except by restoring to a previous backup.

Warning
You shouldn’t specify source and target ranges that overlap. Doing so could result in records
being overwritten incorrectly.
Note
If you copy a record into a different panel, Insight leaves any programming references intact.
For example, copying a user type that points to “door list 15” into another panel will result in the
user type still using door list 15 in the new panel, even if it isn’t programmed or doesn’t exist.

You can swap one or more records, which means the selected records are exchanged.
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To swap a group of records:
1.
2.
3.
4.
5.

Press F7 to open the Copy Wizard, or select the Edit menu and choose “Copy Wizard”.
Click “Copy, swap or move records”.
Click Next.
Click “Swap selected block of records”.
Refer to the instructions for block copying records (previous page), starting at step 5.

You can move one or more records. This is the same as copying the records, except that the
original records are blanked after the copy.
To move a block of records:
1.
2.
3.
4.
5.

Press F7 to open the Copy Wizard, or select the Edit menu and choose “Copy Wizard”.
Click “Copy, swap or move records”.
Click Next.
Click “Block move selected records”.
Refer to the instructions for block copying records (previous page), starting at step 5.

You can clear one or more records to factory default values.
To clear a block of records:
1. Press F7 to open the Copy Wizard, or select the Edit menu and choose “Copy Wizard”.
2. Click “Clear records”.
3. Enter a value for the name, short name and notes fields, or leave the blank to accept
factory defaults. You can use the hash symbol (#) to specify an auto-number. The #
symbol is replaced by the auto-number settings you specify.
4. Click Next.
5. Click the arrow in the Item Type field, and navigate to the panel and item type you want
to clear. A list of programmed items is displayed. (Click the “show blanks” box to show
all items.)
6. Select the item(s) you wish to clear. Hold down the CTRL key to select multiple records.
Hold down the SHIFT key to select a range of records.
7. Click Next.
8. Click Finish. The selected records are erased to factory defaults.



Warning
The selected records are permanently erased. This operation can’t be undone, except by
restoring to a previous backup.
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You can batch program a block of users. This features lets you specify consecutive cards, user
names or notes; set card types; set a common user type; set a common expiry date; and
optionally select a ‘source record’ for duplication.
To batch program a block of users:
1. Press F7 to open the Copy Wizard, or select
the Edit menu and choose “Copy Wizard”.
2. Click “User programming”.
3. Select which options you wish to apply.
Replace card numbers. Tick this box if you
wish to specify the card type and assign
sequential card numbers to a block of users.
Replace user names. Tick this box if you
wish to specify a common name for the block
of users, including an optional auto-number.
Replace other fields. Tick this box if you
want to specify a common user type and
expiry options.
Use selected record as template. Ticking this option duplicates a single user
(replacing the existing users in the block), then applies any other options that are ticked.
If this option isn’t selected, then the block of users are modified as-is.
4. Click Next.
5. Fill in any information requested by the wizard, which will depend on the options you
selected in step 3. In particular, when selecting which users to reprogram, you must
hold down the shift key to select a block of users; otherwise, your changes will only
apply to a single user. (You can use the ctrl key to select non-adjacent users.)
6. Click Finish. The batch programming is applied.




Warning
The selected records are permanently reprogrammed. In particular, if you selected the “use
selected record as template” option, then all fields in the target records are replaced. This
operation can’t be undone, except by restoring to a previous backup.
Tip
If you assigned new card numbers, you can automatically import them into Insight Card Pool. In
Card Pool, click the Panel Scan button on the Card Pool toolbar.

Card Pool Integration
Insight Card Pool is a separately licensed module that allows Operators to create and manage
card pools. Operators can quickly assign cards from a card pool, in addition to marking cards as
lost or suspended.
To assign a card from a card pool:
1.
2.
3.
4.
5.

In Insight Edit, open the user you wish to assign a card to.
Ensure that the “Use Cardpool” option is selected. (V3.3 or later)
Click the ‘Card Pool’ button.
Click the ‘Get Card Pool Card’ button.
Select the card pool and card to assign to this user.
You can assign a (new) available card from a card pool to this user. Or, if the user
already has a card that works at a different panel in the system, and now needs to be
programmed in this panel, too, you can choose their card from all cards that are
assigned in different panels. In either case, Insight will try to find a good card for the
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user, but you can select a different card to the default card from a list with the ‘Different
Card..’ button.
6. Click OK.
7. Click the Save icon in the toolbar.
To create a card in the card pool and assign it to a user:
1. In Insight Edit, open the user you wish to assign a card to.
2. Deselect the “Use Cardpool” option.
3. Select “Site Code” or “Direct Entry” as the card type. Credit cards are not managed by
the Card pool Manager.
4. Type the new card number of the user, or, use the ‘Acquire’ button and acquire the card
number from a connected Enrolment Station.
5. Save the user. You will be prompted for the card pool the new card should be entered
into. If you refuse to select a card pool here (for example, because you haven’t created
card pools yet), you can still later assign that card to a card pool by using the ‘Panel
Scan’ command in the Card Pool Manager (see page 81).



Paid Feature
Card Pool is a separately licensed component of Insight.

Card Acquisition
Insight can enrol cards using a card reader attached to the Insight enrolment PC. Card
acquisition requires:
A compatible card reader unit.
A free serial port on the card enrolment computer.



Tip
If you don’t have any spare serial ports (or any serial ports at all), you can use a serial to USB
protocol converter and connect the card reader to a spare USB port.

Insight v3.2 supports the following models:
Inner Range Card Enrolment Station
ACS Smart Reader
HID PC Log-On
The Inner Range Card Enrolment Station (part number 994500) supports the widest range of
card types and formats. Refer to the tables below.
Insight hardware support for different card formats:
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To acquire a card directly in Insight:
1. In Insight Edit, open the user you wish to assign a card to.
2. If you are using Insight Card Pool at your site, make sure the ‘Use Card Pool’ option is
not ticked.
3. Click the Acquire button.
4. Select the reader type, card format and serial port.
5. Click the Read button.
6. Badge the card.
7. Click the Save icon in the toolbar.
8. If using Insight Card Pool, you are prompted for the card pool. Select a card pool from
the dropdown list, or close the dialog without selecting any card pool.





Tip
If the card you badge belongs to a card pool, the card is automatically marked as “issued” in the
card pool.

Tip
If the card you badge has a new site code, Insight creates a new card pool with that site code
and adds the card to that pool.

Tip
If you don’t select a card pool for the card you badge, Insight Edit will remind you to run the
Panel Scan command in Insight Card Pool (see page 81) so it can be added to one.

Insight Edit Reports
You can generate a range of useful reports in Insight Edit. These reports summarise key areas
of panel programming including users, user types, areas and doors. Reports can be displayed
on-screen, sent directly to a printer, or saved to a file. The contents of the reports can be
streamlined with the use of a filter.
I want to view, print or save…
User programming
User type programming
Input programming
A list of areas in each area list
A list of doors in each door list
A list of lifts in each lift car list
A list of floors in each floor list
A list of sirens in each siren list
Doors accessible to each user type
Users for each user type
Areas accessible to each user type

From the Reports menu, choose…
Programming Users
Programming User Types
Programming Inputs
Programming AreaList
Programming DoorList
Programming LiftCarList
Programming FloorList
Programming SirenList
References User Type Doors
References User Type Users
References User Type Areas
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Floors accessible to each user type
A list of inputs in each area
A list of reportable inputs per area
Users who can turn an area on
Users who can turn an area off
Inputs + process groups in each area
Doors accessible to each user
Areas accessible to each user
Floors accessible to each user
A list of users with access per door
A list of users with access per floor
A list of users with access per Lift Car

References
References
References
References
References
References
References
References
References
References
References
References

User Type Floors
Area Inputs
Area Commissioning Inputs
Area User On
Area User Off
Area Input – Proc Grp.
User To Door
User To Area
User To Floor
User From Door
User From Floor
User From Lift Car

To generate a report:
1. Select your desired report on the Reports menu.
2. To print the report, choose Print in the sub-menu that appears. To view the report,
choose View in the sub-menu that appears.



Tip
Reports saved to a file are written in CSV format, which can be opened by spreadsheet
applications such as Microsoft® Excel®.

To generate a filtered report:
1. Firstly, ensure that the “Use Filtering” item
on the Reports menu is checked.
2. Select your desired report on the Reports
menu.
3. To print the report, choose Print in the submenu that appears. To view the report,
choose View in the sub-menu that appears.
4. The Print Filtering dialog will appear. You
can filter on a combination of parameters,
as shown on the right:
- Item status
(programmed/defaulted/both)
- Name (of the item)
- Notes
5. When filtering, either Simple or Complex
filtering can be chosen. Simple filtering
allows filtering on a single item and/or
Notes entry.
6. Complex filtering allows filtering based on a
combination of search terms. For instance,
you are able to list areas except area
names containing ‘A0’ and ‘SYSTEM’
(illustrated on the right) When Complex
filtering is chosen, the Print Filtering dialog
changes to look like what is shown on the
right. (When using Complex Search, you
can only filter on Item Name, not on notes).
7. Select OK once you have set the parameters of interest to generate the report.



Tip
In both Simple and Complex Search, you can use ‘wildcard characters’ as described on page
38. In Complex Search, you can use the advanced criteria as used in the Advanced Search
52

function. Some examples start on page 45.



Paid Feature
Filtered Reports within Insight Edit are enabled when you enter a valid licence for the Insight
Advanced Reporting Module.

Employees
Each panel contains information about users that have
access privileges for that panel. Depending on the
memory configuration in the panel, a name might also be
stored for some or all users.

It is often useful to store extended information about
each user such as full name, age, home and work
contact details, gender and even a photograph for
identity verification.
Insight calls this additional data extended user
information. Users with this additional information are
referred to as employees.
Insight Versions
Extended user information and user photographs are not
available in Insight Installer.



To add extended information to a user:
1. In Insight edit, double-click the user in the browser pane. Or, right-click the user and
choose “Properties…” in the menu that appears.
2. Click the Employee tab.
3. Enter the person’s title, full name, birth date and gender.
4. Click the Profile tab.
5. Enter the person’s business profile and personal profile.
6. Click the Save Changes button to save your changes.



Note
If you edit the first name or surname field on the Employee tab, the Name field on the Access
tab becomes locked for editing. All future name edits must be carried out on the Employee tab.
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Custom Fields
You may find that the default employee fields such as
name, age and address insufficient for the requirements
of your organisation. Insight lets you define up to 32
custom fields which will be associated with each user.
To define a custom field:
1. In Insight edit, double-click any user in the
browser pane. Or, right-click a user and choose
“Properties…” in the menu that appears.
2. Click the “Custom 1” or “Custom 2” tab.
3. Click an unused check box.
4. Enter a label for the new custom field. The
custom field is created and available for all
users.
To rename a custom field:

1. In Insight edit, double-click any user in the browser pane. Or, right-click a user and
choose “Properties…” in the menu that appears.
2. Click the “Custom 1” or “Custom 2” tab.
3. Double-click the custom field you wish to rename.
4. Enter a new name and click OK. The custom field is renamed.
To remove a custom field:
1. In Insight edit, double-click any user in the browser pane. Or, right-click a user and
choose “Properties…” in the menu that appears.
2. Click the “Custom 1” or “Custom 2” tab.
3. Clear the check box next to the custom field.





Note
Removing a custom field doesn’t delete any data. If you create a new custom field in the same
position, any existing data is restored.

Tip
You can search for data in custom fields. See “searching” on page 44.

Tip
You can import data into custom fields. See below.

Importing Extended User Information
You can import extended user information (such as age and contact details) from an external
file. The file must be in “Comma Separated Values” format (CSV), which means:
The file is a text document.
Each line of the file represents a single user record, with an End-Of-Line symbol
marking the beginning of the next record.
Each field is separated by a comma character.
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Insight expects the data to begin with a heading row followed by your data.



Tip
CSV is a common file format that can be exported by most software products. Check the
documentation that came with your software.

You will be required to provide a heading row followed by the user data. The following table
describes each one of the available headings and the expected data for each.
Field code used in
heading row
###

Description

Data
Any text

secondname
title

First name; must be the first
field, denotes the first name
Second name
Title

gender

Gender

dob

Date of birth

street
suburb
city
state
country
postcode
workphone
homephone
homemobile
workmobile
homefax
workfax
homeemail
workemail
position
department
sitecardnumber

Street
Suburb
City
State
Country
Post code
Phone Number (Work)
Phone Number (Home)
Phone Number (Home Mobile)
Phone Number (Work Mobile)
Fax Number (Home)
Fax Number (Work)
E-mail Address (Home)
E-mail Address (Work)
Position Description
Department
Card number for site card entry
set up. Supersedes
"directnumber" and "creditcard"

company
photo

Company Name
Filename where to find a photo
of the user

Any text
One of the following values: Mr,
Mister, Mrs, Mistress, Miss, Ms,
Dr, Doctor, Prof, Professor, Sir,
Lady, Lord
One of the following values: M,
m, 0, F, f, 1
A date format matching the
locale of this computer (go to
Control Panel Regional &
Language Options for
Windows® XP, or Control
Panel Regional Options for
Windows® 2000). e.g. for
Australia, the format is normally
dd/mm/yyyy. You should
specify a 4 digit year value for
correct processing.
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any valid site card number (a
positive decimal number up to
2147483647).
Any text
A valid image file name
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Field code used in
heading row
directnumber

Description

Data

Card number for direct-entry
card setup. Is superseded by
"sitecardnumber", supersedes
"creditcard"

Any valid direct entry card
number (a hexadecimal number
(not 0) of at most 10 digits).

usertype

Key/token to refer to both panel
and user type in this panel

pin
extraarea
extradoor
extradoorlist

The PIN with which the user will
authenticate at a panel terminal
Extra area
Extra door
Extra door list

Must correspond to a user type
token/key as set up in a Lookup
table in the DUIM setup.
Any valid PIN (decimal).

(custom user field
name 1)
(custom user field
name 2)
(custom user field
name 3)
(custom user field
name 4)
(custom user field
name 5)
(custom user field
name 6)
(custom user field
name 7)
(custom user field
name 8)
(custom user field
name 9)
(custom user field
name 10)
(custom user field
name 11)
(custom user field
name 12)
(custom user field
name 13)
(custom user field
name 14)
(custom user field
name 15)
(custom user field
name 16)
(custom user field
name 17)
(custom user field
name 18)
(custom user field
name 19)
(custom user field
name 20)

custom user field 1 defined in
dbEdit
custom user field 2 defined in
dbEdit
custom user field 3 defined in
dbEdit
custom user field 4 defined in
dbEdit
custom user field 5 defined in
dbEdit
custom user field 6 defined in
dbEdit
custom user field 7 defined in
dbEdit
custom user field 8 defined in
dbEdit
custom user field 9 defined in
dbEdit
custom user field 10 defined in
dbEdit
custom user field 11 defined in
dbEdit
custom user field 12 defined in
dbEdit
custom user field 13 defined in
dbEdit
custom user field 14 defined in
dbEdit
custom user field 15 defined in
dbEdit
custom user field 16 defined in
dbEdit
custom user field 17 defined in
dbEdit
custom user field 18 defined in
dbEdit
custom user field 19 defined in
dbEdit
custom user field 20 defined in
dbEdit
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Area as it appears in the panel
Door as it appears in the panel
Door list as it appears in the
panel
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text

Field code used in
heading row
(custom user field
name 21)
(custom user field
name 22)
(custom user field
name 23)
(custom user field
name 24)
(custom user field
name 25)
(custom user field
name 26)
(custom user field
name 27)
(custom user field
name 28)
(custom user field
name 29)
(custom user field
name 30)
(custom user field
name 31)
(custom user field
name 32)
(custom user field
name 33)
(custom user field
name 34)
(custom user field
name 35)
(custom user field
name 36)
creditcard

Description

Data
Any text

expiry

custom user field 21 defined in
dbEdit
custom user field 22 defined in
dbEdit
custom user field 23 defined in
dbEdit
custom user field 24 defined in
dbEdit
custom user field 25 defined in
dbEdit
custom user field 26 defined in
dbEdit
custom user field 27 defined in
dbEdit
custom user field 28 defined in
dbEdit
custom user field 29 defined in
dbEdit
custom user field 30 defined in
dbEdit
custom user field 31 defined in
dbEdit
custom user field 32 defined in
dbEdit
custom user field 33 defined in
dbEdit
custom user field 34 defined in
dbEdit
custom user field 35 defined in
dbEdit
custom user field 36 defined in
dbEdit
Card number for credit card or
any swipe card authentication.
Is superseded by
"sitecardnumber" and
"directnumber"
Expiry date

delete

Delete information

notes
altusertype

Any additional notes
User type the user will have
after expired. Default None.
Any additional data you want to
specify
Expiry time in hours from current
time, i.e. time of import; will
supersede "expirytime"; will be
superseded by "expiry"

foreignkey
expirynhrs

Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any text
Any valid credit card number

A date in the format: "12 August
2010 11:22" or "12 aug 2010
11:22" or "12/8/2010 11:22";
will supersede "expirynhrs" and
"expirytime". The month name
must be given in English, full or
abbreviated to at least 3 letters.
‘yes’ if the user is to be deleted
instead of added
Any text
Must be a (name of a) user type
as it appears in the panel
Of the form "keyname=value"
A valid (decimal) integer
number.
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Field code used in
heading row
expirytime

Description

Data

Expiry time

irqualifications

The name of the qualification.

A time in the format "9:22" or
"9:22|5". If it's 8:22 now (at the
time of import), "9:22" will be in
an hour, and "9:22|5" will be
9:55 in 5 days' time. If it's 11:15
at the time of import, then
"9:22" will be 9:22 one day
later, and "9:22|5" will be 9:55
in 6 days' time. This time is
superseded by either the
"expiry" or the "expirynhrs"
columns.
Any text

irqualificationvalues

This field will be either the Count
or start date for the qualification

A valid (decimal) integer
number or a date stamp
(DD/MM/YYYY).

When importing .csv files, you can omit a field that you wish to leave unchanged or specify a
filed you want to blank. You must still include the comma after the blank field.
Example:
John,Smith,,M
The third record is empty and skipped when importing.
John,Smith,<blank>,M
The third record is <blank> and will erase any pre-existing data in
this field.
Note
One of the three identifying card numbers -- "directnumber", "sitecardnumber", or "creditcard" –
or a PIN number (pin) is mandatory,
and the user is identified by it, i.e., any old user with the same number will be overwritten.



Sample CSV File: (line breaks added to fit onto the printed page; text should all be on one line)
Line 1:
###,secondname,pin,sitecardnumber,usertype,position,company,title,gender,1/02/2003
,street,suburb,city,state,country,postcode,workphone,homephone,homemobile,workmo
bile,workfax,workemail,Car Rego,notes,photo
Line 2:
Clayton,Kielbasa,0151,1,OWNER,Installer,A Secuirty
Company,Mr,male,2/02/2003,123 aStreet
St,,Melbourne,VIC,Australia,3000,1300000000,,,3462476124,0523596872,emailaddre
ss@company.com,QIW-205,A good installer. Should be paid more.,c:\photos\1.png
Line 3:

Neil,Canney,5253,1,Manager,CEO,,,male,3/02/2003,,,,,Australia,3000,399999999,,855
8812952,,,emailaddress@company.com,VMZ-545,,c:\photos\1.png

You can specify a custom import order in the header row, which must be the first line of the
CSV file. The header row starts with three hash characters (###), followed by a list of field
names (as defined in the table above) separated by commas.



Note
In the import file, “###” means “first name”. Because “###” must be the first entry in the header
row, this means “first name” must be the first field in each row.
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Tip
In addition to the field names defined above, you can also use the name of any custom field
label as defined in dbEdit.

Sample CSV File with header row: (assumes a custom field is defined called ‘favourite
colour’)
Line 1:
Line 2:
Line 3:

###,secondname,sitecardnumber,company,favourite colour
Joe,Bloggs,150,Inner Range,Red
Fred,Smith,151,Inner Range,Blue

To import extended user information:
1. Right-click the panel that contains the users you want to import information for, and
choose “Import Extended Employee Data” in the menu that appears.
2. Navigate to the CSV file that contains your extended
information and click Open. The Input Range dialog appears.
3. Specify the index of the first user you are importing data for.
Installer is index 0, master is index 1, U00003 is index 2, and
so forth.
4. Specify how many users you are importing from the CSV file.
If you enter 0, all records will be imported.
5. Click OK.





Tip
It’s a good idea to write-lock the panel (page 41), so that changes won’t be written to the panel
until the import is complete.

Operator Permissions
To import extended information, you must have the change permission on each user being
imported. If you do not have the change permission on a user, the user is skipped and the next
available record is used.
Insight Versions
Insight Installer only imports First Name, Second Name and Card Number.
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User Photographs
You can attach a photograph to a user, either from an
existing picture file on your computer or by acquiring a
picture from a device like a scanner or digital camera. You
can configure Insight to automatically display the
photograph when the user badges at a door.
To attach an image from your hard disk to a user:
1.
2.
3.
4.
5.
6.

Open the user for editing.
Click the Employee tab.
Click the Attach Image button (
)
Browse to the image file you want to attach.
Click OK.
Click the Save Changes toolbar button to save your changes.



Tip
To save space, Insight stores a compressed “thumbnail” of the photograph, regardless of the
original size and image format. You don’t need to scale your photographs before importing.

To acquire a new photograph and attach it to a user:
1.
2.
3.
4.
5.
6.

Open the user for editing.
Click the Employee tab.
Click the Acquire Photo button (
)
Select the device you will be acquiring the image from (e.g. camera, scanner)
Follow the on-screen directions which will vary depending on the device.
Click the Save Changes toolbar button to save your changes.



Note
Direct image acquisition is available for devices that support the Windows Image Acquisition
®
(WIA) interface in Windows XP. For other devices and operating systems, capture the image to
your hard disk first, then attach the image.

To pop-up the photo automatically when the user badges their card:
See “working with alarm responses” on page 96.

To print an ID badge without starting Photo ID:
1.
2.
3.
4.
5.



Open the user for editing.
Click the Employee tab.
Click the Print Badge button (
)
If more than one card template is defined, you will be asked to choose a template.
In the print dialog that appears, click Print.

Paid Feature
To print ID badges you must have a licence for Insight Photo ID.
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To remove a photograph from a user:
1.
2.
3.
4.

Open the user for editing.
Click the Employee tab.
Click the Remove Photo button (
)
Click the Save Changes toolbar button to save your changes.

Panel Memory Configurations
Each Inner Range panel has a database for storing users and programming information. The
size of the database is determined by the size of the memory chip on the panel (32, 128 or 512
kilobytes). For each memory size, there are a number of memory configurations (such as
Standard, Alarms and Special) that determines how many items of each type are stored by the
panel. This count of items is known as the directory of the panel. For example, the 512k
Standard directory has 128 doors, 250 areas, 64 time zones and so on.
When you connect to a panel, Insight automatically checks the panel’s directory. Under normal
circumstances, the directory of the panel and the directory stored by Insight is the same. Under
certain circumstances, they can be different.
1. You have used a terminal to ‘default’ (change) the panel configuration since it was
enrolled; or
2. You created the panel in Insight from a template or by duplicating another panel, and
are now connecting to a panel with a different memory configuration.
Both situations cause a conflict in Insight, because the panel contains a different number of
records than you can see in Insight. Insight automatically resolves the conflict by creating
surplus and shadow items.
Surplus items are records that no longer fit in the new panel memory configuration. You can
edit them, but they cannot be saved to the panel unless the panel configuration is changed to
something else. If you know you will never do this, then the surplus records can be trimmed,
which deletes them permanently from Insight.
Shadow items are records that exist in the new panel configuration, but not in Insight. They are
like a ‘place holder’, telling you that the records exist in the panel but have not been uploaded
yet. If you know you will be sticking with the new memory configuration, then these records
should be expanded, which converts them into ‘real’ records by uploading them from the panel.
Below are some examples of surplus and shadow records and how they are created.
Example 1

Insight:

4 diaries

Panel:

2 diaries

Insight after connect:
Insight after ‘trim’ command:

4 diaries (2 normal, 2 surplus)
2 diaries



Note
If you edit a surplus record and click save, your panel will be permanently unsynchronised
(since Insight can never save your changes to the panel). To rectify this, you should trim the
surplus records.
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Example 2
Insight:

1 door

Panel:

4 doors

Insight after connect:
Insight after ‘expand’ command:

4 doors (1 normal, 3 shadow)
4 doors



Tip
If you make changes to a shadow record, it is automatically converted to a normal item and
queued for download to the panel.

Trimming and Expanding Records
Under normal circumstances, you should always trim (delete) surplus records, and expand
(upload) shadow records. Insight doesn’t do this automatically, because you might want to copy
the information out of surplus records before trimming, and because expanding shadow records
can be time consuming (they have to be uploaded into Insight).
To trim or expand records:
1. Right click on the panel in the Insight Toolbar, and choose “Properties…” from the menu
that appears.
2. Click the “Maintenance” icon.
3. Click the “Directory” tab.
4. Click “Compare”. The panel column
shows how many items are in the
current panel memory configuration.
The Insight column shows how
many items are being displayed by
Insight.
5. Select the items you want to
expand or trim, or click “select all” to
work on the entire panel.
6. Click “Expand Insight” to convert
shadow records into normal
records. If you are connected to the
panel, the records are uploaded immediately; otherwise, they are queued for upload the
next time it is connected. Click “Trim Insight” to delete surplus records from Insight.
Click “Expand + Trim” to automatically expand or trim, depending on which operation is
appropriate.





Warning
You cannot undo the trim command - the surplus records are permanently deleted.

Note
Trimming and expanding has no effect on the panel. It only effects surplus and shadow records
in Insight.

Note
You cannot change the panel memory configuration with Insight. This can only be performed at
a panel terminal.
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Tip
You can trim or expand a particular item type by right-clicking the item in the Insight Toolbar,
then choosing “Trim Surplus Records” or “Expand Shadow Records” in the menu that appears.

Tip
You can quickly trim or expand the entire panel by right-clicking the panel in the Insight Toolbar,
then choosing “Entire Panel
Trim Surplus Records” or “Entire Panel
Expand Shadow
Records” in the menu that appears.
Operator Permissions
To trim records, you must have the change permission on the containing panel.

63

Virtuality
Virtuality lets you program several physical panels as if they are a single “virtual” panel. In other
words, you program the information once and it is automatically saved to each panel.
Virtuality was introduced in Insight version 2. In its current implementation, virtuality is supported
for users. In other words, you program a user’s information once, and it is saved to multiple
panels. Future versions of Insight may extend virtuality to other item types.
A virtual panel is a collection of two or more physical panels. You create a virtual panel with
Insight Edit using a wizard. Creating a virtual panel is straightforward - you just select which
physical panels to include, and specify how you want to create your virtual users.
When a panel is added to a virtual panel, it is called a member panel.
A virtual user is like a regular user, except the user exists in all of the member panels and is
programmed from a single location.
Insight makes virtuality as simple as possible, by allowing you to edit users in a single location.
You can program all the fields you can normally program for a user such as name, PIN number,
user type, expiry and fob options. When you save your changes, they are sent to each member
panel in the virtual panel.
Although you may think of virtual users as existing in one place, in reality Insight has to convert
your changes into real users in real panels, and this introduces some complexity. For example,
the member panels may have different memory configurations. You may also want a user’s
access rights to be different in each member panel. Member panels will be connected to
different field hardware, and items such as “extra area” cannot be programmed from a single
location, since the extra area will almost certainly be different in each member panel.
Insight solves these problems using virtual links. Virtuality and virtual links will be explained in
more detail in the following pages.
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Virtual Users Explained
To understand virtual users, imagine you have two panels with the following programming. (For
simplicity, we are ignoring the fact that user 1 is normally INSTALLER and user 2 is normally
MASTER.)
Panel A

Panel B

U001 John

U001 John

U002 Peter

U002 Amy

U003 Bill

U003 Jo

U004 Frank

U004 (Blank)

Looking at the diagram, we can see that John exists in both panels, whereas the other users do
not. From now on, we want to program John in one place instead of two. To do this, we make a
new virtual panel and make John a virtual user in the virtual panel.
Virtual Panel

Panel A

Panel B

VU001 John

U001 John

U001 John

U002 Peter

U002 Amy

U003 Bill

U003 Jo

U004 Frank

U004 (Blank)

Now that a virtual panel has been created, the following rules apply:
 John is now VU001 in the virtual panel. This is represented by a gold user icon (

).

 Any programming changes made to VU001 will be saved to U001 in Panel A and U001
in Panel B.
 John cannot be edited in Panel A and Panel B, because he is now a virtual user. This
is represented by a grey user icon ( ) in those panels.
You will note that the user numbers “line up” in each panel – VU001 is the same user as U001
in Panel A and U001 in Panel B. Now imagine that Peter has been granted access to Panel B.
He becomes U004 in that panel. How is this represented in the virtual panel?
Virtual Panel

Panel A

Panel B

VU001 John

U001 John

U001 John

VU002 Peter

U002 Peter

U002 Amy

U003 Bill

U003 Jo

U004 Frank

U004 Peter
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As you can see, the user numbers do not need to “line up”. Virtual user 10 might be physical
user 25 in Panel A and physical user 70 in Panel B.
You can control which physical user in each panel is
linked to the virtual user in the virtual panel.
To see or change which physical users are linked to
a virtual user:
1. Open the virtual user.
2. Click the Physical Panel Items tab. The Panel
Item column shows which physical user is linked
for each panel.
3. If you want to change the physical user in a
panel, click the entry with the mouse. A drop-box
appears, allowing you to set a new physical user.
4. Save your changes.




Tip
You can jump directly to a physical user from this screen. Right click the physical user, and
choose “Edit” in the menu that appears.

Note
If you change the physical user, the newly selected user will be erased and replaced with the
virtual user. The previous user will be unlinked, but retains all programming. You should erase
this programming to avoid user duplication.

66

Virtual Links Explained
To understand virtual links, imagine you have two panels with the following programming. (For
simplicity, we are ignoring the normal default items INSTALLER, MASTER and OWNER.)
Panel A

Panel B

U001 John

U001 John

UT001 Guard

UT001 Clerk

UT002 Manager

UT002 Guard

As can be seen from the diagram, John exists in both panels and has User Type “Guard” in both
panels. Note that Guard is User Type 1 in the first panel and User Type 2 in the second panel.
When set up as a virtual panel, the diagram looks like this:
Virtual Panel

Panel A

Panel A

VU001 John

U001 John

U001 John

VUT001 Guard

UT001 Guard

UT001 Clerk

UT002 Manager

UT002 Guard

In the virtual panel:
 John is a virtual user.
 Guard is a virtual user type link. Guard is only a link – it cannot be edited in the
virtual panel.
In the physical panels:
 John is a copy from the virtual panel and cannot be edited except in the virtual panel.
 Guard is the user type that already existed in the panel. Guard is not copied from the
virtual panel.
Essentially, the “link” (VUT001) tells Insight which user type to use for John in each physical
panel. In Panel A, John is UT001 (Guard). In Panel B, John is UT002 (Guard). Editing VUT001
in Insight shows this information, but not the regular User Type programming fields. These must
be set up in each member panel.
Links apply to the following items: user types, areas, area lists, doors, door lists, inputs and
auxiliaries.
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Virtuality In Practice
The previous explanations may have made virtuality seem complicated. If you set up your
physical panels correctly, then it becomes much easier.
To set up virtuality in a new system:
1. Work out how many users will exist in every panel. This may equal the capacity of your
panels, or be a smaller number. Any leftover users can be programmed specifically on
that panel. Make sure to leave some “headroom” for future use – for example, if your
system currently has 100 users, you may wish to assign 200 virtual users.
2. Program all of the users into consecutive slots in one of the panels.
3. Set up the user types for the users you have created. Again, use consecutive slots.
4. Make sure that the corresponding slots in the other panels do not contain important
information. They will be erased in the creation process, so copy records to safe
locations if necessary (see “using the copy wizard” on page 46).
5. Create the virtual panel using the “Master Panel” method.
Master panel:
Starting record:

# of records:

select the panel you set up in steps 2 and 3.
select one less than the first user you set up
in step 2. So if you started programming your
users at U0010, enter 9 here.
enter the number you decided in step 1.

If you create your virtual panel using this method, then the virtual users and virtual user type
links will all be created for you by Insight. All you need to do is edit the virtual users as required.



Tip
Insight uses colours to differentiate between virtual and non-virtual items. Refer to the table
below.

Icon
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Colour

Item

Gold

Virtual Item

Grey

Member Item

Regular

Normal item

Description
This is a virtual item. Programming changes will
automatically be saved to all member panels.
This is a virtual item in a member panel. You cannot
edit this item directly – edit the item in the virtual panel
instead.
This is a normal item in a panel. When you edit this
item, changes will be saved only to the panel
containing the item.

Creating Virtual Panels
You create virtual panels in Insight Edit with the virtual panel wizard. Ideally, you should create
or enrol the physical panels first, although this isn’t strictly necessary since you can add
member panels later on. When you create a virtual panel, you will normally want Insight to
create virtual users at the same time. You can choose between four methods for this task.
For the following illustrations, imagine you start with two physical panels, A and B, with some
users programmed as shown.
Panel A

Panel B

U001 Installer

U001 Installer

U002 Master

U002 Master

U003 Peter

U003 Sue

U004 Bill

U004 Jane

U005 Frank

U005 Sarah

Method 1: Panel With Default Users
With this method, you specify a starting record and the number of users, and Insight creates the
requested number of blank virtual users. Any existing users in the range specified are erased in
each member panel.
Example
Starting record: 1, number of blank users: 3.
Virtual Panel

Panel A

Panel B

U001 Installer

U001 Installer

VU001 Blank

U002 Blank

U002 Blank

VU002 Blank

U003 Blank

U003 Blank

VU003 Blank

U004 Blank

U004 Blank

U005 Frank

U005 Sarah



Note
Insight considers the first user to be starting record 0, whereas the panel starts number users
with “U00001”. Hence, entering a starting record of 1 corresponds to U00002 in the panel.
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Method 2: Master Panel
With this method, you specify a starting record and the number of users, and Insight creates the
requested number of virtual users by reading them from a dominant panel. Any existing users in
the range specified are overwritten in the other panels.
Example
Dominant panel: Panel A, starting record: 2, number of users: 2.
Virtual Panel

Panel A

Panel B

U001 Installer

U001 Installer

U002 Master

U002 Master

VU001 Peter

U003 Peter

U003 Peter

VU002 Bill

U004 Bill

U004 Bill

U005 Frank

U005 Sarah



Note
Insight considers the first user to be starting record 0, whereas the panel starts number users
with “U00001”. Hence, entering a starting record of 2 corresponds to U00003 in the panel.

Method 3: Empty Panel
With this method, the virtual panel doesn’t contain any virtual users initially. You must add them
later. Any existing users in member panels are unaffected.
Virtual Panel

Panel A

Panel B

U001 Installer

U001 Installer

U002 Master

U002 Master

U003 Peter

U003 Sue

U004 Bill

U004 Jane

U005 Frank

U005 Sarah

Method 4: Generate From Like Records
This method will be implemented in a future version of Insight.



Tip
You can create any number of virtual panels, however each physical panel can only belong in
one virtual panel.
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To create a new virtual panel:
1. Enrol or create the panels that will be in the member panel. You must start with at least
one panel, you can add more later if required.
2. Right click the site that will contain the virtual panel, and choose “New Virtual Panel” in
the menu that appears.

The virtual panel wizard appears.

3. Click Next.
4. Enter a name for the virtual panel.
5. Tick the panels you want to add to the virtual panel. You can add panels from any site
or sub-site, provided they aren’t already a member of a virtual panel.

6.
7.
8.
9.

Click Next.
Choose a creation method for your virtual users (see previous pages).
Click Next.
Depending on the chosen creation method, you may be asked to specify a starting
record and number of virtual users to create. Fill in the required fields, consulting pages
69-70 if necessary. Users in the range specified will become virtual in your member
panels. If you specified “default users” as your creation method, they will be erased. If
you specified “master panel” as your creation method, they will be copied from the
designated panel into the other panels.
10. Click Finish. Your virtual panel is created.
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Note
If you selected a method that creates virtual users, then the virtual users will be written to the
member panels immediately. If any member panels are offline, they will turn red, indicating there
are pending programming changes in those panels.



Note
Virtual users are always created starting with VU00001, even when you specify a starting record
greater than one. See the previous examples for an illustration.

To add a panel to an existing virtual panel without linking Users:
1. In the Insight Toolbar, right click the virtual panel and choose “Properties…” in the menu
that appears.
2. Tick the panels you wish to add to the virtual panel.
3. Click OK.
Note
Users in the virtual panel will not be linked to the newly added panel(s). You must link the users
manually. See pages 69 and 70 for examples.



To add a panel to an existing virtual panel:
To add a panel to an existing virtual panel and automatically link Users:
1. In the Insight Toolbar, right click the virtual panel and choose “Add Panel” in the menu
that appears. This will start the wizard.
2. Tick the panel/s you wish to add to the virtual panel.
3. Select which panel in the virtual panel relationship will be used as the template to
provide the User linking for the new panel. The options are:
“From any panel in the virtual relationship”. This will use a random panel from
the virtual panel.
“From a specific panel in the virtual relationship”. This will allow you to choose
which panel to use as the template. (Recommended option)
4. Click OK.
Warnings
1) Any existing User data in the panel being added will be overwritten if it is put into a
virtual panel relationship using this method.
2) Ensure that the new panel has an appropriate memory size and configuration to support
the number of Users and User Types that are programmed in the template panel.
Think and prepare carefully before adding a new panel to a virtual panel using this method.


Note



Users in the virtual panel will be linked to the newly added panel(s) as defined in the
wizard. The User Type assigned to each User in the new panel will be the same as that
assigned in the template panel, however, the User Type programming (including name) is
not copied into the new panel.
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To delete a virtual panel:
1. In the Insight Toolbar, right click the virtual panel you wish to delete and choose
“Delete” in the menu that appears.
2. Click Yes. The virtual panel is deleted.
Warning
Deleting a virtual panel cannot be undone, except by creating a new virtual panel and setting it
up again. Think carefully before deleting a virtual panel.




Tip
Deleting a virtual panel doesn’t delete the member panels, and their programming remains
unchanged. Future programming changes can only be made on the individual panels, unless
you create a new virtual panel.
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Insight Card Pool
Insight Card Pool lets you assign, manage and examine access control cards in an Inner Range
security system.
Use Insight Card Pool to:
Create direct entry and site code card pools
Move cards between card pools
Assign cards to users
Mark cards as lost or suspended, or found
Re-activate lost or suspended cards
Automatically create card pools based on panel programming
Detect unassigned cards and add them to card pools
Find and fix duplicate card assignments and other problems of the user programming
Card Pool
Toolbar

Filter
Controls

Insight Toolbar

Browse
Toolbar

Browse Pane
The Insight Toolbar lets you navigate between card pools.
The Card Pool Toolbar lets you manage your card pools.
The browse pane displays cards in the selected card pool.
The filter controls let you filter what is displayed in the browse pane.

Using The Card Pool Toolbar
Create a new site code card pool.
Create a new direct entry card pool.
Perform a panel scan and add newly found cards to a card pool.
Get information about Card Pool Manager.

74

About Card Pools
A card pool is a collection of access control cards which can be assigned to cardholders. Often,
the cards are “keyed” to a particular site and numbered sequentially – these cards are called
site code cards. Such cards store two pieces of information, the site code (which is generally
common between all cards on a site), and the card number which is unique for each card.
Usually, the card number is printed on the card for easy identification. Cards can be enrolled
without a card reader, because the site code and card number are readily identifiable.
Cards that don’t have a site code are called direct entry cards. These cards only have one
piece of information, the card number. Because there is no unique site information encoded on
the card, typically this number is quite long and therefore isn’t usually printed on the card. These
cards have to be physically enrolled at a card reader to be enrolled into the system.
Regardless of which method is used, data is encoded on the card using binary numbers (0’s
and 1’s). The length of this encoding (i.e. the number of binary digits or ‘bits’) determines the
“card format” (e.g. 26-bit, 34-bit etc.) The more bits, the more unique cards that can be
represented.
Card pools simplify the management of cards at a site by streamlining the assignment of cards
to users and introducing the ability to tag cards as lost or suspended. Cards can be returned to
the card pool, which makes them available for re assignment.




Note
You can have any number of direct entry or site code card pools.

Warning
Insight Card Pool ignores tenancy rules. Operators will be able to see the names of cardholders
that don’t belong in their tenancy.

Migrating To Card Pool
If you are migrating to card pool and already have cards programmed in your panels, you
should use Card Pool Manager to add these cards to a card pool.
To migrate to Card Pool in an existing installation:
1. Use the Auto Create Card Pools menu option to create card pools based on panel
programming (see “To automatically create card pools based on panel programming:”
on page 76).
2. Add any other card pools you require (for example, corresponding to unissued cards).
See “To manually create a direct entry card pool:” and “To manually create a site code
card pool:” on page 76.
3. Use the Panel Scan button to detect unassigned cards and add them to your card pools
(see “To allocate unassigned cards to card pools:” on page 81).
4. Optionally, use the “Card Scan” to detect and fix problems with card programming and
assignment.

75

Working With Card Pools
You can create card pools in one of two ways. At any time, you can manually create a card
pool. When you manually create a card pool, you specify:
 The type of card pool (direct entry or site code).
 The name of the card pool.
 The site code (for site code card pools).
If no card pools are present, you can automatically create card pools based on panel
programming. Insight Card Manager looks at the site code programming of each panel, and
creates corresponding site code card pools if they don’t exist already. A direct entry card pool is
also created.
To manually create a direct entry card pool:
1. Select to create a new Direct Entry card pool:
Click the Direct Entry button on the Card Pool toolbar ( ), or
Select “New Card Pool
Direct Entry” in the File Menu, or
Right-click the “All Card Pools” icon in the Insight Toolbar and select “New Card
Pool
Direct Entry” from the context menu.
2. Enter the name for the new card pool.
3. Click OK.



Note
Card Pool Manager expects cards to be badged at an Inner Range Card Enrolment Station (part
number 994500) connected to a PC serial port.

To manually create a site code card pool:
1. Select to create a new Site Code card pool:
Click the Site Code button on the Card Pool toolbar ( ), or
Select “New Card Pool
Site Code” in the File Menu, or
Right-click the “All Card Pools” icon in the Insight Toolbar and select “New Card
Pool
Site Code” from the context menu.
2. Enter a name, site code and site code offset for the card pool. The site code offset is
not normally required. However, you must specify an offset if the card number range
overlaps any other site code card number range in any given panel. For more
information, refer to your Concept system programming documentation.
3. Click OK.



Tip
Insight expects the card number field to be entered in decimal. The Site Code may be entered in
the hexadecimal or decimal field depending on the card format. Insight does the conversion
from hexadecimal to decimal or reverse automatically as you type into the box

To automatically create card pools based on panel programming:
1. In Insight Edit, program the site codes for your panel.
2. In Card Pool Manager, click the Auto Create button on the Card Pool toolbar ( ), or
select “Autocreate Cardpools” in the File Menu. This menu option is only available if
there are no card pools in the system. If a site code is found in any panel with no
corresponding card pool, the card pool is created. A direct entry pool is also created.
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Tip
If you have already issued cards to cardholders, you should use the panel scan feature to
update the contents of your card pools. See page 81.
.



To add cards to an existing direct entry card pool:
1.
2.
3.
4.
5.
6.

Right-click the card pool in the Insight Toolbar.
Select “Add cards” in the context menu.
Select the card format.
Select the COM port of your card reader.
Click the Start Read button.
Badge one or more direct entry cards to add them to the direct entry card pool.

To add cards to an existing site code card pool:
1. Right-click the card pool in the Insight Toolbar.
2. Select “Add cards” in the context menu.
3. Specify how you want the cards to be added, as follows:
Enter range manually: adds a sequential batch of cards without badging them.
st
Swipe range: adds a sequential batch of cards, you swipe the 1 and last card.
Swipe cards: adds cards one at a time as you badge them.
4. If you chose “swipe range” or “swipe cards”, specify the card format and COM port, then
click Start Read and badge your cards.
5. Click OK.



Tip
If you change COM ports while Insight is waiting for you to badge a card, then badging is
aborted. Click the Start button to resume badging.
To merge card pools:
1. Drag one card pool onto the other in the Insight Toolbar.



Note
You can only merge a Direct Entry card pool into another Direct Entry card pool, or a Site Code
card pool into another Site Code card pool with the same site code.

To delete a card pool:
1. Right-click the card pool in the Insight Toolbar.
2. Select “Delete card pool” in the context menu.
3. If the card pool contains any assigned cards, you are asked if the users’ card
programming should be erased by this operation. Select “No” if you want to retain the
users’ card programming.
To delete all cards from a card pool:
This is faster than multi-selecting all cards in the browser pane and deleting them.
1. Right-click the card pool in the Insight Toolbar.
2. Select “Delete all cards” in the context menu.
3. If the card pool contains any assigned cards, you are asked if the users’ card
programming should be erased by this operation. Select “No” if you want to retain the
users’ card programming.

Using The Browser
The browser pane in Card Pool Manager shows the status of cards in a card pool, and also lets
you quickly assign and return cards, tag cards as lost, found, or suspended, reactivate them,
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add notes, plus inspect and fix a the assignment of cards.

The browser pane shows the status of all cards in the currently selected Card Pool. The
meaning of each column is explained below.
Heading
Card Pool Name

Description
The name of the pool containing this card.

Card Number

The card number. For site code cards, this is the
decimal card number component without the site code.
For direct entry cards, this is the entire card number (in
hexadecimal).

Card Type

Either direct entry or site code. For site code cards, the
site code is also displayed (in decimal).

Card Status

Available: the card is waiting to be assigned.
In Use: the card has been assigned to a cardholder.
Lost: the card has been lost.
Suspended: the card has been suspended.

Card Assigned To

For cards that are in use or lost, indicates who the card
is assigned to.

Date/Time Last Updated

The date and time the status of this card most recently
changed.

Reactivate

For cards that are lost or suspended, indicates who the
card will be assigned to if it is reactivated.

Last Assigned To

For cards that are returned from the lost or suspended
states, this column indicates who the previous assignee
was.

Quick Note

Operators can enter general comments in this field.

You can filter the browser pane on a range of criteria. Only cards matching the criteria are
displayed.
To apply a filter to the browse pane:
1. Select a criterion in the Select Filter box.
2. Enter a text string in the Filter Text box. Insight hides cards that don’t match the filter
text.



Tip
To stop filtering, clear the contents of the Select Filter box.

Managing Cards
When card numbers are programmed for users in some panels, these cards are programmed.
You manage cards by assigning them in Insight Card Pool or Insight Edit. Cards can be
marked lost or suspended in both Insight Edit and Insight Card Pool, and they can be returned
or reactivated in Insight Card Pool.
In the browse pane, multi-selection is possible. Any of the actions can be carried out on multiple
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cards where this makes sense (e.g., assigning multiple cards is not possible, but returning them
is). You can select all cards in the browse pane with Ctrl-A.
To assign cards from a card pool:
In Insight Edit, see “To assign a card from a card pool:” on page 49; or
Use the Panel Scan (see page 81) to assign one or more cards to card pools which
have already been programmed in users’ panel programming; or
In Insight Card Pool: In the Insight Toolbar, select the card pool that contains the card
you want to assign. In the browse pane, right-click the card and select “Assign To…”



Note
If a person is programmed as a user in multiple different panels and/or virtual panels, the same
card can be assigned to all of those users, because they all actually correspond to the same
actual person (this is the intended modelling). For this reason, both cards marked as ‘Available’
and ‘In Use’ are assignable. But it is impossible to assign an already assigned card to another
user within the same physical or virtual panel in which it is already assigned and keep the
original assignment, as this would create duplicate card programming. In the panel, if two users
are programmed with the same card number, and this card is badged at a card reader of this
panel, the panel will always assume that it is the user of the two with the lower user number who
is entering, so the other user will never be identified.

General info
about the card

List of panel
users who
already have this
card assigned

Tree of users in the
system. Select the user
here who to assign the
card to.

List of panels where the
site code of the card is
programmed, so this
card can badge in

Tool tip shows current
card assignment state of
this user
Card No: 6128 (site code) (Card Pool: IR)

1. Browse to the user who you want to assign the card to.
2. Hit “Apply” if you want to assign the card to more users. Hit “OK” if you want to assign
the card to only this user and finish at the same time.
3. Hit “Cancel” to finish assigning this card.



Note
If the selected user already had a different card, this card will be removed from them first. If
another user in this panel had this card before, then the card will be taken from them and
assigned to the selected user.

To mark a card as lost:
1. In the Insight Toolbar, select the card pool that contains the lost card.
2. In the browse pane, right-click the lost card and choose “Lost” in the menu that appears.
The status of the card is changed to “lost”. The previous user is shown in the
“Reactivate To:” field of the card.
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To suspend a card:
1. In the Insight Toolbar, select the card pool that contains the lost card.
2. In the browse pane, right-click the card and choose “Suspend” in the menu that
appears. The status of the card is changed to “suspended”. The user who had the card
is shown in the “Reactivate To:” field of the card.
To re-activate a lost or suspended card:
1. In the Insight Toolbar, select the card pool that contains the lost or suspended card.
2. In the browse pane, right-click the card and choose “Reactivate” in the menu that
appears. The card will be reassigned to the user listed in the “Reactivate to” column.



Note
If a card is lost or suspended, do not delete the user who held it before. If you do, don’t try to
reactivate the card, it may be reactivated to an unprogrammed user or to a different person.
To return a lost card to the card pool:
1. In the Insight Toolbar, select the card pool that contains the lost card.
2. In the browse pane, right-click the card and choose “Found” in the menu that appears.
The status of the card will be changed to “available” and the identity of the previous
cardholder will be displayed in the “last assigned to” column.

If a suspended card is lost:
1. In the Insight Toolbar, select the card pool that contains the card.
2. In the browse pane, right-click the card and choose “Lost” in the menu that appears.
The status of the card will be changed to “Lost”. The column “Reactivate To” remains as
before.

To return a card to the card pool:
1. In the Insight Toolbar, select the card pool that contains the card.
2. In the browse pane, right-click the card and choose “Return” in the menu that appears.
The status of the card will be changed to “available” and the identity of the previous
cardholder will be displayed in the “last assigned to” column.
If this card was issued to multiple users across different panels (hopefully all
representing the same person), then this applies to all those users, and all those users
have their card programming reset.
To move cards between card pools:
1. Select the cards you want to move, then drag them onto the target card pool in the
Insight Toolbar.



Note
You can only move Direct Entry cards into Direct Entry card pools, and a Site Code cards into
Site Code card pools with the same site code.



Tip
Changes you make in Card Pool are saved automatically.
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Note
If your changes affect a cardholder in a panel and the panel is online, changes will be written to
the panel immediately. If the panel is offline, changes will be written the next time it is
connected.

Panel Scan for Unassigned Cards
Card Pool
selected

Unassigned
cards found

Assignment
Button

Log (Message)
window

Unassigned cards are cards that have been programmed in Insight Edit for a cardholder, but
don’t exist in any card pools. These will be there if Card Pool was licensed after the cards were
programmed. You can use Card Pool Manager to scan for unassigned cards and add them to
your card pools.
To scan for unassigned cards:
1. Select ‘Panel Scan’:
Click the Panel Scan button on the Card Pool toolbar ( ), or
Select ‘Panel Scan’ in the File menu.
2. Insight scans panel programming, then displays the Assign Users To Card Pool
window. If any unassigned cards are detected, they are displayed in the list.
To allocate unassigned cards to card pools:
1.
2.
3.
4.

Select the cardholders whose cards you wish to assign to a card pool.
Select the card pool in the upper right corner.
Click the “Assign to Card Pool” button.
You can repeat steps 1-3 to assign cards to different card pools. The results of the
actions taken are displayed in the Log window.
5. Click the Close button when finished.



Tip
If you change your mind, you can assign a card you previously assigned to one card pool to
another.

Card Scan
A ‘Card Scan’ shows you all places in the system where a particular card is programmed or
assigned. It can help detect all users of a card and correct common problems such as:
Creating missing links between cards and users who hold them.
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Finding and eliminating duplicate cards or other unintentionally assigned cards.
Finding missing site codes (and programming them in the panels where they are
missing).
Correcting an incorrect card state.
Removing a card from all users who hold it.
Associating a card to all users who are programmed or assigned to have that card.
Correct implicit site card programming. If a user has a ‘site code’ card with card number
0, the user is assumed to have a card with the user number as the card number. This
‘implicit’ card programming is problematic because it is not readily visible and does not
translate well into virtualisation of panels.
Remember, a card is programmed for a user if the user has this card programmed in their
panel programming. It is assigned to the user if it exists in the card pool, and the card pool
shows this user as owner of the card. The card is correctly associated with the user if it is both
programmed and assigned to them. The Card Scan detects if this is correctly done for the
scanned card, and can fix the situation if it finds any problems.
To scan a single card
1. Right-click the card in the browse pane and select ‘Scan’ in the context menu, or
Double-click the card.
To scan multiple cards
1. Select all cards to scan in the browse pane. You can select all cards at once with Ctrl-A.
2. Right-click and select ‘Scan’ in the context menu.

List of cards to
be scanned

Card Scan happens in the
background. Here is a count
of the yet unscanned cards.

Count of the
problems found while
scanning the cards.

For a card that was already
scanned, the ‘User Count’
column displays a symbol to
indicate the problem state
of the card.

Detail of
currently
selected card

Assigned users
of currently
selected card
Panels where the
site code of this
card is programmed
Tree of virtual and physical
users who have this card
assigned or programmed,
with a symbol to indicate
their problem status.

Log window

The Card Scan is a complex procedure and can be slow in large databases, but if you select
multiple cards, most of it is done in the background. The dialog displays a count of the cards
that were not scanned yet, and of the major and minor problems that were found while
scanning. Major problems, indicated with a red cross ( ), are:
A wrong card state (card marked ‘In Use’ when it has no users).
A user has this card assigned, but not programmed.
A user has the card programmed implicitly, i.e., the user has a site code card number of
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0. For a physical user, their actual card number is then the user number. For a virtual
user, the card number can possibly not be determined unambiguously.
A user has this card programmed, but not assigned (exception: a physical user
governed by a virtual user does not need to have the card assigned if the parent virtual
user does).
The card has two holders within the same panel (duplicate card).
The card is assigned to a user in a panel which doesn’t have the card’s site code
programmed and activated.
The card is assigned to a virtual user, and the virtual user represents two users in
different physical panels, and the site code is programmed in both panels, but the two
site codes have different site code offsets.
Minor problems are shown with a blue question mark ( ), because they could indicate an
error, or be correct under certain circumstances:
If the card is duplicate, i.e. exists in two different card pools. This could be two
physically different cards with different site codes.
If a user has the card programmed, but a different card assigned. The user could have
a card with the same number, but another site code assigned. Note that if the panel has
the foreign site code programmed, the user will have access at the panel.
If no problem is found with a card or a user, it is marked with a green tick( ).

Troubleshooting cards with the Card Scan dialog
To operate on a single user of a card:
1. With the card selected, select the user (physical or virtual user) in the user tree.
2. Click “Associate” if you want to fix and complete the user’s card programming, so that
the card is correctly programmed and assigned to this user.
Click “Disassociate” if you want to completely revoke the user’s card programming, so
that the card won’t be assigned to the user, and the user won’t have this card
programmed any more.
To operate on one or multiple cards:
1. Select the card or cards you want to operate on. Ctrl-A selects all cards in the list..
2. The following card reprogramming buttons are only active if the card is incorrectly
associated:
Click “Associate All” if you want to correctly program and assign each card to all its
users found.
Click “Disassociate All” if you want to remove this card from all its users found.
Click “Autofix” to fine-tune the actions executed on all selected cards.

Autofix Options:
“Assign cards to all its users” – this behaves like the “Associate All” button.
“Remove card from all its users” – this behaves like the “Disassociate All” button.
Choose “No change” if you don’t want to operate on user card programming with
this Autofix operation.
“Create missing sitecodes” creates the necessary site codes in panels where they
are missing.
“Remove duplicate users” – when the card scan finds two users of the same card
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within one panel, the second one is invalid and will be removed (unprogrammed).
“Correct all card states” – makes an educated guess about what the correct state
should be of any card that has a “wrong” (inconsistent) state, and sets it.
To remove the assignment of a card to a user, but not remove the user’s card
programming:
Don’t do this here. In the browse pane, delete the card and select “No” when asked if
you want to remove the user’s card programming.
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Insight Review
Insight Review lets you search, filter and print security events from your Inner Range security
system. The Professional Edition also includes advanced alarm handling and report generation.
Use Insight Review to:
View live and archived review
Search and filter review data
Specify advanced alarm rules (professional edition)
Acknowledge alarms (professional edition)
Generate reports (professional edition)

Review Toolbars

Browse
Toolbar

Filter
Stacks

Insight
Toolbar

Review Windows

Review

Filter Stacks Explorer Toolbar

The Insight Toolbar lets you manage your sites and panels (page 17).
Review Windows let you search, filter and display review (page 87).
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Underlying Concepts
Inner Range panels maintain an audit trail of access control and alarm events known as review.
Depending on the size and configuration of the panel, this can be up to 6500 entries. Once the
review log is full, it slowly begins overwriting itself.
Insight uploads review from panels whenever it is connected, and stores it in a permanent
archive. The archive can be examined in real time (as new events are added by panel activity)
or historically. Because Insight keeps a permanent archive, it does not matter when the panel
review log overwrites itself.
Warning
Insight only receives review from panels while they are connected. If events occur when a panel
is disconnected, they are queued and received by Insight the next time a connection occurs.
The number of events that can be queued varies depending on panel size, but is guaranteed to
be at least 300 events and will be at most 6,500 events.



Warning
Insight tracks review via the Insight comms task ([Menu], [7], [3], [1] at any terminal). If this
comms task is stopped and started (manually or via the Control Module being reset) then Insight
cannot determine which review events are ‘unseen’. In this case, you must move the review
pointer manually. See page 91.





Previous Software
In PCDirect and WinDirect, review was received automatically during online edit mode. With
Insight, panels might not be ‘connected’ even when Insight is running. To understand panel
connections, see page 27.
Tip
Insight uploads review from panels whenever they are connected, even if the Review module is
not running.

Insight Audit Events
Insight generates its own review entries called audit events. Audit events are generated when
operators log on and log off, when alarms are acknowledged and when items are edited in
Insight Edit.



Tip
You can filter specifically for audit events. Open a review window, add a new Thing filter, and
set the thing to “Insight Audit”.
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Review Windows
Review is examined in a window called the review window. You can have as many review
windows open at a time as you like, each with its own set of filters. To open a new review
window, select “New…” from the File menu, or press CTRL+N.

Review Toolbar
Period Filter
Thing Filter

Filter Stack

Review

Review Preferences and Review Colouring.
A number of options are available to customize the way in which review events
appear in the Review Window, and the way in which they are audibly
annunciated on the computer.
The “Preferences” and “Review Colouring” dialogues for these options can be
accessed from the Edit Menu.

Insight Review Preferences
Optional “beep” and “Play a Sound File” options are
available for panel “Xmit” review events. i.e. Review
messages for events that have been programmed in the
panel to be reported.
Sound files can be selected independently for Alarm
Notifications and Restores by selecting one of the three
sound file options in the Insight library, or a custom “wave”
sound file (.wav file extension).
Sounds are enabled for Notifications and Restores by
default.
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Insight Review Colouring.
Colours can be selected from a range of 48 basic colours
and up to 16 custom colours for the “foreground” (text) and
“background” of a number of important types of review
events.
Factory default settings are provided, and these can be reinstated at any time by clicking on the “Reset to Factory
Defaults” button.
Clicking on the column-heading, sorts the Review Types in
alphabetical or reverse alphabetical order.
Clicking on the appropriate cell in the Foreground or
Background column opens the colour selection dialogue.
Select the colour and click on OK to save your choice.

Using the Review Toolbar
Open a new review window.
Open a saved filter stack.
Save the current filter stack.
33

Show or hide the filter stack.
Add a new filter to the filter stack (and stops review processing).
Turn auto-scroll on or off.
Clear the current window. Disabled if review processing is enabled.
Starts and stops review processing for this window.
Create a filtered report.
Select review archive.

Using the Filter Toolbar
Open a saved filter.
Save the filter for use later.
Remove the filter from the filter stack.
Toggle and/or logic. If and is selected, review must match this filter as well as
previous filters. If or is selected, review only has to match this filter plus any
subsequent and filters.
To Examine Review:
1. Open a new review window (CTRL+N)
2. Load or modify the filter stack to suit your requirements
3. If your filter stack includes the “all review”, “live review” or “last…” filters, and you want
review to appear as it happens at the panel, make sure the panel is connected in the
Insight Toolbar.
4. Click the “GO” button.
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Filtering Review
Since Insight saves every single review event ever received, the number of events can grow to
a large number. Usually, you will only be interested in examining review from a particular time
period or from a specific panel. You can quickly isolate review of interest by applying filters.
About Filter Stacks
Each review window has a filter stack applied to it. A filter stack is a collection of one or more
filters which are “stacked” between the window title and the window contents. When you modify
the filter stack, you change what review events are displayed in the window.



Tip
You can hide the filter stack by clicking the show/hide filter stack button. The filters still apply
even when hidden.

Time Filters
Time filters let you filter for review that occurred at a certain time. There are five types of time
filters.
On:

Lets you specify a particular day. You can also specify a time interval on
the specified day, for example 18:30 to 19:15.

From / To:

Lets you specify an interval that spans more than one day. For example,
rd
midday on March 15 until 8pm on April 3 .

Last:

Live Review:
All Review:

Lets you specify review that occurred within a certain range of the current
time. For example, the last 45 minutes or the last 2 weeks. As time passes,
entries will disappear with this filter type.
This special filter type matches any review that is received live from a
connected panel.
This special filter type matches ALL review unconditionally, including live
review from connected panels.

Thing Filters
Thing filters let you filter for review that concerns a particular item. Refer to the table below.
I want to…

This is achieved by…

See review from a specific panel.

Select the panel thing filter.

Exclude review from a specific panel.

Select the panel thing filter, then set the
matching option box to “isn’t”.

See review that contains certain text.

Select the text compare thing filter.

Exclude review that contains certain text.

Select the text compare thing filter, then set
the matching option box to “isn’t”.

See review for a particular user, door, area,
time zone, function zone, calculated auxiliary,
diary, input or module.

Select the user, door, area, time zone,
function zone, calculated auxiliary, diary or
module thing filter.

Exclude review for a particular user, door,
area, time zone, function zone, calculated
auxiliary, diary, input or module.

Select the user, door, area, time zone,
function zone, calculated auxiliary, diary or
module thing filter, then set the matching
option box to “isn’t”.

See review that is a particular type (e.g. area
on/off, system messages, user access etc.)

Select the review type thing filter.

Exclude review that is a particular type.

Select the review type thing filter, then set the
matching option box to “isn’t”.
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I want to…

This is achieved by…

See XMIT entries.

Select the XMIT thing filter. (XMIT entries are
review messages flagged as ‘important’ by the
panel).

Select review for a particular XMIT message
type.

Select a thing filter that starts with an asterisk.

See all Insight audit events.

Select the Insight audit thing filter.

See edits made to panel programming, Insight
programming or Insight permissions.

Select the audit panel items, audit insight
items or audit permissions thing filter.

See operator log-ons and log-offs.

Select the audit operator log thing filter.

See panel enrolments.

Select the audit sync panel thing filter.



Paid Feature
Not all of these filters are available in Insight Installer.

You can combine any number of time and thing filters to create more complex rules. For
example, by adding three filters you could show only review from “Panel A” that occurred in the
last hour and contains the word “granted” in the message.
To add a filter to the filter stack:
1. Click the add filters button in the toolbar (

) and choose the appropriate type.

2. Modify the filter according to you requirements.
3. If this isn’t the only filter in the stack, click the and/or button to determine how this filter
interacts with the other filters in the stack.
4. Click the go button (

) to activate review processing for the window.



Tip
You can search for items in the review window. Choose “Find…” from the Edit menu, or press
CTRL+F.

To copy review to the clipboard:
1. Select the item(s) you want to copy.
2. Choose “Copy” from the Edit menu, or press CTRL+C.



Tip
You can select multiple rows by holding down the Shift or Control keys whilst clicking in the
review window.

To save review to a text file:
1. (Optional) select the entries you want to save.
2. Choose “Save As…” from the File menu.
3. To save all events, click the All Entries radio button. To save the events you selected in
step 1, click the Selected Events radio button.
4. (Optional) enter a name for your file.
5. Click Save.
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Moving The Review Pointer
If the Insight comms task is reset, then Insight cannot determine which review entries have not
been processed. In this case, it is possible to move the review pointer manually.
To move the review pointer:
1. Right click the panel in the Insight Toolbar and choose “Review” in the menu that
appears, then choose “Move Back…”.
2. Enter how far back you want to move the review pointer.
3. Click Close.
Warning
Moving the review pointer may cause duplicate review entries to be recorded. This feature is
recommended for experts only.



Basic Reports
Insight includes report templates for most common reporting activities, including user access,
door access and alarm reports. Refer to the table below.
I want to…
Create a report showing all review events.
Create a report showing all comms task triggers.
Create a report showing all XMIT events.
Create a report showing user activity.
Create a report showing door activity.
Create a report showing lift activity.
Create a time on site report.
Create a report showing events matching a
complex filter.

This is achieved by…
Use the all events report.
Use the all alarms report.
Use the XMIT alarms report.
Use the user access report.
Use the door access report.
Use the lift access report.
Use the time on site report.
Create a filter stack report.

To generate a basic report:
1. Select the desired report from the Reports menu.
2. Specify the criteria for your report.
3. Click OK. Insight generates the report.



Tip
You can copy all or part of the report into the Windows clipboard. Select the portion you want to
copy, then choose “Copy” from the Edit menu, or press CTRL+C. Formatting will be preserved if
you paste the report into a compatible application such as Microsoft® Word.
To print a report:
1. Choose “Print…” from the edit menu.



Tip
If your report doesn’t paginate correctly, then regenerate the report and change the “records per
page” value to something else.
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To save the report to disk:
1. Choose “Save As…” from the File menu, or press CTRL+S.



Tip
The report is saved in HTML format and can be opened by any web browser.

To find text in a report:
1. Choose “Find…” from the Edit menu, or press CTRL+F.

Custom Reports
You can generate a report based on complex rules and filters. Creating custom reports is a twostep process. First, a filter stack is created that specifies the criteria for the report. Then, the
report is generated.
To create a custom report:
1. If necessary, create a new review window (select “New…” from the File menu, or press
CTRL+N).
2. Add time filters and thing filters to your review window until it is filtering for the data you
want (see page 89).
3. Test your filter stack by pressing the Go button in the toolbar ( ).
4. Click the Filtered Report button in the toolbar ( ). A report is generated matching the
criteria in the filter stack.


Tip

If you save the filter stack with the Save Filter Stack button ( ), then you can quickly access
the report by choosing “Filter Stack” from the Reports menu, then selecting your saved filter
stack. Make sure you are saving the Filter Stack, and not an individual filter - the Save Filter
Stack button is next to the Hide Filter Stack button ( ) at the top of each review window.

Time On Site Report
With Insight you can generate a Time On Site report.
The key features of the Time On Site report are:
1. Fully customisable report criteria including
flexible start and end times, multiple shift times,
cardholders, doors.
2. Selectable reporting fields.
3. Choice of detailed or exception reporting modes.
4. Customisable shift tolerance.
5. Provision for worker breaks of customisable
duration.
6. Option to export to CSV (Comma Separated
Values) file readable by Excel & other software.
7. Option to export to MYOB, Tenix or Custom file.
8. Six ‘report inaccuracy’ validation triggers.
9. Ability to load and save all report settings.



Paid Feature
Time On Site reporting is licensed separately as part of the Insight Advanced Reporting Licence
and requires Insight Professional to operate.
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To generate a Time On Site report:
1.
2.
3.
4.
5.
6.

7.

8.
9.
10.

Choose “Time On Site” from the Reports menu.
On the Time/Date tab, specify the starting and ending date and time for the report.
Define one or more shifts for the report.
On the Panels/Users/Doors tab, select at least one cardholder and door. Any number of
additional doors and cardholders can be specified, across multiple Panels if required.
On the Fields tab, tick the fields you want included on the report.
On the Detailed/Exception tab, choose between a detailed report (which includes all
time on site information) and an exception report (which only includes entries that match
specified exception criteria, such as minimum or maximum hours per day/week/month).
If you want to export the data in addition to generating the report, tick the Generate
Export File box on the Export tab, and choose your Export Type (Custom, MYOB or
Tenix). Once you have chosen the export type, you can then choose your export
settings relevant to that type. If you choose the “Custom” type, you will need to setup
the file format. See “To setup a custom export type format” below.
Choose which review archive to run the report on. The default is “current”, which
contains review that hasn’t been archived.
If you want to save the report settings, click the Save Settings button.
Click OK to generate the report.

To setup a Custom export type format:
1. Choose “Custom” from the
Export Type drop-down list.
2. Select “Edit Custom Output
Format”.
3. Define the content of the
Header, User Summary
record, Ingress/Egress
record and Footer sections.
The required data fields,
separators, format
identifiers, etc. are added by
selecting an insertion point
and double-clicking on an
item in the “Substitution
Fields” list. Normal text can
also be entered by typing.
4. Click OK to accept the
settings for this report.
Date and Time formatting.
In the custom export format definitions; the operator can specify a date format by including a
format phrase in square brackets [].
e.g.
User exited at: ^LASTOUT[%H:%M]\^
For example, a “User Summary Record: (repeated for each user)” line like this:
^USERDEFINED1\^^COMMA\^^LASTOUT[%d/%m/%Y,%H:%M]\^^COMMA\^^ACCES
SPOINTLAST\^^NEWLINE\^
Could produce an output line like this: 666777,18/06/2008,11:25,TOS Door
The formatting codes for the date / time fields are listed below:
%a
%A
%b
%B

Abbreviated weekday name
Full weekday name
Abbreviated month name
Full month name
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%c
%d
%H
%I
%j
%m
%M
%p
%S
%U
%w
%W
%x
%X
%y
%Y
%z, %Z
%%

Date and time representation appropriate for locale
Day of month as decimal number (01 – 31)
Hour in 24-hour format (00 – 23)
Hour in 12-hour format (01 – 12)
Day of year as decimal number (001 – 366)
Month as decimal number (01 – 12)
Minute as decimal number (00 – 59)
Current locale's A.M./P.M. indicator for 12-hour clock
Second as decimal number (00 – 59)
Week of year as decimal number, with Sunday as first day of week (00 – 53)
Weekday as decimal number (0 – 6; Sunday is 0)
Week of year as decimal number, with Monday as first day of week (00 – 53)
Date representation for current locale
Time representation for current locale
Year without century, as decimal number (00 – 99)
Year with century, as decimal number
Either the time zone name or time zone abbreviation, depending on registry
settings; no characters if time zone is unknown.
Percent sign

Note that only the following codes are relevant when defining a time span:
%d
Day of month. Must be used alone & is specified as a decimal number.
%H, %M and %S
Hour, Minute and Second. May be used together.

The # flag may prefix any formatting code. In that case, the meaning of the format code is
changed as follows.
Format Code
%#a, %#A, %#b, %#B, %#p, %#X,
%#z, %#Z, %#%
%#c

%#x
%#d, %#H, %#I, %#j, %#m, %#M,
%#S, %#U, %#w, %#W, %#y,
%#Y



Meaning
# flag is ignored.
Long date and time representation, appropriate for current
locale. For example: "Tuesday, March 14, 1995,
12:41:29".
Long date representation, appropriate to current locale.
For example: "Tuesday, March 14, 1995".
Remove leading zeros (if any).

Note
Insight will automatically flag users whose report data may include inaccuracies. Users are
flagged who trigger any of the following events:
1.
2.
3.
4.
5.
6.




Two or more consecutive ‘Door Out’ events without an intervening ‘Door In’ event.
Two or more consecutive ‘Door In’ events without an intervening ‘Door Out’ event.
First event in shift is ‘Door Out’.
Last event in shift is ‘Door In’.
No ‘Door Out’ events in shift.
No User/Door Access review entries.

Tip
You can specify a shift tolerance when generating a time on site report. In and Out events
occurring within the specified tolerance will be included in the report.

Tip
You can specify customisable worker breaks. Time off site will be ignored if it is less than the
specified interval.
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To generate a report using saved settings:
1.
2.
3.
4.
5.
6.

Choose “Time On Site” from the Reports menu.
Click the Load Settings button.
Navigate to your saved settings file.
Click Open.
(Optional) make any desired settings changes prior to running the report.
Click OK to run the report.

Alarms
Insight provides advanced, customisable alarm recognition and response. The key features of
Insight alarm handling are:







Four alarm levels: low, medium, high and critical.
Define any number of customisable alarm events with complex filters.
Customisable alarm reaction including sound effects and opening schematic maps.
Automatic user photograph pop-up.
Customisable help response messages.
Customisable operator responses.

What is an alarm?
For clarity, we define two different types of alarm:
- Panel alarms (also called XMIT entries) are security conditions detected in the field by a
Control Module and flagged as an alarm. Usually, you will want these alarms to be handled as
an alarm condition in Insight.
- Insight alarms are defined by Operators. They may or may not be based on an XMIT entry.
Insight Alarms are much more flexible than panel alarms, because you can choose exactly what
conditions must be satisfied for the alarm to be raised.
The way Insight reacts to an alarm is controlled by an alarm response. When Insight is first
installed, it has a single alarm response set up that handles all panel alarms. You can modify or
remove this alarm response, and you can add any number of additional alarm responses.
Alarms are displayed in the alarms window, and must be acknowledged. In any module, the
number of outstanding alarms is displayed in the lower right hand corner of the screen.



Paid Feature
Alarm handling is not available in Insight Installer.

Acknowledging Alarms
When an alarm occurs, a number of things will
happen, depending on the rules specified in the
corresponding alarm response. Typically, an
alert sound is played and the alarm count starts
flashing.
To open the alarm handler window:
1. In any module, click the alarm count in
the status bar (bottom right).

To acknowledge an alarm:
1. Open the alarm handler window.
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2. Select the alarm you wish to acknowledge. (You can select multiple alarms with the shift
and control keys).
3. Click the Acknowledge Alarm button (
). Depending on the alarm response options
the Alarm Acknowledge screen appears.
4. If the alarm requires an acknowledgement message, then enter your acknowledgement
text. You can select from pre-defined operator
responses by clicking the down-arrow at the
right edge of the field.
5. Click OK. The alarm is removed from the alarm handler window.

Working With Alarm Responses
An alarm response defines what rules constitute an alarm and also specifies how Insight reacts
when it occurs. Alarms are defined using a filter stack. When incoming review matches the filter
stack, the alarm is triggered. A triggered alarm can be configured to attract the Operator’s
attention in a variety of ways. Triggered alarms are added to the alarms window and must be
acknowledged.
To create a new alarm response:
1. In any module, click the alarm counter (bottom right corner). The Alarm Handler window
opens.
2. On the Edit Alarms menu, choose “New
Alarm Response” and navigate to the
type of review event you want to base
the alarm response on. A new filter stack
is created matching your criteria, and the
Alarm Response window is displayed.
3. Enter the settings for this alarm response
(see below).
4. Click OK.
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Options Tab
This defines the basic properties of the Alarm Response.
Item

Description

Name

The name of the alarm response, used for identification only.

Alarm Level

Specifies the urgency of the alarm. Since the alarm window
can be filtered to only show a certain level and above, this
can be used to prioritise alarms.

Response Help

Specifies the help text that should be displayed when the
alarm is acknowledged.

Operator Response

If ticked, the operator must enter a text message when
acknowledging the alarm. If cleared, no text message is
required.

Enabled

If ticked, alarm processing occurs normally for this alarm
response. If cleared, the alarm response is ignored.

This Alarm will be
Acknowledged Automatically

If ticked, no operator action is required - Insight will
acknowledge the Alarm automatically and the Alarm will not
appear in the IR Alarm Handler window.

Message Tab
Controls the Message displayed to the Operator in the Alarm Response window.
Item

Description

Alarm Response Message

A description of the alarm. This text is displayed next to the
alarm in the alarm handler window.

Text Colour

When the alarm occurs, the text will be this colour in the
alarm handler window.

Background Colour

When the alarm occurs, this colour will be behind the alarm
in the alarm handler window.

Immediate Tab
Allows Insight to perform actions immediately upon receipt of this type of Alarm Insight Review.
Item

Description

Beep PC’s internal Speaker

When the alarm occurs, the internal PC speaker is beeped.

Play a Sound File

When the alarm occurs, the specified sound file is played. To
choose a custom sound, press the Custom radio button, then
browse to the sound file (must be in WAV format). Press the
Test button to hear the alarm sound.

Repeat Count

Indicates how many times to play the alarm sound. If set to
continuous, the sound repeats until the alarm is
acknowledged or the mute sounds button is pressed in the
toolbar (
).

Maximize Window

If Insight Review is running, then it will be maximised (in
other words, the window will be expanded to take up the
entire screen). If Insight Review isn’t running, this option is
ignored.

Flash Application Icon In
Taskbar

If Insight Review is running, then it will start flashing in the
Windows task bar. If Insight Review isn’t running, this option
is ignored.
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Display Photo-ID User
Verification screen

If the review entry that generated the event has a user
associated with it, then the Photo-ID User Verification screen
is displayed.

Start Insight Schematic

Launches Insight Schematic.

…when computer name is

If this field is used, a Windows machine name (without the
backslash characters) must be specified.

Map

In Insight Schematic, specifies which map to display when
the alarm occurs.

Show DVR Camera Live Video

Opens a new video window displaying live video from the
specified camera.

Run (immediate tab)

You can specify the path, name and command line options of
rd
a 3 -party software component, which will be executed when
the alarm occurs.




Note
Custom alarm sounds are not backed up by Insight Archiver. If you delete or rename the custom
sounds, then they will not be played by Insight.
Paid Feature
The Display Photo-ID User Verification screen requires a valid Photo-ID licence.

Using the Photo-ID User Verification
Screen
1. The Photo-ID User Verification
Screen will appear in response
to a user event when enabled.
2. The user associated with the
current user event is displayed
in the middle of the screen.
3. The associated review event is
displayed beneath the pictures.
4. Selecting the Previous or Next
button will show the
corresponding user event and
user photo. You can also click
on the previous or next photo to
go to the corresponding event
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Acknowledge Tab
Contains options pertaining to Alarm acknowledgement.
Item

Description

Display a Message Box

If this option is ticked, then double-clicking an alarm opens
the alarm acknowledgement window. If this option isn’t ticked
and response help is set to none and operator response isn’t
ticked, then double-clicking an alarm silently removes it
without showing the alarm acknowledgement window.

Display a dialog box showing
User Information

If the review entry that generated the event has a user
associated with it, then a User Information Window is
displayed when the alarm is acknowledged, unless the Auto
Pop-Up option is ticked. (This is a different window to the
Photo-ID Verification box in the Immediate tab)

Auto Pop-Up

If the review entry that generated the event has a user
associated with it, then the User Information Window is
displayed when the alarm occurs. The User Information
option must also be ticked.

Run (acknowledge tab)

You can specify the path, name and command line options of
rd
a 3 -party software component, which will be executed when
the alarm is acknowledged.

DVR Tab
Commands can be sent to cameras and DVRs when an Alarm is received.
Item

Description

Execute DVR Command

Sends the specified command to the selected camera or
DVR.

Additional Parameters

Some commands require additional parameters, which can
be specified in these fields.

Reports Tab
Advanced Reports can be triggered to run upon receipt of an Alarm.
Item

Description

Run Report

The checkbox runs the selected report when the alarm
occurs.

Additional Parameters

Allow you to select from Advanced Reports in the system.




Note
For reports to execute automatically, you must set a valid printer in the settings for the selected
report. If you need to print to a network printer, the IRDB service on the Insight server computer
must be set to run using an account that has access to the network printer(s). See your network
administrator if network printing is required.
Tip
Unlike the Actions in the other tabs, the Actions in the DVR and Reports tab aren’t dependent
on an Insight client module being open at the time the Alarm is received. These actions will
execute when the alarm is received by Insight as long as the Insight server is running.
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Paid Feature
To perform DVR commands on alarms, the Insight DVR Integration Module must be purchased.
Likewise, the Insight Advanced Reporting Module is required to trigger reports on alarms.



To customise which events trigger an existing alarm response:
1. Open the Alarm Handler window by clicking the alarm count.
2. Click the Alarm Responses button in the toolbar (
)
3. Select the alarm response you wish to modify, then click Edit. The alarm response filter
stack is displayed, then the alarm response window is opened.
4. Click Cancel to close the alarm response window. You will be left with the alarm
response filter stack.
5. Modify the filter stack to suit your requirements (page 89). Remember, any review
messages that satisfy your filter stack will generate an alarm.
6. Close the filter stack. Changes take effect immediately.

To modify how Insight reacts to an existing alarm response:
1. Open the Alarm Handler window by clicking the alarm count.
2. Click the Alarm Responses button in the toolbar (
)
3. Select the alarm response you wish to modify, then click Edit. The alarm response filter
stack is displayed, then the alarm response window is opened.
4. Make any changes to the alarm response.
5. Click OK.



Tip
If the filter stack for the alarm response is open, then you can modify the alarm response simply
by clicking the Alarm Response button on the toolbar ( ).
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Working With Help Responses
Help responses are displayed as part of the alarm acknowledgement window. You can create
different help responses for different alarms. You must first create the help response using the
help response editor. You can then attach the help response to an alarm so it will be displayed
during the acknowledgement procedure.
To create a new help response:
1. Open the Alarm Handler window by clicking
the alarm count (bottom right corner).
2. Click the Help Responses button in the
toolbar (
).
3. Click New.
4. Enter the name and text of the help
response. You can use the formatting tools at
the bottom of the window to control text
colour, size and formatting.
5. Click OK.
To modify an existing help response:
1. Open the Alarm Handler window by clicking the alarm count.
2.
3.
4.
5.
6.

Click the Help Responses button in the toolbar (
).
Select the help response you wish to modify.
Click Edit.
Make any changes you require.
Click OK. The next time you acknowledge an alarm with this help response attached,
you will be shown the updated text.

To attach help response to an alarm:
1. Open the Alarm Handler window by clicking the alarm count.
2. Click the Alarm Responses button in the toolbar (
)
3. Select the alarm response you wish to modify, then click Edit. The alarm response filter
stack is displayed, then the alarm response window is opened.
4. Select the Options tab.
5. Click the Response Help field, and select the help response you want displayed.
6. Click OK. When operator’s acknowledge this type of alarm, the help text will be
displayed in the acknowledge window.
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Working With Operator Responses
Operators usually need to enter text when acknowledging alarms. Instead of entering free text,
you can provide “templates” dealing with common responses that the operator can quickly
select.
To create a new operator response:
1. Open the Alarm Handler window by clicking the alarm count.
2.
3.
4.
5.

Click the Operator Responses button in the toolbar (
Click New.
Enter the name and text of the operator response.
Click OK.

).

To modify an existing operator response:
1. Open the Alarm Handler window by clicking the alarm count.
2.
3.
4.
5.
6.

Click the Operator Responses button in the toolbar (
Select the operator response you wish to modify.
Click Edit.
Make any changes you require.
Click OK.

).

To apply an operator response when acknowledging an alarm:
1. Double-click the alarm to open the alarm acknowledgement screen
2. In the Operator Acknowledgement field, click the pull-down arrow and choose the
appropriate response. You can optionally modify the text if required.
3. Click OK.
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Insight Licence Manager
Insight Professional requires licence keys to function. These licence keys are stored in the USB
hardware lock that was shipped with Insight Professional.
Use Insight Licence Manager to:
View installed licence keys
Install and remove licence keys

Serial Number

Licence Keys

Active Remote
Connection

The Serial Number identifies your Insight installation.
The Licence Keys determine which features of Insight are available.
The Allow TS and Deny TS buttons and the Allow TS Checkbox are used in
conjunction with “Allow Remote” licences. See the installation instructions supplied with
the Allow Remote license for more details.
Paid Feature
Insight Licence Manager is part of Insight Professional.



Registering Insight Professional
Insight Professional will operate in Professional mode for thirty days from the initial installation
date. During this time, you must contact Inner Range for a permanent Professional licence key.
To register Insight Professional:
1. Choose “About…” from the Help menu of any module.
2. Click the hyperlink that says Click to Register. A new window appears.
3. Click the hyperlink that says Click here for registration form.




Warning
If you fail to register in the 30-day period, Insight will revert to Installer operation. As soon as
your permanent Professional key is entered, Insight will return to Professional operation.

Tip
The Insight serial number is stored inside the hardware key. You can
quickly check the serial number by opening the About box in any
module.
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Licensed Modules
Your Insight Professional licence provides unlimited access to the core Insight Professional
modules such as Insight Operators and Insight Schematic. The following features or functions
are licensed separately:
 Client License
 Panel License
 Insight Reports






Photo ID
Card Pool
Hotel PMS Interface
Just-In-Time User Programming
Camera Licence

 IP-Xmit Alarm Forwarding
 Allow Remote Clients
 COM Interface - Read Only
 COM Interface - Read/Write
 Tag-Board
 User Qualification Expiry
 IP Door Controller licensing

- Licensed per machine. Allows an additional
workstation to run Insight Professional.
- Licensed per panel. Allows enrolment of an
additional Concept control module.
- Allows operators to use the Advanced Reports
module.
- Allows operators to use the Photo ID module.
- Allows operators to use the Card Pool module.
- Allows use of the Dynamic User Import Module.
- Allows use of the Active User Rotation Module.
- Allows use of the DVR Integration module. Two
types of this license are generated. The first
license purchased of this type will allow 30
cameras to be connected to Insight.
Subsequent licenses purchased of this type will
allow an additional 10 cameras to be connected
to Insight
- Allows use of the Insight Communicator
module.
- Allows remote terminal sessions to the Insight
server.
rd
- Allows 3 party products read only access to
Insight via the COM interface. (Note: This
license allows the creation of review messages)
rd
- Allows 3 party products read/write access to
Insight via the COM interface.
- Allows operators to use the Tag Board module.
- Allows the use of the Qualifications module.
- Licensed per panel. Allows enrolment of an
additional Concept IP Door Control module.
(Note: The first 15 IP Door Controllers do not
require a license)

Panel Licensing
Insight Professional includes a licence to enrol one panel. To enrol additional panels, additional
licences are required. Contact your Inner Range distributor.
Note: Up to 15 IP Door Controller Panels may be enrolled without additional licenses.

Workstation Licensing
Insight Professional includes a licence to log in from one workstation. To enrol additional
workstations, additional licences are required. Contact your Inner Range distributor.

About Fixed Workstation Licences
When you purchase workstation licences, they are initially “floating”. As soon as an operator
logs on from a new non-server workstation, the licence becomes locked to that workstation. You
can manually “unlock” a licence at the rate of one workstation per week.
To unlock a workstation licence:
1. In Licence Manager, select the workstation whose licence you want to release.
2. Click Remove.
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To unlock all workstation licences without waiting one week per licence:
1. Contact Inner Range, who can issue a special key to release all workstation licences.
The key will function for 48 hours from the time of generation.

Remote (Terminal Services) Licensing
Insight Professional supports connections to Insight machines over Windows Remote Desktop
or Terminal Services.
The Insight Allow Remote Licence allows connection to an Insight computer on the
network from a remote computer in order to use Insight. The remote computer does not
need to have Insight installed on it.
A Client licence needs to be purchased for each remote connection. For more information,
contact your Inner Range distributor.

105

Insight Operators
Insight Operators lets you manage who is allowed to login to Insight, and what privileges they
have within the Insight system.
Use Insight Operators to:
Create operators
Delete operators
Modify operator privileges
Create “locked down” workstations with reduced privileges
Manage tenancies in multi-tenant systems
Launch Toolbar

Browse Toolbar

Insight Toolbar

Browse Pane

The Insight Toolbar lets you select between operators, workstations, operator types
and tenants.
The browse pane displays items you can modify.

Paid Feature
Insight Operators is part of Insight Professional.




Demo Edition
Operator passwords are bypassed in the demonstration version of Insight.
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Working With Operators
Access to Insight modules is restricted to
authorised personnel called operators.
Operators have their own user name and
password. Operators can be assigned different
levels of privilege, which determine what
operations they can perform.
Administrators
Special operators can be created called
administrators. Administrators are like normal
operators, but with permanently elevated
privileges.
Installer
There is only one installer operator in any Insight installation. The installer has all the privileges
of an administrator, plus the ability to create and delete tenants. The installer is invisible to
everyone except the installer.
Task Manager
There is only one task manager operator in any Insight installation. The account is invisible to
everyone except the installer. The task manager is a special non-logon account which executes
any scheduled operation, including:





Scheduled panel time sync (page 33).
Scheduled user expiry (page 41).
Scheduled database archive.
Scheduled DVR time sync (page 142).

To create an Operator:
1. Click the Operators tab in the Insight
Toolbar.
2. Click the “New” button; or press the
Insert key; or right click the browser
pane and select “New Operator…”
from the menu that appears.
3. Enter a unique name for the Operator.
4. Specify a password for the Operator
then retype the password in the
Confirm Password field.
5. Click the “Types” icon, and allocate
Operator Types to the Operator.
6. Click the “Access” icon, and configure
the Expiry and Availability parameters
for this Operator if required.
7. Click OK to save the new Operator.

To delete an Operator:
1. Click the Operators tab in the Insight Toolbar.
2. Right click the Operator and choose “Delete” in the menu that appears; or click the
Operator with the left mouse button, then press the Delete key.
3. Click Yes when asked if you really want to delete the Operator.
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Tip
You cannot delete yourself.




Operator Permissions
To create an Operator you need create permissions on operators. To delete an operator you
need delete permission on the operator.

To suspend an Operator:
You can suspend an operator without deleting them.
1. Open the Operator you wish to suspend.
2. Click the “Disabled” radio button.
3. Click OK. The Operator will not be able to login to any modules.




Tip
You cannot suspend yourself.

Operator Permissions
To suspend an Operator you must have the change permission on the Operator.

Working With Operator Types
Operator Types let you control which
items Operators can see, create,
delete, control and modify.
Once an Operator Type has been
created, you can assign it to Operators.

To create an Operator Type:
1. Click the Operator Types tab in
the Insight Toolbar.
2. Click the “New” button; or press the Insert key; or right click the browser pane and
select “New Operator Type…” from the menu that appears.
3. Enter a unique name for the Operator Type.
4. Click the “Permissions” icon, and allocate privileges to the Operator Type.
5. Click the “Log On” icon, and specify which workstations Operators of this type are
permitted to log on from.
6. Click OK to save the new Operator Type.
To delete an Operator Type:
1. Click the Operator Types tab in the Insight Toolbar.
2. Right click the Operator Type and choose “Delete” in the menu that appears; or click the
Operator Type with the left mouse button, then press the Delete key.
3. Click Yes when asked if you really want to delete the Operator Type.
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Note
Deleting an Operator Type might prevent Operators from logging in, since an Operator with no
Type cannot login to Insight modules.





Tip
Operators who are Administrators automatically receive all privileges. You do not have to assign
them any Operator Types.

Operator Permissions
To create a new Operator Type, you must have the create permission for Operator Types. To
delete an Operator Type you must have the delete permission on the Operator Type.

Working With Permissions
Permissions are at the heart of Operator Types.
With permissions, you can precisely control what
an Operator can do in Insight.
There are three pages of permissions in each
Operator Type: sites and panels shows
permissions for all sites, panels, panel
programming and maps. Security shows
permissions for Operators, Operator Types and
Workstations (in other words, the items
manipulated by the Insight Operators module
itself). Defaults shows what permissions will apply
to new items that are created in the future.
Insight lets you define what an Operator can do via nine permissions.
Permission
See

Description
The see permission means you can see the item in lists and browser panes.

Inspect

The inspect permission means you can open the item and see how it is
configured.

Change

The change permission means you can modify the item and save your
changes.

Create

The create permission means you can create new items of that type.
Permissions on the new item will be copied from the Defaults page.

Delete

The delete permission means you can delete the item. For panel items like
doors and user types, this permission lets you reset the record to the
unprogrammed state.

Control

The control permission means you can control the item via the Insight Toolbar.

Print

The print permission is not currently implemented.

Export

The export permission means you can export data to a file. It’s currently only
used by the “save panel as template” command in Insight Edit.

Set Perms

The set perms permission is not currently implemented.

Setting Permissions
You grant or deny permissions on a particular item by ticking or clearing the corresponding
checkbox for that item.
The privileges windows are deliberately organised in a tree structure. When you tick an item at
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the top of the tree, the tick “ripples” down through the branches of the tree. Thus, ticking “see” at
the top-most site level grants the “see” privilege to all items in the site including sub-sites,
panels, programming items and maps.





Tip
If you don’t want a tick to “ripple” down the tree, hold down the Control key when you click the
checkbox. The tick will not ripple more than one level down.

Tip
Sometimes, you may want to “ripple” a setting that only makes sense at the lower branches of
the permission tree. For example, you can control doors but not sites. In this case, Insight
provides a special check box with a black border. The purpose of this check box is to provide a
convenient means of turning the permission on and off at a lower level in the tree.

Operator Permissions
To set permissions on an item, you must have the set perms permission on that item. To set
some items, you must also be an administrator.

Working With Module Permissions
With Insight, you can grant or deny Operators access to Insight modules, and you can also
control what actions can be performed within modules. Module permissions are set at the
Operator Type level.
I want to

Use this permission in the tree (see below)

Control which alarms an operator
type can acknowledge

Alarm Handler Alarm Acknowledgement
(Critical/High/Medium/Low)

Specify whether an operator type can
create, edit and remove Alarm
Responses

Alarm Handler Alarm Responses
(Create/Edit/Remove)

Specify whether an operator type can
create, edit and remove Help
Responses

Alarm Handler Help Responses
(Create/Edit/Remove)

Specify which Insight modules are
available to an Operator Type

Run Modules (module name)

To change the permissions for an Operator Type:
1. Double-click the Operator Type you wish to modify.
2. Click Modules.
3. Expand the tree on the right hand pane to locate the item you wish to modify. Ticking an
item grants the permission to all Operators with this Operator Type.
4. Click OK.



Tip
Operators with multiple Operator Types receive the combined permissions of each Operator
Type.
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Working With Workstations
Insight lets you use workstations in two ways.
1. You can specify that certain Operator
Types must log on from designated
workstations.
2. By applying an Operator Type to a
workstation, you can limit the
permissions that are available from
that workstation.
To create a workstation:
1. Click the workstation tab in the Insight
Toolbar.
2. Click the “New” button; or press the Insert key; or right click the browser pane and
select “New Workstation…” from the menu that appears.
3. Enter the name of the workstation, or click the Browse button and select the
workstation from the network.
4. Click OK to save the new workstation.

To delete a workstation:
1. Click the workstation tab in the Insight Toolbar.
2. Right click the workstation and choose “Delete” in the menu that appears; or click the
workstation with the left mouse button, then press the Delete key.
3. Click Yes when asked if you really want to delete the workstation.
To create a “locked down” workstation:
1. Create an Operator Type, and set up the maximum permissions that will be permitted
from your locked-down workstation.
2. Right-click the workstation and choose “Properties…” from the menu that appears.
3. Click the “Operator Type” icon.
4. Click the radio button labelled “Restrict permissions to this operator type”.
5. Select the Operator Type you created.
6. Click OK to save your changes.
Any permission that isn’t granted in the Operator Type will never be allowed on the lockeddown workstation. Any permission that is granted in the Operator Type may be allowed on the
locked-down workstation, depending on the Operator’s normal permissions.





Note
You cannot create or edit Operator Types from workstations that have been locked down.

Warning
It is possible to lock yourself out of Insight completely with this feature. Use it carefully, and
make sure you never lock down your system in such a way that you (the administrator) cannot
change permissions from any workstation.
Operator Permissions
To create a new workstation, you must have the create permission for workstations. To delete a
workstation, you must have the delete permission for that workstation.
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Working With Tenants
Tenants let you ‘divide’ your panel into multiple
groups, so that only parts of the panel are
visible to each group. For example, a shopping
centre might have ten retailers. Rather than
installing one panel per retailer, a single panel
can be used. To prevent retailer A from
tampering with retailer B’s security
configuration, tenants are created so that each
retailer can only ‘see’ their own users, doors,
areas and review.
Tenancy Rules Explained
Tenancy rules can be switched on or
off. If tenancy rules are off, then all operators can see all items, subject to the
permission rules defined for each operator type (see page 109).
Only the installer operator can turn tenancy rules on or off.
Turning tenancy rules off erases any existing tenancies. All items and operators
become ‘untenanted’.
Only the installer operator can create or delete tenancies.
Only the installer and administrators can modify existing tenancies.
If an item (like a door or an area) isn’t placed in a tenancy, it is visible to all tenants
(subject to the permission rules for each operator type).
Once an item is assigned to a tenancy, it is only visible to installer, all administrators
and any operators in that tenancy.
An item can belong to more than one tenancy.
Operators can belong to multiple tenancies. Operators can ‘see’ any item that belongs
to any of their tenancies - provided, of course, that the operator has the appropriate
permissions (see page 109).
Operators cannot see review entries if any part of the review message is out of their
tenancy.
Warning
Insight Card Pool ignores tenancy rules. Operators will be able to see the names of cardholders
in other tenancies.



How Tenancy Affects Review
Review messages are visible to the tenants that are common to all items in the review
message. In other words, only operators who can see all of the items in a message can
see the message.
Changing an items tenancy after a review message has been created has no effect on
the review message.
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To enable Insight tenancy rules:
1. You must log in to Insight Operators as installer.
2. Click tenants.
3. Click the “turn tenancy on” button (above the browser
pane).
4. Click ‘Yes’ on the warning screen that appears.
5. Restart the server by logging on to any Insight module.



Warning
Turning on tenancy rules stops the Insight server. All operators will be disconnected.

To disable Insight tenancy rules:
1.
2.
3.
4.
5.

You must log in to Insight Operators as installer.
Click tenants.
Click the “turn tenancy off” button.
Click ‘Yes’ on the warning screen that appears.
Restart the server by logging on to any Insight module.




Warning
Turning off tenancy will remove all items from any tenancies, then delete the tenants. Turning
tenancy rules back on will not restore the deleted tenants.

Warning
Turning off tenancy rules stops the Insight server. All operators will be disconnected.

To create a new tenancy:
1.
2.
3.
4.
5.

You must log in to Insight Operators as installer.
Click tenants.
Click the “New” button.
Enter a name for the new tenant.
Click OK.

To delete an existing tenancy:
1.
2.
3.
4.
5.

You must log in to Insight Operators as installer.
Click tenants.
Select the tenant you want to delete.
Click the “Delete” button.
Click “Yes” on the warning screen that appears.



Note
When a tenant is deleted, any items belonging to that tenancy are removed from the tenancy. If
an item belonged only to that tenancy, then it becomes visible to all remaining tenants.
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To add an operator to a tenancy:
1.
2.
3.
4.
5.

You must log in to Insight Operators as installer or an administrator.
Click operators.
Double-click the operator you wish to modify.
Click tenancies.
Tick the tenancies you want the operator to be a member of.

To remove an operator from a tenancy:
1.
2.
3.
4.
6.

You must log in to Insight Operators as installer or an administrator.
Click operators.
Double-click the operator you wish to modify.
Click tenancies.
Uncheck the tenancies you want to remove the operator from.

To assign an item to one or more tenancies:
1. You must log in to Insight Operators as installer or an administrator.
2. Click tenant.
3. Double-click any tenancy in the browser pane. (If there aren’t any tenancies defined,
you will need to create one first.)
4. Click members.
5. Locate the item in the items tree. Panel items are in the sites branch. Review filters are
in the review branch. Operators and workstations are in the security branch.
6. Right-click the item, and choose “see all tenancies…” in the menu that appears.
7. Tick the tenancy or tenancies that the item should belong to.
8. Click OK. The item will become invisible except to operators sharing one or more
common tenancy.

To make an item visible to all tenancies:
1. You must log in to Insight Operators as installer or an administrator.
2. Click tenant.
3. Double-click any tenancy in the browser pane. (If there aren’t any tenancies defined,
then the item is already visible to all tenants, subject to Operator Type permissions.)
4. Click members.
5. Locate the item in the items tree. Panel items are in the sites branch. Review filters are
in the review branch. Operators and workstations are in the security branch.
6. Right-click the item, and choose “see all tenancies…” in the menu that appears.
7. Uncheck all the boxes in the “belongs to” window.
8. Click OK.



Note
This method always works if you are logged on as installer. It will work for administrators,
provided the administrator can ‘see’ all the tenancies that the item has. If there are additional
tenancies that the administrator cannot see, then the item will remain in those tenancies and
hence won’t become visible.



Tip
Items are visible to all tenancies by default. You only need follow this procedure to remove an
item from all tenancies if you had previously assigned it to one.
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To see which items belong to a tenancy:
1.
2.
3.
4.
5.

You must log in to Insight Operators as installer or an administrator.
Click tenant.
Double-click the tenancy in the browser pane.
Click members.
Items that are ticked in the tree belong to that tenancy.



Tip
The tenancy count shows how many tenancies an item belongs to. If the tenancy count is zero,
the item is visible to all tenancies.
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Insight Schematic
Insight Schematic allows operators to monitor the status of an installation via an intuitive
interface based around graphical floor plans and site maps. Special icons can be placed on
each map that show the status of hardware items (such as inputs, areas and auxiliaries) in real
time.
Use Insight Schematic to:
Import site plans
Browse drill-downs
Add areas, auxiliaries, inputs, doors, floors and modules to plans
Monitor site activity in real time
View and acknowledge alarms
Control your Inner Range security system

Schematic Toolbar

Map

Map Edit Toolbar

Alarm Group

Insight Toolbar

Area

Map Item (Door)

The Insight Toolbar lets you manage your sites and panels (page 17).
The map lets you add elements to your map, and to monitor and control these elements
in real time (page 118).
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Working With Maps
To use Insight Schematic, you must first import a map of
your site or buildings.



Note
You cannot create map images with Insight Schematic.
You must create or scan your map with other software,
then import the image file into Schematic.
To import a map:
1. In the Insight Toolbar, click on the site that will
contain the new map. If necessary, create a new
master site or sub-site.
2. Choose “New...” (formerly ”Import Graphic…”) from the Map menu. Alternatively, right
click the site and select “New Schematic Map..” from the context menu.
3. Navigate to the image file you wish to import
4. Click Open.
The map is added to the selected site.






Tip
Several sample maps are installed with Insight, which can be used to familiarise yourself with
Schematic. Navigate to the location where you installed Insight, then look in the “Sample Maps”
directory.
Tip
You can change the scale of a map that you have imported. Select “Zoom…” from the Map
menu or use the Zoom combo box on the Edit toolbar.

Tip
Once a graphic is imported, you can delete or move the original file. Insight stores its own copy
of the image.

Tip
Schematic can open files in the following formats: BMP (Bitmap), JPEG (Joint Photographic
Expert Group), PNG (Portable Network Graphics) and TIF (Tagged Image Format). Pictures in
other formats (including AutoCAD DWG files) must be converted into one of these formats prior
to importing.
To edit a map.
From the Insight toolbar: Double-click the map in the Insight Toolbar to display it. Right-click on
the map to “Show” the map on the screen, “Delete” the map, or edit the map “Properties..”
including name, text format, grid resolution and icon size.
From the “Map” menu: Once a map is shown on the screen, the “Map” menu can be used to
“Delete” the map, “Zoom...” the map to the required size or edit the map “Properties..” including
name, text format, grid resolution and icon size.
e.g. To rename a map:
1. In the Insight Toolbar, right-click the map you wish to rename and choose
“Properties…” in the menu that appears.
2. Enter the new map name.
3. Click OK.
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Operator Permissions
To import a map, you must have the create permission for maps. To delete a map, you must
have the delete permission for that map. To rename a map, you must have the change
permission for that map.



Adding Labels
You can add text labels to your maps. To add labels:
Ensure you are in Edit Mode (select “Edit Mode” from the File menu).
In the Insight Toolbar, click the map you want to add the Label to.
Select the Label tool ( ).
Click on the map where you want to place the label.
Enter the text of your label. The text format (font, style, size and alignment) can also be
edited by selecting the “Text Format” tab.
6. Click OK.
Note that a Label can also be used as a Map Link. See “Creating Drill-Downs” for details.
1.
2.
3.
4.
5.

Adding Alarm Groups
Alarm Groups let you monitor alarms from many sources and display them at a single point on
your map.
To add an Alarm Group to your map:
Ensure you are in Edit Mode (select “Edit Mode” from the File menu).
In the Insight Toolbar, click the map you want to add the Alarm Group to.
Select the Alarm Group tool ( ).
Click the map where you want to place the Alarm Group.
In the Alarm Group properties window, enter a name for the Alarm Group.
In the Site Tree, tick the inputs that you want to add to the Alarm Group.
You can use the “Text Format” tab to edit the font, style, size and alignment of the
Alarm Group name.
8. Click OK.
1.
2.
3.
4.
5.
6.
7.

Working With Surveillance Items
Surveillance items correspond to hardware detectors and devices in your Inner Range system,
and fall into one of two categories.
 Point items occupy a single point on the map. These items are usually doors,
auxiliaries, input devices such as door/window reed switches and the like.
 Area items occupy shaped regions on the map. These items are usually Inner Range
areas, or input sensor devices such as motion detectors or perimeter beams.

Adding Surveillance Items
You can monitor the status of your installation by adding surveillance items to your maps.
To add point surveillance items:
1. Ensure you are in Edit Mode (select “Edit Mode” from the File menu).
2. In the Insight Toolbar, expand the Site Tree until you reach the item you wish to
monitor.
3. Click the item with the left mouse button, but do no release the button.
4. With the button held down, drag the item onto your map and release the button.
5. The Item Properties dialogue opens to allow the text format and other relevant
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parameters to be edited if required. Make any changes necessary, then click OK.
(While in edit mode, the item properties can be accessed at any time to view &/or edit
by right-clicking on the item.)
6. If necessary, you can fine-tune the placement of the item with the mouse or arrow keys;
and the size of the icon by dragging one of the resizing handles on the corners.
To add area surveillance items:
1. Ensure you are in Edit Mode (select “Edit Mode” from the File menu).
2. If you are placing an area, select the Area tool ( ). If you are placing a zone input,
select the Zone Area tool ( ).
3. Draw the area by clicking on the map. Hold the CTRL key down if you wish to draw
angled lines.
4. To finish the shape, either double-click the mouse button, or click on the first point of the
shape.
5. The Item Properties dialogue opens to allow the relevant item (e.g. Area, Zone Input) to
be assigned to the shape. You must select an item before you can proceed. The
Properties dialogue also allows the text format and other relevant parameters to be
edited if required. Make any changes necessary, then click OK. (While in edit mode,
the item properties can be accessed at any time to view &/or edit by right-clicking on the
shape.)
6. If necessary, you can fine-tune the shape by dragging the resizing handles on the
corners of the image. You can also fine-tune the placement of the shape with the
mouse or arrow keys. New corners can be added to the shape by clicking and dragging
the mouse from anywhere along an existing side of the shape. To remove a corner from
a shape, right-click the desired corner and select ‘Delete Vertex’ from the context menu.








Tip
You can place the same item more than once, either on the same map or different maps.

Tip
You can see which items have been placed on maps via the Map Items window. Select “Map
Items Window” from the View menu.

Tip
You can jump straight to a placed item on any map. Choose “Go To” from the Edit menu.

Tip
You can choose between the two default icon sizes. In the Insight Toolbar, right-click the map
and choose “Properties…” from the menu that appears. Click the Appearance tab, then choose
the icon size you prefer. All icons can also be sized individually.
Tip
When an item is placed, a text caption appears with the item. You can change the position of
the caption, or hide it completely. Right-click the item and choose “Caption” from the menu that
appears.
Tip
When you place items, they are aligned to a “snap” grid. You can change the size of the snap
grid - choose “Preferences…” from the Edit menu. You can disable grid snap - uncheck “Snap
To Grid” in the Edit Menu. You can hide the snap grid - click the “show/hide snap grid” button in
the Schematic Toolbar.
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Operator Permissions
To add, move or delete surveillance items from maps, you must have the change permission on
that map.



Working with Icons
The Insight Schematic image library contains a range of ready-made icons for use with point
items on the Schematic maps. For each category of items (Auxiliaries, Cameras, Doors, Lift
Floors, Inputs, Modules and PTZ Camera Presets) a range of icons are available to illustrate the
different types of item. e.g. The “Doors” category provides different icons for Boom Gates,
Roller Doors, Sliding Doors and Standard Doors.
In the relevant categories such as Auxiliaries, Doors and Inputs, a variation of each icon is
provided for each of the different item states. e.g. The Auxiliaries category has different icons
for Off and On for each type of Auxiliary.
New icons can be added, and existing icons can be edited, by opening the image library while in
edit mode. You cannot create icons with Insight Schematic. You must create or scan your icon
image with other software, then import the image file into Schematic as described below.

Changing an icon.
The icon for a specific point surveillance item can be changed by right-clicking on the item and
selecting “Icon Library” from the context menu.

Adding or editing an icon.
1. Open the image library by selecting “Image
Library” from the Edit menu , or by clicking on
the “Image Library” icon in the “Map Edit”
toolbar.
2. If adding a new icon,
click in the empty
name cell in the
bottom row. This will
create a new row in
the table for this icon.
If editing the name of
an existing icon, click
in the name cell for
the icon name you
wish to change.
3. Type in the new name
or the changes.
4. If adding a new icon,
click in an empty
image cell for the icon
state you wish to add.
If changing the image
for an existing icon,
click on the icon.
5. Click on the browse
button that appears
and navigate to the
image file that you wish to use. The file must have a gif, jpg, jpeg, bmp or png
extension. Select the file and click “Open”.
6. Repeat step 5 for any additional icons that need to be added or changed.
7. From the “Actions” menu, select “Save Changes”, or if your editing session is complete,
select “Save Changes and Close”.
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Understanding Surveillance Item Status
Insight conveys the status of surveillance items through the use of colour.
Sample

Type

Colour

Meaning

Description

Input

Green

Sealed

The input is in a sealed state.

Input

Red

Alarm

The input is in an alarm state.

Input

Orange

Tamper

The input is in a tamper state.

Auxiliary

Blue

On

The auxiliary is on.

Auxiliary

Grey

Off

The auxiliary is off.

The following symbols may be drawn on top of surveillance items to convey additional
information.
Sample

Type

Meaning

Description

Input

Isolated

The input is isolated.

Auxiliary

Override

The auxiliary is in an override state, and cannot be turned
on or off until the override is ended.

Auxiliary

Not Present

The module containing the auxiliary is not present on the
LAN.

The status of areas and zone areas is displayed using different colours.

Assigned
Unassigned

Edit Mode

Zone Areas
Assigned
Unassigned

Panel Offline

Panel Offline

Subscription Error

Subscription Error

On
Off
Alarm
Tamper

Surveillance Mode

Surveillance Mode

Edit Mode

Areas

Sealed
In Alarm

(fast flash)

In Tamper

(fast flash)

Had Alarm/Tamper

(slow flash)
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Adding Cameras
You can drag a DVR camera onto your map.
To add a camera to a map:
1. Locate the camera in the Insight Toolbar by expanding the associated DVR.
2. Drag and drop the camera onto your floor plan.
Once a camera is placed on a map, you can view live video from the camera in schematic.
To view live video from a camera in schematic:
1. Switch to surveillance mode
2. Right-click the camera and choose “Show Video” in the menu that appears.




Tip
If the camera is a PTZ-enabled model, a PTZ toolbar will be incorporated into the video window.

Note
You can only view live video in schematic. To view historical footage, you must use Insight
Review. See page 144.

Adding Camera Presets
You can drag camera presets for PTZ cameras onto your map.
To add a PTZ camera preset to your map:
1. Locate the PTZ camera preset in the Insight Toolbar by expanding the associated
camera.
2. Drag and drop the preset onto your map. A link is shown to the associated camera.

To activate a preset on your map:
1. Double-click the preset. The PTZ camera will adjust its pan, tilt, zoom and iris to match
the preset.



Paid Feature
Adding cameras and camera presets requires a DVR integration licence. Contact your Inner
Range distributor for more information.
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Creating Drill-Downs
With drill downs, you can create maps that link to other maps. For example, a site diagram
could have clickable buildings that open more detailed interior schematics, or clicking a stairwell
could jump to the next floor in an office building. You can create drill-downs quickly and easily in
Insight Schematic.
To create a drill-down:
1. Ensure you are in Edit Mode (select “Edit Mode” from the File menu).
2. If you will be drilling to a different map, ensure that the map has already been imported
into Schematic.
3. Select the Map Link tool ( ).
4. Trace the outline of your drill-down by clicking on the map. The shape you draw will be
the shape that triggers the drill-down. Hold the CTRL key down if you wish to draw
angled lines.
5. To finish the shape, either double-click the mouse button, or click on the first point of the
shape.
6. The Map Link properties page allows the entry or selection of the target for a link. This
can be specified as map coordinates or as a map item. When a map item is selected
as the link target, the map link can reflect the status of the target item in surveillance
mode.



Tip
In Surveillance Mode, you can follow a drill-down by clicking twice. In Edit Mode, you can follow
a drill-down by right-clicking and choosing “Follow Link” in the menu that appears.

Working In Surveillance Mode
Insight Schematic starts monitoring the status of all surveillance items when you activate
Surveillance Mode. You can also control items directly from your floor plan.
To activate surveillance mode:
1. Select “Surveillance Mode” from the File menu.
In a few moments, the state of all surveillance items is updated.



Note
Insight Schematic cannot monitor the status of panels that are not connected. Schematic places
a cross over all point surveillance items that belong to offline panels, and draws all area
surveillance items a dim grey colour.
Alarm Processing
Schematic has a simple alarm reporting and clearing mechanism. Items that go into an alarm or
tamper state flash and change colour.
 Point surveillance items go red for alarm and orange for tamper; in addition, the text “in
alarm” flashes while the alarm is active, and “had alarm” if the alarm condition has
passed.
 Area surveillance items go red when in alarm, and orange when in tamper; in addition,
the flashing speed halves when the alarm condition has passed.

Alarms will continue to flash, even after the condition that caused the alarm ends. You must
clear alarms from Insight Schematic manually. Alternatively, an alarm or zone map item can be
configured to ‘Automatically Acknowledge’ alarm states and the map item will automatically
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return to the sealed state when the physical input is resealed.
To clear alarms:
1. Right click the item that is in alarm and choose “Clear” from the menu that appears.
The alarm is cleared.







Note
If Schematic is open on more than one workstation then the alarms must be cleared on each
workstation.

Note
Clearing alarms in Insight Schematic does not acknowledge the alarms at the panel. You must
still acknowledge alarms from a Terminal.

Note
Insight Schematic alarms are not related to advanced alarm management in Insight Review.
Clearing alarms in Insight Schematic does not acknowledge alarms in Insight Review.

Note
Insight Schematic must be running when Area alarm events occur, or they will not appear in
Schematic. All other alarm events will be displayed even if they occurred before Insight
Schematic was opened, provided the alarms are still active.
Tip
If a zone input exists in multiple areas, you can choose to only show alarms on the floor plan
when an alarm occurs in one designated area. Right click the zone or zone area and choose
“Area Monitored” in the menu that appears, then choose the area you want to monitor, or
choose “All Areas” to restore normal behaviour.

Controlling Items Within Schematic
You can control field hardware directly from your maps in Schematic including doors, areas,
auxiliaries, home auxiliaries and inputs.
To control an item on a floor plan:
1. Make sure you’re in surveillance mode (File Surveillance Mode)
2. Right-click the item, and choose a command from the menu that appears.



Operator Permissions
To control an item, you must have the control permission on that item.
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Insight Server Tool
The Insight Server Tool lets you perform advanced server tasks.
Use the Insight Server Tool to:
Manually start or stop Insight Server
See who is connected to Insight Server
Disconnect clients who are connected
Configure your modem pool

Insight Server Tool

Starting and Stopping Insight Server
Insight Server normally starts automatically. Insight Installer starts its own internal server when
the operator logs on. Insight Professional starts the server as soon as Windows has loaded
(but before anyone has logged in).
Insight Server is running and accepting client connections.
Insight Server is running, but no connections will be accepted.
Insight Server is stopped. The server will start again if an operator tries to log
on.
To stop Insight Server:
1. Right click the Insight Server Tool and choose “Stop Database” in the menu that
appears.




Note
Stopping the server can take up to one minute.

Warning
If you stop Insight Server, all operators will be forcibly disconnected. All panels will also be
disconnected, and review and alarms will not be received until the panels are reconnected.

To start Insight Server:
1. Right-click the Insight Server Tool and choose “Start Database” in the menu that
appears.



Note
Starting the server can take up to one minute.
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Note
To start the Insight Professional server, the red lamp must be illuminating on the hardware lock,
which must be plugged into a USB port on the server computer.

Viewing Client Connections
You can see which operators are connected to
Insight Server. You can also block connections,
so operators can no longer log on.
To view client connections:
1. Right-click the Insight Server Tool, and
choose “Client Connections…” in the
menu that appears.

To disconnect an operator:
1. Right-click the Insight Server Tool, and choose “Client Connections…” in the menu that
appears.
2. Select the session that you wish to disconnect.
3. Click Stop.
4. In the Module Shutdown window, enter a message that will be displayed on the
Operator’s workstation and also specify how long the message will appear before the
session is terminated.
5. Click OK.

To block new connections:
1. Right-click the Insight Server Tool, and choose “Client Connections…” in the menu that
appears.
2. Tick the “Block new connections” checkbox.
New connections will not be accepted. Note that sessions that have already been established
are not affected.

Configuring Your Modem Pool
You can choose which modems on the server computer are available for incoming and outgoing
Insight connections. See Modem Blocking on page 32.
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Insight Photo ID
Insight Photo ID allows you to design ID card templates and print identification tags and badges
for Users (employees, contractors, visitors, etc.)
In Insight V4, this module has undergone a significant upgrade. The main changes are as
follows:
All new Photo-ID card designer.
Rotation and cropping of images, as they are acquired (either from a camera or a file).
Support for double sided cards.
Barcode support.
Association rules allow new users to automatically use the correct card template based
on user-type, department, etc.
Use Insight Photo ID to:
Design one or more ID card templates (styles and layouts) for your organisation.
Print ID cards using these templates.

Toolbars

Properties Window

Card design
Thumbnails

Photo Field

Workspace
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Text/
Database
Fields

Underlying Concepts
Printing ID cards is a two step process. First, you must design a card template (layout). The
card template lets you choose how the ID card will look.
Photo ID provides simple tools which allow you to design card templates by inserting the
required graphics and fields into the card design and defining what fonts and colours will be
used.
You can create and save as many different card templates as you like, each with a different
layout. Templates may include images, simple graphics, text and user database information
such as user names, company details and photos.
Once a template has been created, it can be used to print a batch of ID cards. To print cards,
you first select the users who will be issued with the cards, then issue the print command.
The Photo ID Toolbars let you quickly customise and print ID badges.
The field elements define how your ID badge looks and prints.



Paid Feature
Photo ID is a separately licensed add-on to Insight Professional.

Toolbars
Photo ID provides quick access toolbars, in addition to drop-down menus, that will cover most of
the actions required to design a card template. The toolbars can be custom arranged by
clicking on the four dots to the left of each toolbar and dragging them to your preferred position.
General Photo ID Toolbar
Changes the view from Design mode to Print mode.
Changes the view from Print mode to Design mode.
Creates a new card template.
Save changes to the currently selected card template.
Print one or more ID badges based on the current template.
Cut the selected item/s.
Copy the selected item/s.
Paste the previously copied or cut item/s.
Zoom out to reduce the viewing size of the card.
Zoom in to increase the viewing size of the card.
Zoom page fit: Adjust the viewing size of the card to fit the screen.

Insert Toolbar
Add an image to the card template.
Add a photograph from the User database.
Add a text/database field.
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Inserts a barcode
Inserts a single straight line
Inserts a rectangle
Inserts a circle or ellipse
Layer Arrange toolbar
Bring the selected items to the front
Move the selected items to the back
Bring the selected items forward
Move the selected items backward
Item Align and Sizing toolbar
Left align the selected items
Horizontally Centre the selected items
Right align the selected items
Top Align the selected items
Vertically Centre the selected items
Bottom Align the selected items
Make the width of the selected items the same
Make the height of the selected items the same
Make both the height and the width of the selected items the same
Make the horizontal spacing between the selected items the same
Make the vertical spacing between the selected items the same

Working With Card Templates
With Insight Photo ID you can add, remove and modify card templates. A card template stores
the layout of an ID card including any text, images or watermarks that appear on the card.
To create a new a card template:
1. Choose “New Card” from the Card menu, or press the New Card button on the Photo ID
toolbar ( ).
2. In the Properties window, specify a name for the template, select whether the card is
single-sided or double-sided and specify the size of the card.
3. Edit and save the template.



Tip
To create a new template based on an existing card layout, select the existing template from the
Card Designs window, (or the Workspace tab if the template has already been opened) and
select “Save as new Card” from the Card menu.
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To delete a card template:
1. Select the template from the Card Designs window.
2. Click the “Delete” button at the top of the window, or right-click on the template and
select “Delete”.
3. A “Delete Card” confirmation message will appear.
4. Read the message to confirm which template is to be deleted, then click on Yes to
delete the template, or click on No if the wrong template was selected.




Warning
Deleting a template is permanent. You cannot restore a deleted template.

Tip
Deleting a template does not delete the employees that are using that ID badge.

To modify an existing template:
1. Double-click on the template you wish to edit from the Card Designs window,
2. or, Select the template you wish to edit from the Card Designs window and click on the
Open button on the toolbar ( ).
3. You can now modify the template.

Designing Card Templates
Card templates are made up of any combination of text (custom static text and/or database
fields), images, vector graphics and user photographs. Custom text, images and graphics are
the same on every card in a batch. They form the “layout” of the card. Database fields and
photographs are different for each employee. They form the “information” on the card.
To add text to a template:
1.
2.
3.
4.
5.
6.
7.

Select the template you want to work with, or create a new template.
Click the “Add Text Field” button in the toolbar ( ).
Click and drag the mouse in a rectangle shape where you want the text to appear.
In the window that appears, enter the text that you want to place on your card.
Click the “Font” button, and specify a font (typeface), size and colour for the text.
Specify any other attributes for your text, such as alignment and orientation.
Click OK. When cards are printed, the text you entered will appear on every card.





Note
You must specify a font every time you add text to a card.

Tip
If the text is “chopped off”, then you need to increase the size of the text rectangle. With the
selection tool ( ), click the text on your card layout and drag the selection handles to make the
rectangle bigger.
Tip

To change the text, font or colour, double click the text with the selection tool ( ).
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Tip
To create vertical text, tick the “Rotate text 90?” box in the text properties window.

To add images to a template:
1. Select the template you want to work with, or create a new template.
2. Click the “Add Image Field” button in the toolbar ( ).
3. Click and drag the mouse in a rectangle shape where you want the image to appear.
You can resize the image later if you want.
4. In the window that appears, click the browse button (
) and navigate to the image.
5. Click OK. When cards are printed, the image you placed will appear on every card.




Tip
To change the size of an image, click on it once, then drag one of the selection handles that
appear around the image.

Tip
To rotate an image, tick the “Rotate Image 90?” box in the image properties window.

To add database fields to a template:
1.
2.
3.
4.
5.
6.
7.






Select the template you want to work with, or create a new template.
Click the “Add Database Field” button in the toolbar ( ).
Click and drag the mouse in a rectangle shape where you want the text to appear.
In the window that appears, choose the database field that you want.
Click the “Font” button, and specify a font (typeface), size and colour for the text.
Specify any other attributes for your text, such as alignment and orientation.
Click OK. When cards are printed, the information for each employee will replace the
field.

Note
You must specify a font every time you add a database field to a card.

Tip

To change the font or colour, double click the database field with the selection tool ( ).

Tip
To create vertical text, tick the “Rotate text 90?” box in the text properties window.

Tip
To place a barcode on your ID card, use a barcode font such as “3of9.ttf”. Remember that
barcode readers expect an asterisk as the first and last character in a barcode.

132

To add employee photographs to a template:
1. Select the template you want to work with, or create a new template.
2. Click the “Add Photograph Field” button in the toolbar ( ).
3. Click and drag the mouse in a rectangle shape where you want the photograph to
appear. You can resize the photograph later if you want.
4. If you want a border around the image, tick the “border around photograph” box.
5. If you want to rotate the photograph 90 degrees clockwise, tick the “rotate photograph
90” box.
6. Click OK. When the card is printed, the employee photograph will appear on the card.




Note
You must assign a photograph to an employee with Insight Edit before it will print on their ID
card. See page 60.

Tip
To quickly add text, images or database fields to a card layout, select “Manage Fields” from the
Define Photo ID menu, or click the field management button ( ) in the toolbar.

Editing Card Templates
You can make changes to existing card templates with Insight Photo ID.
To move text, images, database fields or photos:
1.
2.
3.
4.

Select the template you want to work with, or create a new template.
Make sure the selection tool ( ) is selected by clicking it in the toolbar.
Click the text, field or image you wish to move. Selection handles appear on the item.
Click the item again and drag it to a new location.




Tip
If you can’t select an item because it is ‘underneath’ another item, then move the top item out of
the way, or right click the top item and choose “make last” in the menu that appears.

Tip
You can make fine adjustments to the location of an item by tapping the arrow keys on your
keyboard while the item is selected.

To resize text, images, database fields or photos:
1. Select the template you want to work with, or create a new template.
2. Make sure the selection tool ( ) is selected by clicking it in the toolbar.
3. Click the text, field or image you wish to resize. Selection handles appear around the
item.
4. Click one of the selection handles and drag it to a new location.

To edit the properties of an item:
1. Select the template you want to work with, or create a new template.
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2. Make sure the selection tool ( ) is selected by clicking it in the toolbar.
3. Double-click the text field or image you wish to edit.

Printing Cards
Photo ID allows you to print single or multiple cards to different types of outputs. Part of the
printing process can be automated using card associations (see Print Using Card Associations
for details).
To switch Photo ID to Print Mode, click the print mode icon (
View drop-down menu.

) or select Print Mode under the

Print mode allows you to preview card designs for particular users in available panels.
To preview a user, select a panel, then click the name of a user within that panel. You can
preview other card designs by double clicking a card from within the card window.
The User window displays all programmed users for the selected panel. You can tick the box
next to each user for whom you wish to print a card. This window can be customized by adding
or removing the user fields you wish to view.
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Right click on the field header and check or uncheck the appropriate fields.

Print Toolbar
The print toolbar offers a quick, easy way of making final adjustments to the user photo.
Returns you to design mode.
Print a card/multiple cards according to the current print setup.
Crop the photo while previewing a particular user.
Zoom in or out of the user photo.
Reset the photo to it's original state.

Print Setup
Before you begin printing, open the Print Setup window from the Card drop-down menu to setup
your printing options.
To print onto cards, you must have a printer capable of accepting cards.
You can print to paper of any available size to your installed printers. Select the paper size,
source and resolution which most suits your needs.
Orientation allows you to select either Portrait or Landscape orientation (be aware that your card
design must be appropriate to the orientation chosen).
File section gives options for outputting to a file (see Print output section).
You have the option to choose which side/s of the card to print. To print both sides you will need
a compatible printer.
Print range will print either the Current selected user and card design or the full Selection of
users which have been checked in the user list of your panel.
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Print Output
PhotoID offers two different outputs via the print
setup window, Printer Output or File Output.
To output to a printer
1. Open the print setup window.
2. 2. Select the appropriate printer you have
already installed on your system by clicking
the browse button
under the Printer
section.
To output to a file
1. Check the “Print to file” box. Once selected,
the Printer section will be greyed out and
you will be shown options for the file output.
2. Select the folder destination in which you
wish to save the file.
3. Select the resolution and file type and click
OK.
Once you have completed your setup, click the print icon

or select Print from the Card menu.

Print Using Card Associations
PhotoID allows you to easily print cards for multiple users by using card associations (see Card
Association section below for details).
After selecting all of the users for whom you wish to print cards, open the print setup window by
selecting Print Setup under the Card menu.
Within the Print range section check the Selection option, then tick the “Use Card Associations”
box. This will print cards for all selected users on card designs specified in your card
association setup.
Once you have completed your setup, click the print icon

or select Print from the Card menu.

Card associations
Card Associations is a powerful tool which allows you to associate a chosen card template with
a particular piece of user information (e.g. user type or extended user data) which is stored in
the database.
This association can then be used to automatically print cards using the same template for
multiple users that share the common field, and to automatically select that template when
printing a card for a particular user.
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1. Select card association from the
Card drop-down menu and click the
New icon
2. Right click in the Card box to choose
the appropriate card design.
3. Under the Name column, choose the
user profile field you would like to
associate to that card design.
4. Double click in the Value box to type
in the common value for that user
field. This will be compared to
database values using a text
compare function, and is not case
sensitive (e.g. sales matches Sales).
This example shows that all users who work
in the Research and Development
department, will have a blue card printed and
all users who work in the Sales department,
will have a green card printed.

Insight does allow for non-mutually exclusive card associations. For instance in the above case,
we could have a third card that was printed for anybody whose User Type was set to
"Manager". In this case the card templates are prioritised from top to bottom, so the Research
and Development Manager would get a Research and Development card, not a Manager card.



Tip
To select a range of adjacent employees, click the first employee, hold down the shift key, then
click the second employee. To select non-adjacent employees, hold down the Ctrl key, then
click the employees you want.
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Insight DVR Integration
Insight DVR Integration allows operators to control Digital Video Recorders and cameras within
Insight, including the ability to view live and historical video feeds.
Use Insight DVR Integration to:
Attach DVRs and cameras to Insight
View live and historical video feeds directly in the Insight workspace
Remotely control PTZ cameras
Access recorded video information based on review events
Switch cameras and video feeds based on custom real-time triggers

Selected Camera Feed
(yellow border)

Camera
Feeds
Insight
Toolbar

DVR
Control Bar

Camera
Pan/Tilt

Camera
Zoom/Focus/Iris

Timeline
Controls

Playback
Controls

Layout
Controls

The Insight Toolbar lets you open video feeds and send control commands
The camera pan/tilt and zoom/focus/iris controls let you control PTZ cameras
The timeline controls let you locate previously recorded footage
The playback controls let you switch between live view and recorded playback modes
The layout controls let you arrange your video feeds and OSD (on-screen display)



Paid Feature
Insight DVR integration must be licensed separately. Insight DVR integration requires Insight
Professional.
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About Insight DVR Integration
Insight provides true integration with an ever expanding range of Digital Video Recorders. You
can choose to view live and recorded camera images directly within Insight. You can control
PTZ cameras including pan, tilt, zoom and iris. You can also issue commands directly to
cameras and DVRs.

DVR Plugins installer.
Insight DVR Integration is constantly being updated to add new DVR models to the range of
DVRs supported by Insight. New DVR models added since Insight version 3.2 release are no
longer automatically installed with an Insight installation or upgrade.
To add support for new DVR models, you need to run the Insight DVR Plugins installer program
separately on both the server and all client PCs requiring DVR services.
This installer first runs a setup wizard which lists the models available and allows you to select
the specific DVR model/s that your system is required to support.
To add a DVR (quick guide):
1. Check the list of supported DVRs on the Inner Range web page to make sure your
model is supported. If necessary, run the DVR Plugins installer to add DVRs that have
been added to the range of supported products since Insight V3.2.
2. Set up the DVR and cameras according to the documentation that came with your DVR.
3. Enrol the DVR into Insight (page 140).
4. If you are using Insight Schematic, you can drag cameras and camera presets onto
your building floor plans (page 122).
5. If you are using Insight to manage alarms, you can customise your alarm responses to
display camera footage (page 99).
6. If you are using a dedicated monitor or hardware multiplexer, you can use Insight to
remotely control the DVR whilst watching video feeds on your monitor (page 146).
7. You can view video feeds and remotely control cameras directly in Insight (page 141).

Enrolling A New DVR
You must enrol a new DVR into Insight before you can control cameras or view video feeds.
To enrol a new DVR:
1. Start any Insight module that uses the Insight Toolbar (Edit, Review or Schematic).
2. In the Insight Toolbar, make sure the Browser tab is selected.
3. Decide which site you want to attach the DVR to, or create a new site if necessary. (The
decision of which site is unimportant, since it has no affect on DVR integration.)
4. Right click the site that will contain the DVR, and choose “New Digital Video
Recorder…” in the menu that appears. (Note: requires a licence.) The DVR wizard
appears.
5. Follow the on-screen prompts. The enrolment procedure varies slightly between brands
and models. This is because there is no industry standard governing DVR design and
manufacture. You will probably need to refer to the documentation that came with your
DVR.
Note: the MCI interface is the interface used to issue commands to the DVR. The
video streaming interface is the interface used to view camera feeds in Insight. You
can choose not to configure the video streaming interface, but the MCI interface is
necessary to interface with the DVR.
6. On the Cameras page, specify the type and number of cameras connected to the DVR.
(For some models, this is populated automatically.)
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The name can be any name that meaningfully identifies the camera.
To set the camera type (Fixed or PTZ), click the entry twice.
The camera number should match the camera number assigned by the DVR
software.
7. On the DVR Associations page, specify the area and/or other panel item/s that you wish
to associate with each camera. Insight V3.3 or later now allows a camera to be linked
to multiple panel items, no longer just an area.
The camera can be associated with one or more panel items. e.g. Areas, Doors,
Lift Cars, Inputs, etc.
Right-clicking a Review Event in Insight Review that contains the item, allows you
to jump directly to the historical footage from that camera beginning at the date/time
of the Review Event.

Depending on the specific model of DVR you can then use the playback controls to
rewind, fast forward, etc. from that point.

To un-enrol a DVR:
1. Start any Insight module that uses the Insight Toolbar (Edit, Review or Schematic).
2. In the Insight Toolbar, make sure the Browser tab is selected.
3. Right click the DVR, and choose “Delete” in the menu that appears.
To edit DVR settings including configured cameras:
1. Start any Insight module that uses the Insight Toolbar (Edit, Review or Schematic).
2. In the Insight Toolbar, make sure the Browser tab is selected.
3. Right click the DVR, and choose “Properties…” in the menu that appears.



Note
If you add, remove or reassign cameras with your DVR software, you must update the DVR
properties in Insight.

Working With Video Windows
To see camera footage, you have to open a video window (also called a software video
multiplexer). When video windows are created, they show the footage from one camera (either
live or historical). You can change the layout of a video window to show more than one camera.
Regardless of how many cameras are being displayed, the time line of the video window is
always synchronised. This means that the view from each camera will always show images
from the same time period. If you rewind to a particular date and time, then the video window
will show what each camera recorded at that time. If you switch to live footage, then each
camera in the video window will show live footage.
You can open multiple video windows. Each video window can have multiple cameras. Each
video window has its own time line, so you can (for example) show live camera feeds in one
window and historical feeds (of the same or different cameras) in another window.
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To open a new video window:
1. In Insight Review, select the Control tab of the
Insight Toolbar.
2. Right click a video camera in the tree, and
choose “Show Video” in the menu that appears.
A new video window is opened.



Tip
You can add additional cameras to the window. See
working with layouts on page 145.



Tip
You can switch to a different camera without creating a new video window. Simply drag the new
camera from the Insight Toolbar and drop it onto the video window.

To assign cameras to a video window:
1. Click the video window you want to add cameras to, and make sure the layout contains
the number of cameras you want to add (page 145).
2. In the Insight Toolbar, make sure the Control tab is selected.
3. Drag cameras from the Insight Toolbar and drop them onto the appropriate panels in
the video window. Video feeds are added and synchronised to the time line of the video
window.
Synchronising DVR Date/Time
You can synchronise the DVR date and time so that it’s the same as Insight Server.
Synchronisation can be performed manually, or scheduled to occur automatically at specified
intervals.
To manually synchronise the DVR date and time:
1. In the Insight Toolbar, right-click the DVR you want to synchronise and choose
“Properties…” in the menu that appears.
2. Click the DVR Time Zone tab.
3. Specify the time zone where the DVR is located.
4. Click Synchronise DVR Now.
To automatically synchronise the DVR date and time with Insight Server:
1. In the Insight Toolbar, right-click the DVR you want to synchronise and choose
“Properties…” in the menu that appears.
2. Click the DVR Time Zone tab.
3. Click the Schedule button.
4. Tick the “Schedule DVR Time Synchronisation” box.
5. Specify how often you wish to synchronise the DVR with Insight Server.
6. Click OK.



Note
When synchronising, the DVR date and time is changed to match the date and time of Insight
Server.
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Note
For synchronisation to occur, Insight server must be running.



Working With The DVR Control Bar
The DVR Control Bar lets you manage your cameras. You can switch between live and archival
footage, change the time code of the video window and change the number of cameras
displayed. For PTZ cameras you can pan, tilt, zoom, iris and focus the camera by remote
control or activate a camera preset.

Camera
Pan/Tilt

Camera
Zoom/Focus/Iris

Timeline
Controls

Playback
Controls

Layout
Controls

Controlling PTZ Cameras
You can remotely control compatible PTZ cameras from
the DVR Control Bar.
To control a PTZ camera:
1. In the video window, click the camera you want to control. The selected camera is
enclosed by a yellow rectangle.
2. Make sure the DVR Control Bar is visible (View DVR Control Bar)
3. Make sure the video window is in live video mode (click
)
4. To pan the camera, click the left and right arrow controls ( and ).
5. To tilt the camera, click the up and down arrow controls ( and ).
6. To zoom the camera, click the zoom + and zoom – buttons.
7. To focus the camera, click the focus + and focus – buttons.
8. To adjust the iris of the camera, click the iris + and iris – buttons.
Some PTZ cameras support a “tour” mode, where the camera automatically tracks over a preset
path.
To put a PTZ camera into tour mode:
1. Click the video window containing the camera you want to control.
2. Make sure the DVR Control Bar is visible (View DVR Control Bar)
3. Make sure the video window is in live video mode (click
)
4. Click the tour button (

). The camera enters tour mode.



Tip
To exit tour mode, click the tour button a second time, or click one of the pan/tilt/zoom/focus/iris
buttons.

Some cameras can be programmed with presets. Activating a preset sets the zoom, focus, iris,
tilt and zoom to a known position. Use your DVR software to program your camera presets.
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To activate a PTZ camera preset:
1. Click the video window containing the camera you want to control.
2. Make sure the DVR Control Bar is visible (View DVR Control Bar)
3. Make sure the video window is in live video mode (click
)
4. Click the preset button (
). The preset controls appear.
5. Enter the preset number you wish to activate.
6. Click Go. The camera moves to the selected preset.



Tip
You can also activate camera presets in Insight Schematic. See page 122.

Working With The Video Timeline
Each video window maintains a video timeline. The
timeline applies to all cameras in the window. For
example, if you add 5 cameras to a video window, then set
the time line to March 15 at 10am, then each camera will
show archival footage from March 15 at 10am.
The time line is ignored if the video window is showing live
footage.

To view live footage:
1. Click the video window containing the cameras you want to switch to live feed.
2. Make sure the DVR Control Bar is visible (View DVR Control Bar)
3. Click the live video button ( )
The live video button turns red, indicating you are watching live video.



Tip
This only applies to cameras in the active video window. Other video windows are unaffected.

To view archival footage:
1. Click the video window containing the cameras you want to see
archival footage for.
2. Make sure the DVR Control Bar is visible (View DVR Control Bar)
3. In the Video Timeline box, enter the date and time in the Date/Time
box, or click the calendar button and select a date, then drag the
slider control to set the time.
The live video button turns blue, indicating you are watching archival video.
To set the time code to a review event:
1. Make sure the video window containing the cameras you want to see is open. If
necessary, create a new video window and assign cameras to it.
2. Open the review window containing the review message. Make sure the video window
isn’t completely obscured by the review window.
3. Drag the review event and drop it onto the video window. The time code is changed to
match the date and time of the review event.
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To control playback of archival footage:

1. Enter playback mode (see “to view archival footage”, above).
2. Use the video playback controls described below.
Play forward (normal speed)
Play backwards (normal speed)
Freeze current frame
Play forward (high speed)
Play backwards (high speed)
Advance forward one frame
Advance backwards one frame
Freeze current frame

Working With Layouts
You can show up to sixteen cameras in a single video
window. Each camera is synchronised with the time controls
for the video window.
To change the layout of a video window:
1. Click the video window you want to change.
2. Make sure the DVR Control Bar is visible (View DVR
Control Bar)
3. Make sure the Layouts tab is selected.
4. Click a new layout.
5. Drag cameras from the Insight Toolbar onto the new layout.



Note
If you switch to a layout with fewer cameras than the current layout then Insight will discard any
leftover cameras. You can always add the cameras again by dragging them from the Insight
Toolbar and dropping them on the layout.
Insight can superimpose an On-Screen Display (OSD) for each camera in a video window. The
OSD shows the name of the camera.
To activate the OSD for a video window:
1. Click the video window you want to change.
2. Make sure the DVR Control Bar is visible (View
Control Bar)
3. Make sure the OSD tab is selected.
4. Tick or clear the Show Camera Name box.

DVR



Tip
Turning on the OSD effects all cameras in the current video window.
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Sending Commands To A DVR Or Camera
You can send a model-specific command to a DVR or camera. Right-click the DVR or camera,
and choose “Commands” in the menu that appears.



Note
The commands available will be specific to the make and model of your DVR and/or camera.
Consult the documentation that came with your equipment for more information.

Integration With Review
You can set the time code of a video window to the time and date of a review event. In other
words, if a particular review entry occurs on February 28 at 3pm, you can quickly see camera
footage from this date and time. See page 144.
You can associate cameras with areas. Right-clicking on a review event that contains the area
enables you to see live video from the associated camera.

Integration With Schematic
You can place cameras and camera presets directly onto your floor plans in Insight Schematic.
See page 122.
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Touch Designer
TouchDesigner 1.0 is a new module within Insight Installer and Insight Professional that allows
customisation of the touch screen terminal.

As you can see in the image above there are three main components to TouchDesigner.
The tree view on the left hand side only contains Concept panels that are using a memory
configuration that supports touch screen terminals. Depending on the memory configuration and
memory size you can create a number of Layouts, Screens and Buttons.
The centre section of the application is for previewing and selecting Screens and Buttons.
The right side of the screen is for adjusting the properties for the currently selected Layout,
Screen or Button.
Additionally there is a new tool bar for the creation of blank Layouts, Screens and Buttons:
. These buttons will be enabled depending on your selection within the tree view
on the left hand side of TouchDesigner.
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Customisation of a Touch Screen Terminal
As stated above there are three components used to create a
custom touch screen design. A touch screen Layout contains
Screens which contain Buttons. All of these components can
be customised, however the First Screen that is created
automatically with every Layout will have the default Inner
Range Menu Screen.



Note
You can only change the colour scheme, layout name and
the next screen that the Control and Security buttons will take
you to on the default Inner Range Menu Screen.

Panel memory and layouts
Just to the right of every panel in the TouchDesigner are two numbers in brackets:

The example above has a 128k panel with (80/44). The number 80 represents the total memory
or ‘structures’ allocated to touch screen Layouts created within the panel. The number 44
represents the remaining structures available to create more Layouts, Screens and buttons.
You can exceed the total structures allocated to the panel you are configuring Layouts, Screens
and Buttons for but you will not be able to save changes. If you attempt to save any changes
you have made after exceeding the total, a warning dialog will appear.



Note
The panel icon will change from green to red to represent unsaved changes within the
TouchDesigner.

Creating a new Layout
To begin creating a new Layout for your touch screen
terminal, right click the panel in the tree view on the left
hand side of the screen and select Add layout…



Note
You can create a new Layout by clicking on LA after selecting the panel you wish to create it for:
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Next you will be required to give the new layout a Name and a Colour
scheme:

After clicking OK to confirm the layout name and colour, you will notice a number in brackets to
the right of the newly created layout. The panel icon will change to red

.

The number in brackets (3) represents the structures this layout will use within the panel.
Additionally, Screens will have their own number in brackets representing the structures they
will take within the panel.
The name of the selected Layout can be changed in the Properties on the right hand side of the
screen.
Whenever a change has been made to a panel Layout,
Screen or Button the Panel icon will change to red. To
save your changes, right click your panel and select
Save.

Creating a new Screen
There are three types of screens that can be created. By right clicking the desired panel you can
click on Add Screen followed by Menu Screen or Diary Screen:

Add Screen
Menu Screen
Fixed Text allows you to create a standard Screen
with buttons etc…
Add Screen
Menu Screen
Custom Text allows you to create the same standard
Screen as above with custom text at the top.
Add Screen
Diary Screen allows you to create a blank screen for displaying diary
messages. Please refer to [Menu], [5], [4] p1 of the Programming, Applications And
Reference Manual for more detail on diary messages.

Creation of a Fixed Text Menu Screen:
By right clicking your Layout and selecting Add Screen
Menu Screen
Fixed Text you’ll be presented with the
following dialog:

1. Enter a name to describe your new screen.
2. The Button Alignment buttons allow you to group the
buttons together on the screen.
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3. If the Needs Logon check box is ticked users will be required to enter their PIN code to
access the screen you have created:

4. If the Has Logoff Button check box is ticked, users will be able to logoff using
the button:
5. If the Has Toolbox Button check box is ticked, users will be able to access
Review and Isolate if permissions have been given to them in their Menu
Group via their User Type: Please refer to the Programming, Applications And
Reference Manual for more detail on user programming.

6. If the Has Back Button check button is ticked, the user has the option to return
to the previous screen:



Tip
When creating a Layout with many screens, the Back button will make navigation easier for the
end user.

Creation of a Custom Text Menu Screen:
By right clicking your Layout and selecting Add Screen
Menu Screen
Custom Text you’ll
be presented with a dialog similar to the one seen when creating a Fixed Text Menu Screen.
You will notice that there is an additional text box at the bottom of the dialog allowing you to
enter a custom title at the top of the screen you are creating:



Tip
When creating a Layout with many screens, make good use of the Custom Text Menu Screen
to make navigation easier for the end user.

Creation of a Diary Screen:
By right clicking your Layout and selecting Add Screen
Diary Screen you’ll be presented
with a dialog similar to the one seen when creating a Fixed Text Menu Screen. You will notice
that you only have the option to change the screen name and select the Diary Message you
wish to display on the screen you are creating.
Diary Screens can not be modified. You can change the name of the screen and the Diary
Message assigned.
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Note
A Diary Screen will overlay the Main Screen if active.



Creating a new Button
Menu Screens allow you to place Buttons on them. To do this Right click the Screen in the tree
view of the left hand side of the screen and select Add Items:

Add Items and Add Custom Text items allow you to select one of nine different items.
Custom Text items differ slightly to Add items in that they allow you to specify a text label for
the button. Add Items will allow you to create an item with either the name of the item
programmed within the panel or a list of pre-defined text words.

Button placement
Once you have selected an item to place on your
screen, a new button will be placed on your screen.
You can move the button amongst other buttons on
your screen by right clicking it and selecting either
Move Previous Position or Move Next Position:



Tip
To remove a button from your screen, right click it
and select Delete. A confirmation dialog will pop up to confirm your action.

Button properties
Most of the buttons available will have similar properties. The common button properties are:
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Button

This property is read only. It is a number that represents the location of the
Button amongst the other Buttons that may be on the same Screen.

Parent Screen

This property is read only. This property contains the name of the Screen
containing the Menu Button.

Button Function

Allows you to change the button from a Menu Button to another item.

Button Text

If the button is a custom text button you can enter custom text here to
describe the buttons function:
If the button is not a custom text button then you will have the option to
select one of the items in the drop down list box.

Title type

Allows you to change the button from a custom text button to a preset
button.

Menu Buttons
Menu Buttons are used to allow the user to navigate from the current
screen to another.
Next Screen

Allows you to select the screen that will be
displayed if this button is pressed.

Requires Logon

This property is read only. It will indicate if the Next Screen has the
property Need Logon set to Yes.

Area Buttons
Area buttons allow the user to arm or disarm a single area within the
system.
Area Index:

Allows you to select one of the areas available in
the panel.

Timed Auxiliary Buttons
Timed Auxiliary buttons allow the user to activate a home auxiliary for a
timed period or toggle its state on/off.
Home Auxiliary Index: Allows you to select one of the home auxiliaries
available in the panel

AreaList Buttons
AreaList buttons allow the user to arm or disarm the selected area list
within the system.
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AreaList Index

Allows you to select one of the area lists available in the panel:

Isolate Buttons
The Isolate button allows the user to access a separate menu for
isolation of standard inputs and system inputs.

Review Buttons
The Review button allows the user to access a separate menu for
viewing panel history.

User Extra Area Buttons
The User Extra Area button allows the user to arm or disarm the their
allocated extra area within the system.

Home Analogue Auxiliary Buttons
The Home Analogue Auxiliary button allows the user to control an
automation system such as C-Bus, Dynalite or HPM. Eg. A Home
Analogue Auxiliary can be used to control light dimming.
Home Auxiliary Index

Is used to select the home auxiliary that will be
used to control the automation system.

Switched Auxiliary Buttons
Switched Auxiliary buttons allow the user to toggle the state of a home
auxiliary.
Home Auxiliary Index

Allows you to select one of the home auxiliaries
available in the panel:
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Active User Rotation Module
The AURM (Active User Rotation Module) has been designed to accommodate for
configurations consisting of one or many panels that require more users than the maximum
allowable memory configuration.
When a user presents their card to a reader, the panel will search its own memory for the user
record. If the users record exists locally then the panel will grant access as per its programmed
configuration. If the user does not exist then the panel will send a request to Insight. Insight will
then search for this user within its own database and update the panel with the users record. If
all of the user records in the panel are already programmed then the user record that has been
inactive the longest will be replaced.
When presenting a card to a reader the transaction time will vary if the user is not stored locally.
The total time taken is approximately 3 seconds from when the card is presented and when the
user is granted or denied access.

Paid Feature
Insight Active User Rotation Module is a separately licensed module and requires Insight
Professional to run.



Requirements
To take advantage of Active User Rotation, the following criteria must be met:
Insight Professional 4.3 or above
o Active User Rotation Module license.
o Virtual Panel with one or many panels configured for AUR
Concept panel(s) with the following configuration:
o Firmware v7.60 or above.
o 512k memory expansion.
o Reader Mode set to Site Code.
o Reader option U (Request unknown User) in EU.
o A permanent connection.
o Active User Rotation selected in Panel Profile.

Configuring Active User Rotation
Before starting please ensure you are using a panel with firmware version 7.6 or above. To
check this press [Menu], [2] when logged out of the terminal.

1) Configuring the Concept panel
a. Log in to the Terminal: [0], [1], [OK].
b. Go to the Reader Options: [Menu], [7], [2], [4].
c. Enter the Reader Module number to program: [0], [1].
d. Turn on Request unknown User: [OK] x7, [►], [9].
e. Change the Reader 1 Mode to Site Code: [OK] x3, [►].
f. Change the Reader 2 Mode to Site Code: [OK] x5 [►].
g. Repeat steps b - f for each reader module.
h. Go to the Intelligent Reader Options: [Menu], [7], [2], [8].
i. Enter the Intelligent Reader Module number to program: [0], [1].
j. Change the Reader 1 Mode to Site Code: [OK] x10, [►].
k. Turn on Request unknown User for Reader 1: [OK] x2, [►], [9].
l. Change the Reader 2 Mode to Site Code: [OK] x5, [►].
m. Turn on Request unknown User for Reader 2: [OK] x2, [►], [9].
n. Change the Reader 3 Mode to Site Code: [OK] x5, [►].
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o. Turn on Request unknown User for Reader 3: [OK] x2, [►], [9].
p. Change the Reader 4 Mode to Site Code: [OK] x5, [►].
q. Turn on Request unknown User for Reader 4: [OK] x2, [►], [9].
r. Repeat steps h - q for each reader module.
2) You will need to enrol the panel in to Insight as you would normally.



Note
For Instruction on Door programming and the Insight communications task please refer to the
“Concept 4000 Programming, Applications And Reference Manual”.

3) Once the panel is enrolled within Insight you will need to go in to the panel properties and
turn on Active User Rotation. You will also need to set the AUR threshold. Set this threshold
to the user record number that active user rotation will start from. Users below this threshold
will act as normal local panel users:
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4) Make sure the panel is set to Permanent connection (Insight will try to stay connected):



Note
If a user is not in the panels database when it is offline then the user will be denied access.
5) Right-click a site and select New Virtual Panel…
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6) Select Active User Rotation and click

:

The remainder of the Virtual Panel Wizard is the same as creating a standard virtual panel.
Please refer to the Insight User Manual for more detail on creating virtual panels.
7) Virtual users created will not go directly to the panel. If an Unknown Card Request is
generated then insight will send the user to the panel if the user exists.
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Dynamic User Import Module
The Dynamic User Import Module enables automatic user programming of a Concept panel. It is
designed for installations where the access-enabled user base changes frequently, like in
hotels, clubs, fitness centres, etc.
The DUIM module runs as a service on the Insight Server machine and picks up files with the
updated user information. These files can be output files from a third party system, and so the
update of the user base can run fully automatically.
This module was initially conceived for use with a hotel's Property Management System, but the
Insight Dynamic User Import Module can also be applied to commercial and industrial
applications with its ability to take output from other ERP/HR Systems and update user
programming in Insight and Concept panels accordingly.

Paid Feature
Insight Dynamic User Import Module is a separately licensed module and requires Insight
Professional to run.



The Dynamic User Import Module is a service that runs in conjunction with Insight on the Insight
Server machine. It must be set up to work with the panel(s) in the system before it will run
properly.

Setting up the Dynamic User Import Module
Before attempting to set up the Dynamic User Import Module, it is recommended that the panel
or panels have been programmed first. The key panel items relevant to this module are:
Panel Name(s)
Number of users to be serviced - this will determine the memory configuration in the
panel as well as the User Range specified in the Dynamic User Import Module
Type of cards used for access
User types - When importing .INI files from a Hotel PMS, a User Type will be associated
with each floor the panel will service, based on the floor number. When importing .CSV
files from ERP/HR systems, a correspondence will be established between User Types
in the panel and User Type tokens as they appear in the .CSV file.
To Set Up the Dynamic User Import Module:
1. Ensure the Dynamic User Import
Service is installed on the Insight
Server Machine. To verify this, click
on the Insight Task bar Icon
on the
Insight Server machine. The DUIM
service is installed if the menu item
‘DUIM Service Settings’) is enabled. If
the service is running, this menu item
is checked.
2. Select this menu item (‘DUIM Service
Settings’).
3. You will be prompted to log in. Log in
as installer to enter the setup.
4. Enter the settings required by the
Dynamic User Import Module (see
below).
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Operator Permissions
To access the Setup dialog, the Installer user must be the currently logged-in user in Insight!



Login Tab
Item
Dynamic User Import Service
Status

Description
Indicates the current status of the DUIM service (running,
stopped, start pending, stop pending, etc). If the status is
‘running’, this is also indicated by a check before the ‘DUIM
Service Settings’ menu item of the Insight Task Bar Icon and
can so be found out without logging in.
This section of the Setup dialog provides buttons to start and
stop the service, and to test the Dynamic User Import
Module.

Operator Details

Sets the Insight Operator account which will be used to
process the data files.
The user specified in Operator Details should be set up
specifically for use with the Dynamic User Import Module
only and limited to having SEE permissions on panel items
and CHANGE permissions on users.

Folder to Monitor

This is the folder where the Dynamic User Import Module will
expect data files with the updated user information to be
dropped by a third party system. The default location is the
“CMS Monitor Files” folder in the Insight Application Data
folder (C:\Documents and Settings\All Users\Application
Data\Inner Range\Insight\CMS Monitor Files\).

Start: When ‘Start’ is pressed, the status display will change to ‘Start pending’ and then
‘Running’, indicating that the Dynamic User Import Module is ready to use. It will then monitor
the folder nominated under the ‘Folder to monitor’ setting for new files and process new files as
it sees them.
Stop: Selecting the ‘Stop’ button will cause the DUIM service to stop if it is running. The status
display will change to ‘Stop pending’ and then ‘Stopped’, indicating that the Dynamic User
Import Module is not operating.
Test: Pressing this button opens a dialog where the Dynamic User Import Module can be
quickly tested. The operator can test the addition as well as the removal of a user. The test
must be started with the ‘Start’ button first which will restart the DUIM service (to make sure that
any new settings entered are picked up, provided they were ‘Applied’ first).
To test the working of the Dynamic User Import Module, enter sample users in the Testing
dialog and see them appear in the panel in Insight Edit.

Options Tab
Item
Import Type

Description
This tells the Dynamic User Import Module which kind of files to
look for.
Windows INI File: Version 1 of Hotel PMS Tool format (see
section on page 163). Use this format when interfacing with a
Hotel PMS and where Room Numbers are part of the User data.
CSV File: Comma-Separated Value file format. This CSV file
format follows the same rules as import of extended user
information in Insight Edit (see page 54). Use this format when
interfacing with ERP and HR systems.
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Card Type

Select a radio button to match the type of access cards
programmed in the panel.

Card Pool for Cards

When importing user programming via a CSV file, the card
numbers and/or card allocation can be automatically entered
into the Card Pool system, assuming the Insight installation has
a valid Card Pool licence.
The type of the card pool selected in this dialog must match the
type of card specified in the user programming in the CSV file.
No action is taken if the Card Pool specified does not match the
type of card specified in the user programming in the CSV file.
For example, if the Card Pool specified is a Site Code Card Pool
and the user programming indicates a Direct Entry Card Pool,
then no cards are assigned.

User Type Lookup

Check the ‘Multi-storey hotel application’ checkbox if interfacing
with a Hotel PMS system and importing data using the .INI
format. This links a floor (derived from the guest's room number)
with a matching User Type in the panel. The “Room Digits”
setting (see below) is only active if this item is checked.
When interfacing with a system using the .CSV format, leave
this checkbox unchecked. In this case, a User Type defined in
the .CSV file is linked to a particular User Type in the panel
using a Lookup Table defined in the “Lookup Table” tab..

Room Digits
(Not applicable when not a
hotel application)

The number of digits to remove from the room number to get the
floor number (hotel floor). For example, if room 12 on the 4th
floor was designated Room 412, Room Digits should be set to
2.



Note
When using CSV files, specific items of programming for a user can be cleared by populating
the field(s) with the entry, <blank>. The <blank> entry cannot be used for the following fields:
PIN, First Name, Second Name, Gender, Date of Birth, Card Number.

Panels Tab
The Dynamic User Import Module needs to know which panel(s) is/(are) servicing the
installation.
Item

Description

Panel Selection Icon List

A list of icons representing the panels used for dynamic user
import.

‘Properties’ Button

Allows settings for the selected panel to be viewed and
changed.

‘Remove Panel’ Button

Deletes the selected panel from the Dynamic User Import
Module setup.

‘Add Panel’ Button

Used to add panels to the list that the Dynamic User Import
Module will deal with. Selecting this button will bring up a
dialog which is explained below.

Adding Panels (‘Add Panel’) or modifying them
(‘Properties’) brings up the ‘Add Panel’ dialog:
Panel Name: Type the panel name in this field. (The
panel must already exist in the system). The Panel
Name field must exactly match the name of the Panel
as shown within the Insight Edit module.
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Virtual Panel: If this item is checked, the panel shows up in the Select Panels pane as a virtual
panel (which must already exist in the system).
User Range: This setting refers to the range of user numbers to use in the panel when adding
new users. Each of the "Card Only User" settings are in blocks of 8192 user numbers.
For up to 4096 Users with User Number in the range of U0001 to U4096, select
"Card/Pin Users(57)". This would be the typical setting on a 128k panel (where built-in
memory configurations allow a maximum of 2000 users).
For up to 8192 Card Only Users with User Number in the range of U4097 to U12288,
select "Card Only User(185)".
For up to 8192 Card Only Users with User Number in the range of U12289 to U20480,
select "Card Only User(186)".
A 512k panel is required for this setting and beyond.
For up to 8192 Card Only Users with User Number in the range of U20481 to U28672,
select "Card Only User(187)".
For up to 8192 Card Only Users with User Number in the range of U28673 to U36864,
select "Card Only User(188)".
This setting and beyond would require a 512k panel with a custom memory
configuration.
For up to 8192 Card Only Users with User Number in the range of U36865 to U45056,
select "Card Only User(189)".
For up to 8192 Card Only Users with User Number in the range of U45057 to U53248,
select "Card Only User(190)".




Note
You can import more than 8192 users. If for example you decide to import 8500 users and you
have selected “Card Only User(185)”, users 12289 to 12788 will flow over in to “Card Only
User(186)”.
Warning
If the setting of User Range exceeds the amount of users available in the Panel (based on
memory size and configuration, for instance, choosing a "Card Only User" setting on a 128k
panels, which, by default do not support Card Only users), the Dynamic User Import Module
may successfully process the setup file, but will report an error when processing files to add
users.
User Index: This setting determines an index number from which the module starts adding users
in the panel. For instance, if the User Range is set to "Card Only User(187)" (which means that
User Numbers of 8000-16000 are used in the panel) and the User Index is set to 10, the first
User Number that the Hotel PMS Tool will use in the panel is U8011.



Tip
Where the User Range includes U0001-U4000, it is recommended that User Index is set to at
least 3 to avoid inadvertently overwriting the user programming for the MASTER and
INSTALLER users.



Note
No User Range and User Index can be selected if the panel is virtual. User ranges and starting
indices are already specified when defining the virtual panel.
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Lookup Table Tab
Lookup tables are required for the Dynamic User Import Module to link a hotel floor in an .INI file
to a User Type in a panel (for Hotel PMS) or to match a User Type token in a .CSV file (typically
from an ERP/HR system) to a User Type in a panel.
The Dynamic User Import Module Setup dialog will create a lookup table for each of the panels
defined in the Panels tab.
To see and edit properties in a lookup table, leftclick the lookup table, then select the Edit…
button. This will open the Lookup Properties
dialog for the selected lookup table. Alternatively,
double clicking a lookup table will also open the
Lookup Properties dialog.
The Lookup Properties dialog shows the existing lookup values for a panel. The values display
which User Type in a panel is associated with a particular floor (for .INI files) or user type token
(for .CSV files).
From this dialog, the user can add, edit, and delete lookup items for a panel.
Lookup Properties Item

Description

Hotel Floor (if Hotel application);
Key for User Type (otherwise)

The Hotel Floor (a number) if hotel application.

User Type

The User Type in the panel that corresponds to the Hotel
Floor or User Type key in the data file.

Panel

The panel this User Type belongs to.

If not a hotel application ad CSV-style file inout, a token (key)
to refer to the User Type in this particular Panel as it will be
found in the external data file.

When the Add or Edit buttons on the Lookup Properties dialog are pressed, the Lookup Item
dialog appears:
An explanation of the different Lookup Item dialog properties is shown below.
Item

Description

Hotel Floor/Token to represent
User Type

Hotel Floor or User Type token (key) found in the external
data file.
When importing using .INI files and using room numbers, this
value is typically the floor number.
When importing using .CSV files, this value can be chosen
freely. It is recommended to choose a token that is exactly
the same as the User Name In Panel.
The Hotel Floor or User Type token must be unique within
the lookup table!

User Type In Panel

In this field, enter the User Type defined in the panel that
corresponds to the floor or user type in the Hotel Floor/User
Type field.

Panel Name

Select the panel to which this User Type belongs to.
Remember that lookup tables are created for each panel in
the system, so all items within a lookup table should relate to
one panel only.

162




Note
Whilst Hotel Floor/User Type Values must be unique within a table, many different floors or user
type tokens may be associated with a single actual User Type in the panel.

Note
Entering a single asterisk, "*" in the User Type In Panel field tells the Dynamic User Import
Module that there is no Panel User Type associated with this User Type key value in the data
file. With the exception of, "*", the entry in this field must have a matching entry in the panel.
Finish the Set-Up procedure using the ‘Apply’ or the ‘Close’ button at the bottom of the Setup
dialog.
Working with the Dynamic User Import Module
Once the Dynamic User Import Module is set up and the new Setup written to disk via the
‘Apply’ or ‘Close’ button, the DUIM service needs to be (re-)started to pick up the new settings.
If you use only ‘Apply’ (so the Setup dialog stays open) or re-enter the Setup dialog afterwards,
in the ‘Login’ Tab, you can see the current status of the service. If the service is running, hit the
‘stop’ button. Now start the service again. The Dynamic User Import Module is now ready to
wait for new user data.

Sending data files to the Dynamic User Import Module
1. Ensure that the Dynamic User Import Module is running and ready to accept data.
2. The third-party system should be set up to output data files in a format that matches the
settings applied to the Dynamic User Import Module.
3. The third-party system should output files with incrementing file names each time a new
data file is created (e.g.: Insight0000001.csv, Insight0000002.csv, etc.).
4. The names of the data files must correspond to a certain naming convention:
If using .CSV files, the files must be named “Insight*.csv” (e.g.:
Insight0000001.csv).
If using .INI files, the files must be either be named “InsightAdd*.ini” (for adding a
user) or “InsightDel*.ini” (for deleting a user) (e.g.: InsightAdd0001.ini,
InsightDelete0002.ini).
5. The data files need to be dropped into the location nominated in the set-up for the
Dynamic User Import Module.

Hotel PMS INI File Format



Note
The .INI file name must use the following naming convention: The file must be called either
“InsightAdd*.ini” (e.g. “InsightAdd0001.ini”) to add a user, or “InsightDelete*.ini” (e.g.
“InsightDelete0001.ini”) to remove a user.
When importing .INI files, the data must be in the following format:
Guest Name, Room Number, Card Number, Leave
Each record is on a new line in the file.
Field

Data

Name

any text, e.g.: "Rodrigo Rodriguez"

Room

A room number, e.g.: "207".
A number of digits (specified in the ‘Room Digits’ setting in
the ‘Options’ tab of the DUIM setup) will be removed from the
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end of this number. The remainder must correspond to one
of the floor numbers entered in the ‘Lookup Table’ in the
DUIM Setup, which correspond to a panel user type.
Card

Card number, e.g.: "6702FF0000".
The Card type will be imported as Site Code, Direct Entry, or
Credit Card, depending on the ‘Card Type’ setting in the
‘Options’ tab of the DUIM Setup.

Leave

Date/Time in one of the following formats:
dd Month yyyy hh:mm

e.g.: "27 January 2007 10:59"

dd mon yyyy hh:mm

e.g.: "27 jan 2007 10:59"

dd/mm/yyyy hh:mm

e.g.: "27/01/2007 10:59"

In all date formats, a single space character separates
the date from the time.
In the first and second date format, a single space
separates the date components.
In the first and second date format, the month
component is aphabetical. The Dynamic User Import
Module will parse the first three letters of the month
component.

Example .INI Files for import with the DUIM Service
[File name: InsightAdd00002.ini]
[DATA_ADD]
Name=Wayne Clarke
Card=6534221
Room=308
[File name: InsightDelete00003.ini]
[DATA_DELETE]
Name=Conor O’Hara
Card=54297645



Note
Only one user can be added or deleted per .INI file.

Instructions for DUIMPreprocess.bat
When DUIM sees a file with a filename starting with "Insight" and ending with the file extension
".dui" (e.g. "Insight_users.dui") in the directory it searches for import data, it calls a batch file
DUIMPreprocess.bat if it exists. Creation of this batch file is the responsibility of the integrator.
This batch file could contain any valid windows command line commands. It would normally
contain a script or call a program to manipulate the data into the correct format for input via
DUIM.
For instance, a script file or external command line program might take a complete list of all
users for a site, compare it to a previous list output in the same order and create a list of
additions, modifications and deletions, without affecting unmodified users, thereby significantly
speeding up the import process.
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Description of Operation
1. The user or third party application drops a file called Insightxxxxxx.dui into the
directory that DUIM monitors for new data (e.g. C:\Documents and Settings\All
Users\Application Data\Inner Range\Insight\CMS Monitor Files).
2. Insight DUIM calls DUIMPreprocess.bat
3. The batch file may call a third party program (integrator's responsibility) to manipulate
the user data, create a resultant Insightxxxxxx.csv file and delete the old
Insightxxxxxx.dui file. Some users have used the excellent suite of new text file
manipulation tools to achieve this.
4. Insight DUIM reads the resultant .csv file and applies the changes to the user database.
5. Insight DUIM deletes the CSV file.

Disclaimer
DUIMPreprocess.bat is a utility created in good faith by Inner Range Pty. Ltd. to make things
easier for customers to interface to third party systems. It does not come with any warranty,
express or implied.
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Qualifications
Qualifications work by allowing a user access to a particular Door according to the validity of the
Qualification and whether the user can otherwise access that door associated with the user.
The first 8 Door Lists in the system are reserved for Qualifications. A qualification is associated
with each of these door lists. Any Doors assigned to these Door Lists will require a user with a
valid Qualification assigned to that Door to be valid in order to get access through that Door.
Qualifications can be configured in two ways – Timed or Count.
Timed Qualifications:
A user can be given a qualification that spans a predefined number of days. For
example: A forklift operator might require a particular license that has a duration of one
year / 365 days. A Timed Qualification could be used if the forklift operator is only
permitted to work within a secure location during the time their license is valid.
Timed Qualifications have two special properties - Valid Duration and Expire Warning:
Valid Duration is the total number of days that the license is valid for.
Expire Warning is set to the number of days prior to expiry that generate an
event in Review.
Count Qualifications:
Users can be given a Count Qualifications to limit a users total number of entries to a
defined door list. For example: An employee might pay in advance for 10 days use of an
underground car park. Each time the user is granted access to the car park entry their
Count Qualification is reduced by 1. Once the count reaches 0 the user will be denied
access.

When qualifications are in effect, if a door is in any of door lists 1-8, a user who otherwise would
have access to that door at that time must also have the appropriate qualification. If the door
appears in more than one of these door lists, the user must have all of the associated
qualifications to gain access..

Requirements
To take advantage of the new qualifications feature, the following criteria must be met:
Insight Professional 4.3 or above
o Qualifications license key
Concept panel with the following configuration:
o Firmware v7.70 b46 or above.
o 512k Memory Expansion fitted.
o Defaulted to the xDoor memory configuration.
o In General System Options - Option Q in ELPSZWQ
o A permanent connection.



Note
ANY door assigned to ANY of the first 8 Door Lists requires a Qualification. These Door Lists
are reserved for Qualifications.
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Preparing the Concept Panel
Before starting please ensure you are using a panel with firmware version 7.70 b46 or above.
To check this press [Menu], [2] when logged out of the terminal.
8) Configuring the Concept panel
a. Log in to the Terminal: [0], [1], [OK].
b. Go in to the Default menu [Menu], [7], [5], [2].
c. Select xDoor [►] x8, [OK], [9].
d. Log in to the Terminal: [0], [1], [OK].
e. Go to the General System Options [Menu], [7], [5], [1].
f. Turn on Qualifications , [OK] x20, [►] x6, [9], [OK].
9) You will need to enrol the panel in to Insight as you would normally.
User Qualifications are only enabled if the requirements listed in the section above are met.

Creating the Qualification
Qualifications are created using the Insight Edit module:
1) Open Insight Professional by Right-clicking the Insight Launch Pad (Pro)
icon.
a. Select Insight Edit.
b. Log in to the Insight Edit module by entering your User Name and Password. To
continue select Log On.

2) Create a Qualification:
a. Click on Edit
User Qualifications…

b. Qualifications are displayed in a table format:
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c.

i. This screen allows you to view all of the existing Qualifications and their
properties.
Click Add… to create a new Qualification:

d. Enter a Name to define the purpose of the Qualification.
e. Enter a Description to help identify and explain the purpose of the qualification to
others.
f. Tick the Active tick box to allow you assign the Qualification to a user.
g. Enter the Door List Index of the Door List you wish to assign this Qualification to.
h. Select either Time Qualification or Count Qualification.
i. If you select Time Qualification you will need to enter a Valid Duration in days.
j. If you select Time Qualification you will need to enter an Expire Warning in days.
k. Click OK.
l. Click Save then Exit.

Creating Doors
When using qualifications door programming does not differ.
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Note
Doors assigned to a Door List between 1 and 8 will grant access only to a user with a valid
Qualification assigned to that Door List.

Note
For Instruction on Door programming please refer to the “Concept 4000 Programming,
Applications And Reference Manual”.

Creating Door Lists
You will need to assign one or many doors to the first 8 door lists corresponding to the
appropriate qualification.
1) Create a door list for the qualification.
a. From the tree view on the left hand side of Insight Edit Select Door Lists.

b. Double-click the Door List that the qualification has been assigned to (in the “Door
List Index” box of the Qualification screen) on the right hand side of Insight Edit.

c. Give the Door List a descriptive name that will reflect its purpose.
d. Select the Door(s) you want to require this qualification for access.
e. Click on the save
icon to finish.
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Creating Users



Note
For Instruction on User programming please refer to the “Concept 4000 Programming,
Applications And Reference Manual”.

Newer versions of Insight Edit have a Qualifications section at the bottom of the Users Options
tab:

The Red and Green indicators to the right of the ‘Qualifications…’ button indicate valid
Qualifications assigned to the User. The indicators represent Door Lists 1 through 8
respectively.
In the image above the user has a valid Qualification(s) assigned to Door List 1 and a valid
Qualification(s) assigned to Door List 4. The User will be able to access any Doors assigned to
st
th
the 1 or 4 Door List if their User Type has a Door List with those Doors assigned.
1) Assign a door list to the user.
a. From the tree view on the left hand side of Insight Edit Select Users.

b. Double-click the User you wish to give a Qualification on the right hand side of
Insight Edit.

c.

Give the User a User Type with appropriate access including a Door List
containing the Door that is a member of a qualification door list.

2) Assigning the User a Qualification within Insight Edit:
a. Click on the Options tab for that User.
b. Click on Qualifications…

c.
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Double-click on the Name of the Qualification you wish to assign to the User.

d. Depending on the type of qualification you are giving to the user you will be
required to enter either a date of a number of credits:
i. If the qualification is a timed type than you will need to enter the date from
where the qualification will start from.

ii. If the qualification is a count type than you will need to enter a value
representing the total number of times the user is allowed to access any of
the doors in the qualification door list.

e. Click OK. Then Click OK again to go back to the Users Options tab.
f. Click on the save
icon to finish.
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Insight Review
Listed below are a few examples Insight review events:

The user has access to the door.

Insight will generate a review event when a users qualification reaches its expiry
warning time. This event will be generated each day for the user until the qualification
has expired.

The users qualification has expired. If the user attempts to gain access to a door that
requires a qualification they will be denied.

The user is denied entry due to an expired (or no) qualification.

Importing Extended User Information
You can import extended user information (such as age and contact details) from an external
file. The file must be in “Comma Separated Values” format (CSV).
Imported and exported user information has two extra columns for qualifications:
Field code if used
in heading row
irqualifications

Description

Data

The name of the qualification.

Any text

irqualificationvalues

This field will be either the
Count or start date for the
qualification

A valid (decimal) integer
number or a date stamp
(DD/MM/YYYY).



Note
For more information on importing extended user information and the dynamic user import
module, please refer to the Insight user manual.
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Appendix A: Communications Task Configuration
Insight communicates with panels via an Insight comms task. This comms task must be CT001
in the panel.
To configure the Insight comms task:
1. Using an elite terminal, log in with the Installer PIN and go to [Menu], [7], [3], [1] (comms
tasks).
2. If your panel is using factory settings (or the panel has been defaulted) then CT001 will
be set to Insight. In this case, you will only need to adjust the settings in red.
3. Press [Help], [9], and change the panel ID to a unique, non-zero value. The first two
digits should be 00. The value you enter here must match the number assigned in the
Insight front-end software (see pages 22 and 33).
4. Leave all other settings on their defaults, which are listed below:
1

Panel ID = 00xxxxxx 
Port: 1
Baud: 9600 
Opts NUIP = ....nnnn
Ethernet = ..…ACE

For direct serial connections: if you are using a
DTR/DSR comms cable, you can set opts to nYnn.
This stops phantom mouse detection on older
PC’s. Most cables do not have DTR/DSR
connected, and will not work with this option.
For Ethernet UART only. If you don’t intend to use
an Ethernet UART, set these flags to nnn.

RS232 = ..…ACE
FE3000 = ..…ACE
2
Ext. Mod = ..…nnn
Int. Mod = ..…nnn
Insight IP: see below
Insight Key1: 0
Insight Key2: 0
IPFast IP: 0.0.0.0
IPFast Key1: 0
IPFast Key2: 0
Panel IP: see below
Router IP: see below
Subnet Msk: see below
CT001 Announce Port: 17185
Max Attempts: 0

If you don’t intend to use this connection type, set
these flags to nnn.
If you are using the internal modem, set these
flags to ..…ACE and configure an I-modem task.
To secure your installation, set these to random
values. They must match the settings on page 33.

 Insight requires these settings to enrol the panel. Note them down. You will also need
to know the panel serial number (press [Menu], [2]).
Insight IP is the static IP address of the Insight Server computer. If you aren’t using the
Ethernet or FE3000 connection paths, leave this as zero.
Panel IP is the static IP address of the panel. If you aren’t using the Ethernet or FE3000
connection paths, or if you want the panel to obtain an IP address from a DHCP server,
leave this as zero.
Router IP is the static IP address of the local router or gateway. If you aren’t using the
Ethernet or FE3000 connection paths, leave this as zero.
Subnet Mask is the TCP/IP subnet mask for the local network. If you aren’t using the
1

Pick a random or sequential number for each panel. The number must be unique for all panels
in your Insight installation.
2
Control Module firmware prior to V6.0 doesn’t support an external modem connection with
Insight.
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Ethernet or FE3000 connection paths, leave this as zero.
5. Make CT001 idle then active.
To configure the I-modem comms task:
1. Change CT002 from active to idle
2. Change CT002 to I-modem
3. Press [Help], [9], and make sure the following settings are selected:
Rings to answer = 15
Ans. Options = nnnnnn..
Line Test Time = 0
Insight # = None
IPFast # = None
ISP Accnt =
ISP Passwd =
Dial = nnnnnnnn
PABX No. = None
Back No. = None
Cust No. = None
Seize Aux =
Single DTMF Tone =
Line Test Count = 0

For timed fax bypass, set these options to
nnnYnnn..
If you want the panel to dial Insight when there is
an alarm, set this to the phone number of the
Insight Server computer.

4. Make CT002 active.
5. In CT001, make sure Int. Mod = ..…ACE and restart CT001.
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Appendix B: Upgrading the Database to SQL Express 2005
This appendix applies to installations that are upgrading to Insight V3.2 or higher from a
previous version of Insight (V3.1x or earlier).
Prior to V3.2, Insight Professional used MSDE (Microsoft Server Desktop Engine) SQL as the
default database platform. This limited the maximum database size to 2 GB of data.
Commencing with V3.2, Insight ships with MS SQL Express 2005 which is used in new
installations. If upgrading from an earlier version of Insight, the installer will retain the previous
database (either MSDE or SQL Server).
Since MS SQL Express 2005 allows a database limit of 4 GB and is compatible with MS Vista,
some installations that are upgrading to Insight 3.2 may benefit from upgrading the database
platform to SQL Express 2005.
To Upgrade from Insight 3.1 (or earlier) to Insight 3.2 (or higher) and use SQL Express
2005:
1. Before installing Insight 3.2, use the Insight Archiver SQL module to back up the Insight
database
2. Remove MSDE (Microsoft SQL Server Desktop Engine) completely using Add or
Remove Programs from the Windows Control Panel (Start Control Panel Add or
Remove Programs)
3. Install the new version of Insight, following all the prompts
4. Restore the Insight database which was backed up in step 1




Note
The Insight installer will prompt the user that SQL Server 2005 will be installed to run under a
particular account (usually, “NT AUTHORITY\Network Service”) and that the account needs
access to the Insight installation folder. The user should answer “Yes” to the dialog.
Note
If the previous version of Insight was set up to have its database back ups stored to a location
outside the Insight installation folder, then the “NT AUTHORITY\Network Service” account on
the Insight ‘server’ machine needs to have full access to the location the Insight database back
ups are kept in
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Appendix C: Insight Express Feature Set
Insight Express is an inexpensive software solution for small business enterprises. It provides
one connection to a Concept 3000/4000 control panel and can be used on a single computer
workstation. Full operator passwords are provided for added security. Insight Express can also
be upgraded to Insight Professional when further expansion is required. It is intended for small
businesses with only a single panel and one client.

Overview
Insight Express is a cut down version of Insight with the following features/limitations.
Features:
Lower cost.
Allows permanent connections.
Able to expire users that the panel cannot (same as Insight Pro).
Limitations:
It is a stand-alone system. (NOT client/server like Insight Pro).
Only 1 panel can exist in the database at any time.
Will not work with IP Door controllers.
No Schematics
No Alarm Handler
No Virtual Panel
No Tenancy
Edit reports will not support the filtering dialogs
Licensing:
Needs an Insight Express dongle. Will not run if no dongle is present.
Will revert to Insight INSTALLER type of functionality if a valid “Express” key is not in
the dongle (even if an Insight Pro key is).
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Appendix D: Panel Firmware Versions Support
The Concept 4000 Panel Firmware is regularly updated to incorporate new features.
When each new version of Insight software is released, it will provide full support for the version
of Panel firmware that is currently in production, or a version that is soon to be released to
production.
The table below shows which version of Insight is required to provide full support for the various
versions of Panel firmware.
Additional columns also show which versions of Panel firmware are provided with “Enrol Only”
and “Extended” support.

Insight
Version
V1.0
V1.4
V2.1
V3.0.0.11
V3.1
V3.2
V4.0

Panel (Control Module) Version and level of support.
Partial. Type 1 Panels only.
Enrol Only
Extended (See note below)
V2.0 to V4.09
V2.0 to V4.09
V2.0 to V4.09
V2.0 to V4.09
V2.0 to V4.09
V2.0 to V4.09
V2.0 to V4.09

Full
Type 2 Panels only.
V5.0
V5.1 / V5.11
V5.2 to V5.28
V5.6
V5.7
V6.2 to V7.0
V7.4

NOTE: Extended Type 1 Panel support.
Insight V4.0 or later now provides extended support for Type 1 Panels.
Connection is via the “PCDirect” Comms Task format and provides full upload and download of
the Panel database, control of common entities such as Areas, Doors, Home Auxiliaries, etc.
and the retrieval and storage of Review.
As Insight is intended to manage Type 2 Panels, some newer features not available in Type 1
panels will appear to be available, but will not function. If these particular features are required,
or to take advantage of the full range of Insight features, the Panel will need to be upgraded to a
Type 2 or later Control Module with the latest firmware fitted.
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Appendix E: Microsoft SQL Server Express limitations
This appendix explains the limitations of the bundled SQL Server 2005 Express Edition software
and provides guidelines to determine when it is appropriate to upgrade to another edition.

The Limits
SQL Server Express edition is a free database engine provided by Microsoft. Express Edition
has a number of limitations, but the most important one from the point of view of the Inner
Range Insight Management Software is a limit of 4 Gigabytes for any one database.
Insight uses a number of databases to store its data. The ones most likely to be affected by this
limit are the Review database in any busy system and the main Insight database (which
includes users) when there are a lot of panels or a lot of users.
As an indication, Insight Review can fill a 4GB database with approximately 2 million events.
This number depends very much on the type of event, the number of review entries the event
generates and the text associated with those entries. This equates to a little over 5,000 events
per day for a year, where each event might cause a number of review entries. On a busy site,
5,000 or more events per day would not be uncommon.
Operations that we regard as an event for this purpose would include:
1. User access operations to Doors or Lifts.
2. Automation events.
3. Modules constantly going on and off line due to poor LAN installation practices has
been known to fill up 4GB in a day or two.
4. Other events including Area on/off, log-ins, etc. which occur much less often, would
therefore contribute less.
Interestingly, Insight Schematics state changes and area count increments/decrements don’t
get stored in Insight Review and therefore don’t contribute to it filling up.
As another indication, 10,000 user photos of 400kB each would alone fill up the Insight
database.

Guidelines
Under any of the following circumstances, an unlimited edition of the SQL Server would be
recommended:
If Insight Review is logging the activity of 200 users, each performing an average of 10
access operations per day, you probably need an unlimited SQL server. If a lot of
Automation functions are also being logged, these numbers should be decreased.
If Insight Review is logging the activity of 20 automation functions, each processing an
average of 100 changes of state per day, you probably need an unlimited SQL server.
If a lot of User access operations are also being logged, these numbers should be
decreased.
If the Insight database has more than 5000 user photos, you probably need an
unlimited SQL Server.
If the Insight database has more than 10 panels, you probably need an unlimited SQL
Server.
Note that the above are only guidelines.
Due to the range of factors influencing database usage there is no guarantee that you won’t run
out of database space if you choose to utilize SQL Express edition when the system activity
&/or database size is below, but approaching, these suggested numbers.
If your system is large and/or busy, closely monitor the size of your review database in
particular, noting how much it grows over a specific period. (e.g. A week or a month)
If it gets much above half of the 4GB limit, older Review events should be archived to free up
space.
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Once you know how long it takes for the review database to grow to over half of the 4GB limit
you will then have the information you need to pick a suitable period for older Review events to
be archived on a regular basis. This will not only reduce the chances of Insight encountering
problems, but will also improve responsiveness to viewing filtered review and generating review
based reports.

Solutions
Microsoft has an SQL Server Workgroup edition that costs approximately $1000 for a server
with 5 client access licenses. This edition removes the 4GB database limit.
For very large enterprise systems, with tens or even hundreds of panels, it is best to discuss the
requirements with Inner Range. In this case the solution would usually include a faster
Microsoft SQL Server standard edition with multicore processors running on separate dedicated
server PC and connected to the Insight Server with fast (Gigabit) Ethernet.

We should also certainly mention in this area that SQL can’t be left to its own devices with
regards to memory consumption if it is installed on the same computer as the Insight Server.
Server Properties

Memory

Maximum server Memory:
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